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Preface

Overview
Cisco Customer Response Solutions Historical Reports Use Guide provides 
instructions and related information for installing, upgrading, and accessing the 
Cisco Customer Response Solutions (CRS) 4.0 Historical Reports Client 
interface. This manual also describes each historical report in detail, explains how 
to generate, view, print, save, and schedule historical reports, and provides 
information for administrating the Historical Reports system.

Audience
This manual is intended for call center supervisors who need to prepare and 
understand Cisco CRS historical reports.
ix
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Organization
Organization
This manual is organized as follows:

Related Documentation
For additional information about Cisco CRS and about Cisco CRS Historical 
Reports refer to the following documents:

• Cisco CRS Administration Guide

• Cisco CRS Database Schema 

• Getting Started with Cisco Unified IP IVR

Chapter 1, “Overview” Introduces the Cisco CRS database 
and describes the Cisco CRS 
Historical Reports client interface

Chapter 2, “Installation and 
Configuration”

Provides instructions for installing, 
upgrading, and giving users access to 
the Cisco CRS Historical Reports 
system, describes configuration files, 
and explains how to change the 
language on the client computer

Chapter 3, “Descriptions of Historical 
Reports”

Provides an overview and descriptions 
of each historical report

Chapter 4, “Generating Historical 
Reports”

Describes how to generate, view, 
print, and save historical reports

Chapter 5, “Scheduling Historical 
Reports”

Explains how to use the Scheduler to 
automatically generate historical 
reports at some time in the future

Chapter 6, “Log Files” Describes the Cisco CRS Historical 
Reports system log files

Appendix A, “Cisco CRS Reason 
Codes”

Describes the events that cause an 
agent to go to the Logout state or Not 
Ready state
x
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Preface
Conventions
• Getting Started with Cisco Unified CCX

• Cisco CRS Installation Guide

• Cisco CRS Historical Reports Administrator and Developer Guide

• Cisco CRS Servicing and Troubleshooting Guide

Conventions
This manual uses the following conventions:

Convention Description

boldface font Boldface font is used to indicate commands, such as user 
entries, keys, buttons, and folder and submenu names. For 
example:

• Choose Edit > Find.

• Click Finish.

italic font  Italic font is used to indicate the following:

• To introduce a new term. Example: A skill group is a 
collection of agents who share similar skills.

• For emphasis. Example: 
Do not use the numerical naming convention.

• A syntax value that the user must replace. Example: 
IF (condition, true-value, false-value)

• A book title. Example: 
See the Cisco CRS Installation Guide.
xi
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Preface
Obtaining Documentation
Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. This 
section explains the product documentation resources that Cisco offers.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

window font Window font, such as Courier, is used for the following:

• Text as it appears in code or that the window displays. 
Example:
<html><title>Cisco Systems,Inc. 
</title></html>

< > Angle brackets are used to indicate the following:

• For arguments where the context does not allow italic, 
such as ASCII output. 

• A character string that the user enters but that does not 
appear on the window such as a password.

Convention Description
xii
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Preface
Documentation Feedback
Product Documentation DVD
The Product Documentation DVD is a library of technical product documentation 
on a portable medium. The DVD enables you to access installation, configuration, 
and command guides for Cisco hardware and software products. With the DVD, 
you have access to the HTML documentation and some of the PDF files found on 
the Cisco website at this URL:

http://www.cisco.com/univercd/home/home.htm

The Product Documentation DVD is created and released regularly. DVDs are 
available singly or by subscription. Registered Cisco.com users can order a 
Product Documentation DVD (product number DOC-DOCDVD= or 
DOC-DOCDVD=SUB) from Cisco Marketplace at the Product Documentation 
Store at this URL:

http://www.cisco.com/go/marketplace/docstore

Ordering Documentation
You must be a registered Cisco.com user to access Cisco Marketplace. Registered 
users may order Cisco documentation at the Product Documentation Store at this 
URL: 

http://www.cisco.com/go/marketplace/docstore

If you do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Documentation Feedback
You can provide feedback about Cisco technical documentation on the 
Cisco Support site area by entering your comments in the feedback form available 
in every online document.
xiii
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Preface
Cisco Product Security Overview
Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you will find information about how to do the following:

• Report security vulnerabilities in Cisco products

• Obtain assistance with security incidents that involve Cisco products

• Register to receive security information from Cisco

A current list of security advisories, security notices, and security responses for 
Cisco products is available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are 
updated in real time, you can subscribe to the Product Security Incident Response 
Team Really Simple Syndication (PSIRT RSS) feed. Information about how to 
subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally 
before we release them, and we strive to correct all vulnerabilities quickly. If you 
think that you have identified a vulnerability in a Cisco product, contact PSIRT:

• For emergencies only — security-alert@cisco.com

An emergency is either a condition in which a system is under active attack 
or a condition for which a severe and urgent security vulnerability should be 
reported. All other conditions are considered nonemergencies.

• For nonemergencies— psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532
xiv
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Preface
Product Alerts and Field Notices
Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for 
example, GnuPG) to encrypt any sensitive information that you send to Cisco. 
PSIRT can work with information that has been encrypted with PGP versions 2.x 
through 9.x. 

Never use a revoked encryption key or an expired encryption key. The correct 
public key to use in your correspondence with PSIRT is the one linked in the 
Contact Summary section of the Security Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT to find other means of encrypting 
the data before sending any sensitive material.

Product Alerts and Field Notices
Modifications to or updates about Cisco products are announced in Cisco Product 
Alerts and Cisco Field Notices. You can receive these announcements by using 
the Product Alert Tool on Cisco.com. This tool enables you to create a profile and 
choose those products for which you want to receive information.

To access the Product Alert Tool, you must be a registered Cisco.com user. 
Registered users can access the tool at this URL:

http://tools.cisco.com/Support/PAT/do/ViewMyProfiles.do?local=en

To register as a Cisco.com user, go to this URL:

http://tools.cisco.com/RPF/register/register.do
xv
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Obtaining Technical Assistance
Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical 
assistance. The Cisco Support website on Cisco.com features extensive online 
support resources. In addition, if you have a valid Cisco service contract, 
Cisco Technical Assistance Center (TAC) engineers provide telephone support. If 
you do not have a valid Cisco service contract, contact your reseller.

Cisco Support Website
The Cisco Support website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and 
technologies. The website is available 24 hours a day at this URL:

http://www.cisco.com/en/US/support/index.html

Access to all tools on the Cisco Support website requires a Cisco.com user ID and 
password. If you have a valid service contract but do not have a user ID or 
password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Before you submit a request for service online or by phone, use the Cisco Product 
Identification Tool to locate your product serial number. You can access this tool 
from the Cisco Support website by clicking the Get Tools & Resources link, 
clicking the All Tools (A-Z) tab, and then choosing Cisco Product Identification 
Tool from the alphabetical list. This tool offers three search options: by product 
ID or model name; by tree view; or, for certain products, by copying and pasting 
show command output. Search results show an illustration of your product with 
the serial number label location highlighted. Locate the serial number label on 
your product and record the information before placing a service call.

Tip Displaying and Searching on Cisco.com

If you suspect that the browser is not refreshing a web page, force the browser to 
update the web page by holding down the Ctrl key while pressing F5.
xvi
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Obtaining Technical Assistance
To find technical information, narrow your search to look in technical 
documentation, not the entire Cisco.com website. After using the Search box on 
the Cisco.com home page, click the Advanced Search link next to the Search box 
on the resulting page and then click the Technical Support & Documentation 
radio button.

To provide feedback about the Cisco.com website or a particular technical 
document, click Contacts & Feedback at the top of any Cisco.com web page.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you 
describe your situation, the TAC Service Request Tool provides recommended 
solutions. If your issue is not resolved using the recommended resources, your 
service request is assigned to a Cisco engineer. The TAC Service Request Tool is 
located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the 
Cisco TAC by telephone. (S1 or S2 service requests are those in which your 
production network is down or severely degraded.) Cisco engineers are assigned 
immediately to S1 and S2 service requests to help keep your business operations 
running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411
Australia: 1 800 805 227
EMEA: +32 2 704 55 55
USA: 1 800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts
xvii
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Obtaining Additional Publications and Information
Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—An existing network is “down” or there is a critical impact to 
your business operations. You and Cisco will commit all necessary resources 
around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or 
significant aspects of your business operations are negatively affected by 
inadequate performance of Cisco products. You and Cisco will commit full-time 
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired while most 
business operations remain functional. You and Cisco will commit resources 
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product 
capabilities, installation, or configuration. There is little or no effect on your 
business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• The Cisco Online Subscription Center is the website where you can sign up 
for a variety of Cisco e-mail newsletters and other communications. Create a 
profile and then select the subscriptions that you would like to receive. To 
visit the Cisco Online Subscription Center, go to this URL:

http://www.cisco.com/offer/subscribe

• The Cisco Product Quick Reference Guide is a handy, compact reference tool 
that includes brief product overviews, key features, sample part numbers, and 
abbreviated technical specifications for many Cisco products that are sold 
through channel partners. It is updated twice a year and includes the latest 
Cisco channel product offerings. To order and find out more about the 
Cisco Product Quick Reference Guide, go to this URL: 

http://www.cisco.com/go/guide
xviii
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Obtaining Additional Publications and Information
• Cisco Marketplace provides a variety of Cisco books, reference guides, 
documentation, and logo merchandise. Visit Cisco Marketplace, the company 
store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training, and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to 
Cisco Press at this URL:

http://www.ciscopress.com

• Internet Protocol Journal is a quarterly journal published by Cisco for 
engineering professionals involved in designing, developing, and operating 
public and private internets and intranets. You can access the Internet 
Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco, as well as customer support services, 
can be obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website where 
networking professionals share questions, suggestions, and information 
about networking products and technologies with Cisco experts and other 
networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

• “What’s New in Cisco Documentation” is an online publication that provides 
information about the latest documentation releases for Cisco products. 
Updated monthly, this online publication is organized by product category to 
direct you quickly to the documentation for your products. You can view the 
latest release of “What’s New in Cisco Documentation” at this URL:

http://www.cisco.com/univercd/cc/td/doc/abtunicd/136957.htm

• World-class networking training is available from Cisco. You can view 
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
xix
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Cisco CRS Histor
 

C H A P T E R 1

Overview

The Cisco CRS Historical Reports system is designed to provide you with 
information about the call activities of your Cisco Customer Response Solutions 
(CRS) system. With Cisco CRS Historical Reports, you can

• Easily access historical data

• View, print, and save reports

• Sort and filter reports

• Send scheduled reports to a file or to a printer

• Export reports in a variety of formats, including Portable Document Format 
(PDF), Microsoft Excel, Rich Text Format (RTF), Extensible Markup 
Language (XML), and Comma-Separated Values (CSV)

• Prepare custom reports using a variety of generally available third-party 
applications that are designed to create reports from databases

The following sections include these topics:

• System Database, page 1-2

• The Cisco CRS Historical Reports Client Interface, page 1-2

• Failover, page 1-7
1-1
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Chapter 1      Overview
System Database
System Database
As the Cisco CRS system runs, it stores call activity data in a database on the 
Cisco CRS server, or on a server running the Database component, if one is 
deployed. (It also stores this activity on a standby server, if one is deployed.) You 
use the Cisco CRS Historical Reports client to create historical reports based on 
this data.

For more information about the Cisco CRS databases, refer to Cisco CRS 
Administration Guide.

The Cisco CRS Historical Reports Client Interface
You perform most Cisco CRS Historical Reports client activities from an 
easy-to-use set of menus on the client computer. Figure 1-1 shows the Cisco CRS 
Historical Reports main window.
1-2
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The Cisco CRS Historical Reports Client Interface
Figure 1-1 Cisco CRS Historical Reports Main Window

Item Reference

1 Open tool Saving Report Settings, page 4-8

2 Save tool Saving Report Settings, page 4-8

3 Login tool Changing Login and Server Information, page 1-6
1-3
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Chapter 1      Overview
The Cisco CRS Historical Reports Client Interface
Starting the Cisco CRS Historical Reports Client
When you start the Cisco CRS Historical Reports client, the client logs in to the 
Cisco CRS server, giving you access to data stored in the Cisco CRS database. To 
start the Cisco CRS Historical Reports client, perform the following steps.

4 Scheduler tool Viewing and Deleting Schedules, page 5-15

5 Help tool Getting Online Help, page 1-7

6 Help button Getting Online Help, page 1-7

7 Reset button General Report Settings, page 4-1

Detailed Report Settings, page 4-4

General Settings for Scheduled Reports, page 5-5

8 View button1 The Report Viewer, page 4-12

9 Start and end date 
and time fields

Choosing the Date and Time Range for a Report, 
page 4-4

10 Check box for 
including charts 
with a report

Including Charts with a Report, page 4-3

Including Charts with a Scheduled Report, page 5-6

11 Report name Choosing the Report to Generate, page 4-2

Choosing the Report to Schedule, page 5-6

12 Tabs for general 
and detailed report 
settings

General Report Settings, page 4-1

Detailed Report Settings, page 4-4

General Settings for Scheduled Reports, page 5-5

Detailed Settings for Scheduled Reports, page 5-10

13 Reporting tasks General Report Settings, page 4-1

Loading Report Settings, page 4-10

Choosing the Report to Schedule, page 5-6

1.  This button changes depending on the reporting task selected

Item (continued) Reference (continued)
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Note If you try to start the Cisco CRS Historical Reports client but you have not been 
given access to it, you will see the User Privileges Missing dialog box. In this 
case, your system administrator can click Yes and set up access for you. If you 
click No, you will not have access to any reports. Your system administrator can 
give you access later. See the “Giving Users Access to Cisco CRS Historical 
Reports” section on page 2-8 for more information.

Caution If your Cisco CRS historical reports client PC runs on the Microsoft Windows 
2000 Professional operation system (OS) or if your Cisco CRS server runs on the 
Window 2003 OS, then the security policies on your Cisco CRS Historical 
Reports client PC must match the policies on your Cisco CRS server. To verify 
this match on a Cisco CRS server, choose Start > Programs > Control Panel > 
Administrative Tools > Local Security Policy and note the Network Security: 
LAN Manager Authentication setting under Security Settings > Local Policies > 
Security Options. Next, go to the Local Security Settings window on the 
Historical Reports client PC and verify that the Security: LAN Manager 
Authentication setting under Security Settings > Local Policies > Security 
Options is identical to the Cisco CRS server.

Procedure

Step 1 Double-click the Cisco Historical Reports icon on your Windows desktop. Or, 
choose Start > Programs > Cisco CRS Historical Reports > 
Cisco CRS Historical Reports.

The Login dialog box appears.

Step 2 Enter your user name and your password.

If the client does not have information about the server to log in to, the Server field 
appears in the Login dialog box. Enter the IP address or the host name of the Cisco 
CRS server in the Server field.

If the client does have information about the server to log in to but you want to 
specify a different server, click Server and enter the IP address or the host name 
of the server in the Server field.
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Step 3 Click OK.

The system displays the Cisco CRS Historical Reports main window.

Related Topics

• Changing Login and Server Information, page 1-6

• Exiting the Cisco CRS Historical Reports Client, page 1-6

Changing Login and Server Information 
From the Cisco CRS Historical Reports main window, you can change current 
login information or change the server that you are logged in to.

To log in as a different user or to change the server to which the 
Cisco CRS Historical Reports client is connected, follow these steps:

Procedure

Step 1 Click the Login tool in the Cisco CRS Historical Reports main window. Or, 
choose Settings > Login.

The Login dialog box appears.

Step 2 If you want to log in under a different name, enter the user name and password. If 
you want to log in to a different server, click Server and enter the IP address or 
the host name of the server.

You can log in as a different user and change the server at the same time.

Step 3 Click OK.

Exiting the Cisco CRS Historical Reports Client
To exit the Cisco CRS Historical Reports client, choose File > Exit from the Cisco 
CRS Historical Reports main window.
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Getting Online Help
The Cisco CRS Historical Reports client provides online help. Depending on the 
displayed window, you can get help by performing one of the following actions:

• Clicking the Help button

• Clicking the Help tool

• Choosing Help > Contents or Help > Search for Help On from the menu bar

• Pressing the F1 key

Failover
Your Cisco CRS deployment may include a standby server for the Cisco CRS 
Database component. In this case, if the Database component fails over when you 
are logged in to the Cisco CRS Historical Reports client, you will see the 
following message when you attempt to generate a report:

The connection to the historical database was broken. Please log back 
in to the Cisco CRS Historical Reports Client to attempt to 
reestablish the connection to the database.

If you see this message, log back in to the Cisco CRS Historical Reports client. 
The client will attempt to connect automatically to the working database server.

If the Cisco CRS Server has shut down completely, you will need to specify the 
Standby server IP address when you log back in. For more information, see the 
“Starting the Cisco CRS Historical Reports Client” section on page 1-4.

If you try to run a report after a failover, the response differs based on the type of 
failover:

• Engine failover: you will not see any difference in report generation or node 
status.

• Database failover: If you are generating a report when a database failover 
occurs, the report generation process stops immediately, you will receive a 
disconnected message, and will not be able to proceed. 

– You can re-login to the same CRS node to which you were logged in prior 
to the failover.
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– If you are unable to connect to the same node, it might be due to a 
shutdown scenario or due to CRS Node Manger not running on that node. 
In this case, connect to the remaining node.

– If a database failover occurs when the Scheduler is generating a report, 
that report generation process also will stop immediately and that report 
will not be generated. Subsequent scheduled reports will be generated if 
the failover process completes before that time.
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C H A P T E R 2

Installation and Configuration

The following sections include these topics:

• Prerequisites, page 2-1

• Installing the Cisco CRS Historical Reports Client, page 2-2

• Reinstalling the Cisco CRS Historical Reports Client, page 2-5

• Upgrading the Cisco CRS Historical Reports Client, page 2-6

• Giving Users Access to Cisco CRS Historical Reports, page 2-8

• Configuration Files, page 2-12

• Changing the Client Language, page 2-19

Prerequisites 
Prior to installing the Cisco CRS Historical Reports client, ensure that you have 
met the following requirements:

• You have already installed the Cisco CRS server.

• You can access the Cisco CRS server from the computer on which you install 
the Cisco CRS Historical Reports client.

Caution Do not install the Cisco CRS Historical Reports client on the Cisco CRS server. 
You can install the client software on as many client computers as licensed.
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Installing the Cisco CRS Historical Reports Client

Note See the Cisco CRSSoftware and Hardware Compatibility Guide 
(http://www.cisco.com/en/US/partner/products/sw/custcosw/ps1846/products_d
evice_support_tables_list.html) for a list of supported operating systems and 
software required to install the Cisco CRS Historical Reports.

The Cisco CRS Historical Reports client installation procedure processes several 
operations on the client computer, including

• Installing the Cisco CRS Historical Reports client

• Creating directories in which the computer stores required files

• Installing the Scheduler (the part of CRS Historical Reports that manages and 
generates scheduled reports)

To install the CRS Historical Reports client, perform the following steps on the 
client computer.

Procedure

Step 1 From the client computer, log in to the Cisco CRS Administration application or 
log in to the CRS Supervision application.

For more information, see the Cisco CRS Administration Guide 
(http://www.cisco.com/en/US/partner/products/sw/custcosw/ps1846/products_in
stallation_and_configuration_guides_list.html).

Step 2 Perform one of the following actions:

• From Cisco CRS Administration, choose Tools > Plug-ins. When the 
Plug-ins web page appears, click the Cisco CRS Historical Reports 
hyperlink.

• From the CRS Supervision Download web page, click the 
Cisco CRS Historical Reports hyperlink.

The File Download dialog box appears.

Step 3 Click one of the following radio buttons:
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• Run this program from its current location—With this option, the client 
computer does not retain the Cisco CRS Historical Reports installation file 
after installation.

• Save this program to disk—With this option, the client computer retains the 
Cisco CRS Historical Reports installation file after installation. In this case, 
you can reinstall Cisco CRS Historical Reports without having to log in to the 
Cisco CRS server.

Step 4 Click OK in the File Download dialog box.

• If you clicked the Run this program from its current location radio button, 
the computer opens the installation program, and then it extracts the files that 
it needs for the installation. When this process completes, the 
Cisco CRS Historical Reports Setup window appears.

• If you clicked the Save this program to disk radio button, the Save As dialog 
box appears. Perform the following steps:

– Specify the directory in which you want to save the installation program 
(CiscoAppReportsInstall.exe) and click Save.

– When the installation file completes downloading, click Open in the 
Download Complete dialog box. The computer prepares to install the 
application, and then it extracts the files that it needs for the installation. 
When this process completes, the Cisco CRS Historical Reports Setup 
window appears.

Step 5 Click Next in the Cisco CRS Historical Reports Setup window.

The Cisco CRS Historical Reports Setup window displays the License 
Agreement.

Step 6 Read the License Agreement, and then, if you agree, click Yes.

The Cisco CRS Historical Reports Setup window prompts you to choose an 
installation folder.

Step 7 To install the Historical Reports files in the Program Files directory on your 
computer, click Next.

If you want to install the files in another directory, click Browse, choose the 
directory, click OK, and then click Next.

The Cisco CRS Historical Reports Setup window prompts you to select a program 
folder.
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Step 8 To use the Cisco CRS Historical Reports program folder to hold program icons, 
click Next.

To use another folder to hold program icons, enter the folder name or choose it 
from the list of existing folders, and then click Next.

The Cisco CRS Historical Reports Setup window prompts you to identify the 
Cisco CRS server.

Step 9 Enter the host name or IP address of the Cisco CRS server, and then click Next.

If you do not enter this information now, you can enter it later when you start 
Cisco CRS Historical Reports.

The Cisco CRS Historical Reports Setup window prompts you for permission to 
start copying files.

Step 10 Click Next to continue with the installation.

After the files are copied, the Desktop Shortcut dialog box appears.

Step 11 Click Yes to create a shortcut for Cisco CRS Historical Reports on your Windows 
desktop.

Step 12 Click Finish.

The installation is complete. The computer restarts, if necessary.

Related Topics

• Prerequisites, page 2-1

• Reinstalling the Cisco CRS Historical Reports Client, page 2-5

• Upgrading the Cisco CRS Historical Reports Client, page 2-6

• Giving Users Access to Cisco CRS Historical Reports, page 2-8

• Configuration Files, page 2-12

• Changing the Client Language, page 2-19
2-4
Cisco CRS Historical Reports User Guide, Release 5.0(1)



 

Chapter 2      Installation and Configuration
Reinstalling the Cisco CRS Historical Reports Client
Reinstalling the Cisco CRS Historical Reports Client

Note Be sure to exit the client application and the Scheduler on the client computer 
before proceeding. For instructions, see the “Exiting the Cisco CRS Historical 
Reports Client” section on page 1-6 and see “The Scheduler” section on page 5-3.

This procedure assumes that the Cisco CRS Historical Reports Client installation 
file (CiscoAppReportsInstall.exe) already exists on your computer.

To reinstall the Cisco CRS Historical Reports client, perform the following steps 
on the client computer.

Procedure

Step 1 Run the CiscoAppReportsInstall.exe installation file that you have already saved 
to your computer. 

A dialog box provides choices to upgrade/reinstall or uninstall the client.

Step 2 To upgrade or reinstall the current version of the client, select the 
Upgrade/Reinstall radio button, and click Next.

After the files are copied, the Desktop Shortcut dialog box appears.

Step 3 Click Yes if you want to create a shortcut for the client on your Windows desktop.

Step 4 Click Finish.

The installation is complete.

Related Topics

• Prerequisites, page 2-1

• Installing the Cisco CRS Historical Reports Client, page 2-2

• Upgrading the Cisco CRS Historical Reports Client, page 2-6

• Giving Users Access to Cisco CRS Historical Reports, page 2-8

• Configuration Files, page 2-12

• Changing the Client Language, page 2-19
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Upgrading the Cisco CRS Historical Reports Client

Note Be sure to exit the client application and the Scheduler on the client computer 
before proceeding. For instructions, see the “Exiting the Cisco CRS Historical 
Reports Client” section on page 1-6 and see “The Scheduler” section on page 5-3.

This procedure assumes that the Cisco CRS Historical Reports Client installation 
file (CiscoAppReportsInstall.exe) does not exist on your computer.

To upgrade the CRS Historical Reports client, perform the following steps on the 
client computer.

Procedure

Step 1 Perform one of the following actions:

• From Cisco CRS Administration, choose Tools > Plug-ins. When the 
Plug-ins web page appears, click the Cisco CRS Historical Reports 
hyperlink.

• From the CRS Supervision Download web page, click the 
Cisco CRS Historical Reports hyperlink.

The File Download dialog box appears.

Step 2 Click OK in the File Download dialog box.

• If you clicked the Run this program from its current location radio button, 
the computer opens the installation program, and then it extracts the files that 
it needs for the installation. When this process completes, the 
Cisco CRS Historical Reports Setup window appears.

• If you clicked the Save this program to disk radio button, the Save As dialog 
box appears. Perform the following steps:

– Specify the directory in which you want to save the installation program 
(CiscoAppReportsInstall.exe) and click Save. If you have previously 
saved the installation program in the same directory, a dialog box appears 
asking whether you want to replace the existing installation program file. 
Click Yes to continue.
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– When the installation file completes downloading, click Open in the 
Download Complete dialog box. The computer prepares to install the 
application, and then it extracts the files that it needs for the installation. 
When this process completes, the Cisco CRS Historical Reports Setup 
window appears.

Step 3 To upgrade to the new version of the client, select the Upgrade/Reinstall radio 
button, and click Next.

Step 4 To install the Historical Reports files in the Program Files directory on your 
computer, click Next.

If you want to install the files in another directory, click Browse, choose the 
directory, click OK, and then click Next.

The Cisco CRS Historical Reports Setup window prompts you to select a program 
folder.

Step 5 To use the Cisco CRS Historical Reports program folder to hold program icons, 
click Next.

To use another folder to hold program icons, enter the folder name or choose it 
from the list of existing folders, and then click Next.

The Cisco CRS Historical Reports Setup window prompts you to identify the 
Cisco CRS server.

Step 6 Enter the host name or IP address of the Cisco CRS server, and then click Next.

If you do not enter this information now, you can enter it later when you start 
Cisco CRS Historical Reports.

The Cisco CRS Historical Reports Setup window prompts you for permission to 
start copying files.

Step 7 Click Next to continue with the upgrade.

After the files are copied, the Desktop Shortcut dialog box appears.

Step 8 Click Yes to create a shortcut for Cisco CRS Historical Reports on your Windows 
desktop.

Step 9 Click Finish.

The installation is complete. The computer restarts, if necessary.
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Related Topics

• Prerequisites, page 2-1

• Installing the Cisco CRS Historical Reports Client, page 2-2

• Reinstalling the Cisco CRS Historical Reports Client, page 2-5

• Giving Users Access to Cisco CRS Historical Reports, page 2-8

• Configuration Files, page 2-12

• Changing the Client Language, page 2-19

Giving Users Access to Cisco CRS Historical Reports
Before a user can generate a historical report from the CRS Historical Reports 
client, you must specify the Cisco CRS application packages for which the user 
can generate reports.

To give a user access to historical reporting, you must first set up the user in 
Cisco CRS Administration. See the Cisco CRS Administration Guide 
(http://www.cisco.com/en/US/partner/products/sw/custcosw/ps1846/products_in
stallation_and_configuration_guides_list.html) for more information.

The following table shows the historical reports that are available for each Cisco 
CRS application package. In this table, “Yes” means that a report is available, and 
“—” means that a report is not available. If you give a user access to an 
application, the user will be able to generate all of the reports that are available 
for that application.

Report Name Unified QM
Unified IP 
IVR

Unified CCX 
Standard

Unified CCX 
Enhanced

Unified CCX 
Premium

Abandoned Call Detail 
Activity Report

— — Yes Yes Yes

Aborted and Rejected Call 
Detail Report

— — Yes Yes Yes

Agent Call Summary 
Report

— — Yes Yes Yes

Agent Detail Report — — Yes Yes Yes
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Agent Login Logout 
Activity Report

— — Yes Yes Yes

Agent Not Ready Reason 
Code Summary Report

— — Yes Yes Yes

Agent State Detail Report — — Yes Yes Yes

Agent State Summary 
Report (by Agent)

— — Yes Yes Yes

Agent State Summary 
Report (by Interval)

— — Yes Yes Yes

Agent Summary Report — — Yes Yes Yes

Agent Wrap-up Data Detail 
Report

— — Yes Yes Yes

Agent Wrap-up Data 
Summary Report

— — Yes Yes Yes

Application Performance 
Analysis Report

Yes Yes Yes Yes Yes

Application Summary 
Report

— — Yes Yes Yes

Call Custom Variables 
Report

— — Yes Yes Yes

Called Number Summary 
Activity Report

— — Yes Yes Yes

Common Skill Contact 
Service Queue Activity 
Report (by Interval)

— — Yes Yes Yes

Contact Service Queue 
Activity Report

— — Yes Yes Yes

Contact Service Queue 
Activity Report (by CSQ)

— — Yes Yes Yes

Contact Service Queue 
Activity Report (by 
Interval)

— — Yes Yes Yes

Report Name Unified QM
Unified IP 
IVR

Unified CCX 
Standard

Unified CCX 
Enhanced

Unified CCX 
Premium
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Contact Service Queue Call 
Distribution Summary 
Report

— — Yes Yes Yes

Contact Service Queue 
Priority Summary Report

— — Yes Yes Yes

Contact Service Queue 
Service Level Priority 
Summary Report

— — Yes Yes Yes

CSQ–Agent Summary 
Report

— — Yes Yes Yes

Detailed Call by Call 
CCDR Report

Yes Yes Yes Yes Yes

Detailed Call, CSQ, Agent 
Report

— — Yes Yes Yes

Multichannel Agent 
Contact Summary Report

— — — — Yes, with 
Multichannel 
license1

Multichannel Agent Login 
Logout Activity Report

— — — — Yes, with 
Multichannel 
license1

Multichannel CSQ Activity 
Report

— — — — Yes, with 
Multichannel 
license1

Outbound Agent Detail 
Performance Report

— — — — Yes, with 
Outbound 
license

Outbound Campaign 
Summary Report

— — — — Yes, with 
Outbound 
license

Priority Summary Activity 
Report

— — — Yes Yes

Report Name Unified QM
Unified IP 
IVR

Unified CCX 
Standard

Unified CCX 
Enhanced

Unified CCX 
Premium
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To specify the historical reports that a user can generate, perform these steps:

Procedure

Step 1 Log in to Cisco CRS Administration.

For information about logging in to Cisco CRS Administration, refer to Cisco 
CRS Administration Guide.

Step 2 From the Cisco CRS Administration application, choose Tools > Historical 
Reporting.

The Historical Reporting Configuration web page appears.

Step 3 In the navigation bar, click the User Configuration hyperlink.

Step 4 Click the Select User drop-down arrow to view a list of users, and then choose the 
user that you want.

Step 5 Click Next.

The following panes appear:

• Installed Reporting Package—This pane contains a list of Cisco CRS 
applications that are installed.

• Selected Reporting Package—This pane shows the applications, if any, that 
the user can access to generate historical reports.

Step 6 To select one or more applications for which the user will be able to generate 
historical reports, click the reporting package name in the Installed Reporting 
Package pane, and then click >.

The reporting package name moves to the Selected Reporting Package pane.

Remote Monitoring Detail 
Report

— — Yes Yes Yes

Traffic Analysis Report Yes Yes Yes Yes Yes

1. Multichannel reports are specific to Unified EIM/Unified WIM and use the MS SQL 2000 database (installed in a mixed mode 
authentication). To generate combined historical reports, Cisco CRS requires access details for the Unified EIM/Unified WIM 
database (host name or IP address of the server, database name, database user, and database password). See the Cisco CRS 
Administration Guide for detailed configuration information.

Report Name Unified QM
Unified IP 
IVR

Unified CCX 
Standard

Unified CCX 
Enhanced

Unified CCX 
Premium
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To unselect a name that appears in the Selected Reporting Package pane, choose 
that application name, and then click <.

The reporting package name moves to the Installed Reporting Packages pane.

Step 7 Click Update to give the user access to historical reports for the selected 
applications.

To configure another user, repeat Step 4 through Step 7.

Configuration Files
The CRS Historical Reports client maintains two configuration files on each 
client computer. The following sections explain each file in detail. The 
configuration files are:

• hrcConfig.ini—This file is stored in the Cisco CRS Historical Reports 
directory, which is under the directory in which you installed the Cisco CRS 
Historical Reports client system. (By default, the system installs in the 
Program Files directory.) This file contains general instructions for the Cisco 
CRS Historical Reports client system.

• sch.ini—This file is stored in the Cisco CRS Historical Reports\Scheduler 
directory, which is under the directory in which you installed the Cisco CRS 
Historical Reports client system. (By default, the system installs in the 
Program Files directory.) This file contains instructions regarding the 
Scheduler.

You can edit either of these configuration files and make changes, if needed. To 
edit a configuration file, perform these steps:

Procedure

Step 1 Use any text editor to open the configuration file.

Step 2 Make changes to parameters as desired.
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Caution If you edit the configuration files and make changes that are not 
recognized by the system, you may face the risk of corrupting the 
system.

Step 3 Save the file and exit the text editor.

Step 4 If you edit the hrcConfig.ini file while the Cisco CRS Historical Reports client is 
running, exit and restart the client program to cause your changes to take effect.

If you edit the sch.ini file, right-click the Scheduler icon that appears in the status 
area on your Windows task bar and choose Stop Scheduler. Then right-click the 
Scheduler icon again and choose Run Scheduler to cause your changes to take 
effect.

Related Topics

• The hrcConfig.ini Configuration File, page 2-13

• The sch.ini Configuration File, page 2-16

The hrcConfig.ini Configuration File
The hrcConfig.ini file contains general instructions for the 
Cisco CRS Historical Reports client system. The following table shows the 
parameters in this file.
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Parameter Explanation

defaultHost IP address or host name that appears in the Server field in the 
Cisco CRS Historical Reports Login dialog box.

Default value: IP address or host name of the server most 
recently logged in to.

defaultExportPath Path name of the default directory in which the Cisco CRS 
Historical Reports system stores scheduled reports that are 
exported to a file.

Default value: Cisco CRS Historical Reports\reports 
directory, which is under the directory in which you installed 
the Cisco CRS Historical Reports client.

To change the defaultExportPath parameter in the 
hrcConfig.ini configuration file for the Cisco CRS Historical 
Reports Client, follow these guidelines:

• Make sure that the new directory exists on the shared 
drive.

• Enclose the new path in quotation marks. For example: 
defaultExportPath=“\\209.165.200.225\F$\CRS_REP

ORTS”

showUserNameOnReport Specifies whether the username of the user who is logged in 
when a report is generated appears on the report.

Valid values: 

• 0—Name does not appear

• 1—Name appears

Default value: 1

logLevel Level of detail in which the system records events in the 
Historical Reports Client log file.

Valid values: 

• 1—Record errors only

• 2—Record errors and warnings

• 3—Record errors, warnings, and debugging messages

Default value: 1
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NumOfLogFiles Number of Historical Reports Client log files the system 
maintains. The system creates a new Historical Reports 
Client log file whenever the current Historical Reports Client 
log file reaches the size specified by MaxSizeOfLogFiles. 
(See the next parameter.)

Valid values: Integers 1 or greater

Default value: 10

MaxSizeOfLogFiles Specifies that the system should create a new Historical 
Reports Client log file when the current log file reaches this 
size in KB.

Valid values: Integers 1 or greater

Default value: 1000

Note 1000 KB is the recommended value for this 
parameter because a log file that is much larger than 
1000 KB can be difficult to read, and several large log 
files can take up significant disk space.

database (under [SCH]) Database file in the Cisco CRS Historical Reports\Scheduler 
directory in which scheduling information is stored. If you 
change this parameter, you must also change the database 
parameter in the sch.ini configuration file to the same value.

Valid value: HistoricalReportsScheduler.mdb

DRIVER (under [CRS_DATABASE]) Display only. Name of the database driver.

SERVER (under [CRS_DATABASE]) Display only. IP address or host name of the server from 
which the Cisco CRS Historical Reports client obtains 
historical data.

DATABASE (under 
[CRS_DATABASE])

Display only. Name of the main Cisco CRS database on the 
server from which the Cisco CRS Historical Reports client 
obtains historical data.

UID (under [CRS_DATABASE]) Display only. User identification used to log in to the 
Cisco CRS database on the server from which the Cisco CRS 
Historical Reports client obtains historical data.

Parameter Explanation
2-15
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 2      Installation and Configuration
Configuration Files
Related Topic

• Client System Log Files, page 6-2

The sch.ini Configuration File
The sch.ini file contains general instructions for the Scheduler, including the 
location of the Scheduler database, the level of detail in which to record log file 
information, and how to handle missed schedules. The following table shows the 
parameters in this file.

NETWORK (under 
[CRS_DATABASE])

Display only. Network library used by the Cisco CRS 
Historical Reports client when connecting to the Cisco CRS 
database.

DRIVER (under 
[CRS_DATABASE_ALTERNATIVE])

If you want the Cisco CRS Historical Reports client to access 
databases on a computer other than the default server, specify 
the name of the alternative database driver here.

Valid value: Name of the alternative database driver

SERVER (under 
[CRS_DATABASE_ALTERNATIVE])

If you want the Cisco CRS Historical Reports client to access 
databases on a computer other than the default server, specify 
the IP address or host name of the alternative server here.

Valid value: IP address or host name of the alternative server 
on which the Cisco CRS databases are duplicated

DATABASE (under 
[CRS_DATABASE_ALTERNATIVE])

If you want the Cisco CRS Historical Reports client to access 
databases with names other than the default Cisco CRS 
database names, specify the alternative name of the main 
database here.

Valid value: Name of the alternative main database

NETWORK (under 
[CRS_DATABASE_ALTERNATIVE])

If you want the Cisco CRS Historical Reports client to access 
databases using a network library other than the default 
network library (dbmssocn for TCP/IP), specify the name of 
the alternative network library here.

Valid value: Name of the alternative network library (for 
example, dbnmpntw for named pipes)

Parameter Explanation
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Parameter Explanation

database Database file in the Cisco CRS Historical Reports\Scheduler 
directory in which scheduling information is stored. If you change this 
parameter, you must also change the database parameter in the 
hrcConfig.ini configuration file to the same value.

Valid value: HistoricalReportsScheduler.mdb

NumOfMissedScheduleRuns If one scheduled report is missed because the Scheduler is not 
running, or if several consecutive occurrences of a report are missed 
because the Scheduler is not running, specifies up to how many of the 
missed reports should be generated if you choose to execute missed 
schedules.

Valid values: Zero or greater

Default value: 1

Missed_daily For reports that are scheduled to run daily, specifies whether the 
reports should be generated if they are missed and you choose to 
execute missed schedules.

Valid values: 

• 1—Generate the report

• 0—Do not generate the report

Default value: 1

Missed_weekly For reports that are scheduled to run weekly, specifies whether the 
reports should be generated if they are missed and you choose to 
execute missed schedules.

Valid values: 

• 1—Generate the report

• 0—Do not generate the report

Default value: 1
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Related Topics

• Handling Missed Schedules, page 5-17

• Scheduler Log Files, page 6-4

Missed_monthly For reports that are scheduled to run monthly, specifies whether the 
reports should be generated if they are missed and you choose to 
execute missed schedules.

Valid values: 

• 1 —Generate the report

• 0—Do not generate the report

Default value: 1

Missed_once For reports that are scheduled to run once, specifies whether the 
reports should be generated if they are missed and you choose to 
execute missed schedules.

Valid values: 

• 1—Generate the report

• 0—Do not generate the report

Default value: 1

logLevel Level of detail in which the system records events in the Scheduler log 
files.

Valid values: 

• 1—Record Scheduler errors only

• 2—Record Scheduler errors and Scheduler warnings

• 3—Record Scheduler errors, Scheduler warnings, and schedule 
information

• 4—Record Scheduler errors, Scheduler warnings, and detailed 
schedule information

Default value: 3

Parameter Explanation
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Changing the Client Language
You can use the Windows Regional Options settings to set the language for the 
Cisco CRS Historical Reports client. You can set any of the languages that are 
supported by your Cisco CRS system. If you set a language that is not supported 
by your Cisco CRS system, the client system will default to English.

When you set a language, the Cisco CRS Historical Reports client displays the 
following information in that language:

• Information displayed in windows and dialog boxes, including field names 
and button names

• Menu names and menu options

• Field names, headings, and other static items in reports

The client language does not affect the language of the data in reports.

Caution Setting the language may affect the display language of other applications that are 
running on the client computer.

Note Refer to your Windows documentation for more information on setting languages. 
See the http://www.microsoft.com/globaldev/handson/user/2kintlsupp.mspx 
website for further details
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C H A P T E R 3

Descriptions of Historical Reports

Cisco CRS Historical Reports provides a set of formatted reports that are designed 
to provide you with information about the operations and activities of your Cisco 
CRS system and the agents using the system. Reports present information in a 
tabular form and, unless you specify otherwise, include charts that highlight 
important information.

If you require reports other than the system-formatted reports, you can create your 
own custom reports. To create custom reports, refer to Cisco CRS Historical 
Reports Administrator and Developer Guide.

The following sections include these topics:

• Overview of Reports, page 3-2

• Report Details, page 3-7

• Report Footnotes, page 3-91
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Overview of Reports
Cisco CRS Historical Reports can generate a variety of historical reports. 
Table 3-1 shows the following information for each report:

• Report Name and Reference—Name of the historical report and reference to 
section in this chapter that contains detailed information about the report.

• Application Package—Cisco CRS packages for which the report is available.

• Description—Brief description of the content of the report.

Each report is described in alphabetical order in the “Report Details” section on 
page 3-7. 

Table 3-1 Summary of Historical Reports

Report Name and Reference Application Package Description

Abandoned Call Detail 
Activity Report, page 3-9

• Unified CCX1 Standard

• Unified CCX Enhanced

• Unified CCX Premium

Detailed information about each 
abandoned call

Aborted and Rejected Call 
Detail Report, page 3-10

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Detailed information about each aborted 
or rejected call

Agent Call Summary 
Report, page 3-13

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Summary information about inbound and 
outbound transfer, conference, and agent 
calls

Agent Detail Report, 
page 3-15

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Detailed information about each call 
received or made by each agent

Agent Login Logout 
Activity Report, page 3-17

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Detailed information about the login and 
logout activities of each agent
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Agent Not Ready Reason 
Code Summary Report, 
page 3-19

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Time that each agent spent in Not Ready 
state, and information about reason codes 
agents entered when going to Not Ready 
state

Agent State Detail Report, 
page 3-21

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about the time each agent 
went to and spent in an agent state, and 
the reason why the agent went to Logout 
state or Not Ready state

Agent State Summary 
Report (by Agent), 
page 3-23

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about the length and 
percentage of time that agents spent in 
each agent state, grouped by agent name

Agent State Summary 
Report (by Interval), 
page 3-25

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about the length and 
percentage of time that agents spent in 
each agent state, grouped by 30- or 
60-minute intervals within the report 
period

Agent Summary Report, 
page 3-28

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Summary statistics about the activities of 
each agent, including call and agent state 
activities

Agent Wrap-up Data Detail 
Report, page 3-31

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Detailed information about each wrap-up 
data

Agent Wrap-up Data 
Summary Report, page 3-33

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Summary information about details 
entered by the agent after the agent enters 
the work state associated with the 
wrap-up feature

Table 3-1 Summary of Historical Reports (continued)

Report Name and Reference Application Package Description
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Application Performance 
Analysis Report, page 3-35

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

• Unified QM2

• Unified IP IVR3

Summary information about calls 
received by each Unified CCX or Unified 
IP IVR application

Application Summary 
Report, page 3-36

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Summary call statistics for calls 
presented to, handled by, and abandoned 
from each application, and information 
about call talk time, work time, and 
abandon time

Call Custom Variables 
Report, page 3-38

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about custom variables, if 
any, that are set by the Set Session Info 
step in the workflow associated with a 
call or leg

Called Number Summary 
Activity Report, page 3-42

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Summary information for each number 
dialed by callers

Common Skill Contact 
Service Queue Activity 
Report (by Interval), 
page 3-43

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Summary information about calls 
presented, calls handled, and calls 
abandoned for each group of CSQs that is 
configured with the same skills but 
different competence levels

Contact Service Queue 
Activity Report, page 3-47

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Summary information about calls 
presented to, handled by, abandoned 
from, and dequeued from each CSQ, and 
information about call queue time and 
handle time

Contact Service Queue 
Activity Report (by CSQ), 
page 3-49

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about calls routed to CSQs 
and information about service level, 
grouped by CSQ

Table 3-1 Summary of Historical Reports (continued)

Report Name and Reference Application Package Description
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Contact Service Queue 
Activity Report (by 
Interval), page 3-53

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about calls routed to CSQs 
and information about service level, 
grouped by 30– or 60–minute intervals 
within the report period

Contact Service Queue Call 
Distribution Summary 
Report, page 3-57

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Number of calls handled and abandoned 
within 4 time intervals of configurable 
length

Contact Service Queue 
Priority Summary Report, 
page 3-60

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about the total number of 
calls presented to each contact service, 
and the total and average number of calls 
presented for each call priority

Contact Service Queue 
Service Level Priority 
Summary Report, page 3-61

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about total number and 
percentage of calls that are handled 
within service level, and number and 
percentage of calls that are handled 
within service level for each call priority

CSQ–Agent Summary 
Report, page 3-63

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Information about the activities of an 
agent in a CSQ

Detailed Call by Call CCDR 
Report, page 3-65

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

• Unified QM

• Unified IP IVR

Information from the Contact Call Detail 
Record (CCDR), the contact routing 
detail record, and the agent connection 
detail record for each leg of a call

Detailed Call, CSQ, Agent 
Report, page 3-69

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Detailed call information about the CSQ 
to which the call was routed and the agent 
handling the call

Multichannel Agent Contact 
Summary Report, page 3-72

Unified CCX Premium with 
the Multichannel license

Summary information about inbound and 
outbound e-mail and chat

Table 3-1 Summary of Historical Reports (continued)

Report Name and Reference Application Package Description
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Multichannel Agent Login 
Logout Activity Report, 
page 3-74

Unified CCX Premium with 
the Multichannel license

Detail information about the 
multichannel (e-mail and chat) activities 
of each agent

Multichannel CSQ Activity 
Report, page 3-76

Unified CCX Premium with 
the Multichannel license

Summary information of calls, e-mails, 
and chats presented to, handled by, 
abandoned from, and dequeued from each 
CSQ 

Outbound Agent Detail 
Performance Report, 
page 3-79

Unified CCX Premium with 
the Outbound4 license

Detailed information about each agent 
and also contains Outbound campaign 
call details for each agent 

Outbound Campaign 
Summary Report, page 3-82

Unified CCX Premium with 
the Outbound4 license

Summary information about the 
Outbound campaign statistics for a 
specified period

Priority Summary Activity 
Report, page 3-85

• Unified CCX Enhanced

• Unified CCX Premium

Summary information about the priority 
levels of each call received 

Remote Monitoring Detail 
Report, page 3-87

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

Detailed information about each remote 
monitoring session performed by a 
supervisor

Traffic Analysis Report, 
page 3-89

• Unified CCX Standard

• Unified CCX Enhanced

• Unified CCX Premium

• Unified QM

• Unified IP IVR

Summary information about calls 
received by the Cisco CRS system during 
each day in the report range

1. Cisco Unified Contact Center Express (Unified CCX)

2. Cisco Unified Queue Manager (Unified QM)

3. Cisco Unified IP IVR (Unified IP IVR)

4. Cisco Unified Outbound Preview Dialer (Outbound)

Table 3-1 Summary of Historical Reports (continued)

Report Name and Reference Application Package Description
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Report Details
This section provides the following information for each Cisco CRS historical 
report:

• A description of the report.

• A table describing the information that is displayed in each chart produced 
with the report.

• A table describing each field in the tabular section of the report.

• A table describing each sort criterion that is available for the report. For more 
information about sorting a report, see the “Detailed Report Settings” section 
on page 4-4.

• A table describing each filter parameter, if any, that is available for the report. 
You can use a filter parameter to limit information that appears in a report. 
For more information about filtering a report, see the “Detailed Report 
Settings” section on page 4-4.

Note When a report shows date and time information for an event or an activity, that 
date and time is the Cisco CRS server date and time. 

This section describes each of the following reports:

• Abandoned Call Detail Activity Report, page 3-9

• Aborted and Rejected Call Detail Report, page 3-10

• Agent Call Summary Report, page 3-13

• Agent Detail Report, page 3-15

• Agent Login Logout Activity Report, page 3-17

• Agent Not Ready Reason Code Summary Report, page 3-19

• Agent State Detail Report, page 3-21

• Agent State Summary Report (by Agent), page 3-23

• Agent State Summary Report (by Interval), page 3-25

• Agent Summary Report, page 3-28

• Agent Wrap-up Data Detail Report, page 3-31
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• Agent Wrap-up Data Summary Report, page 3-33

• Application Performance Analysis Report, page 3-35

• Application Summary Report, page 3-36

• Call Custom Variables Report, page 3-38

• Called Number Summary Activity Report, page 3-42

• Common Skill Contact Service Queue Activity Report (by Interval), 
page 3-43

• Contact Service Queue Activity Report, page 3-47

• Contact Service Queue Activity Report (by CSQ), page 3-49

• Contact Service Queue Activity Report (by Interval), page 3-53

• Contact Service Queue Call Distribution Summary Report, page 3-57

• Contact Service Queue Priority Summary Report, page 3-60

• Contact Service Queue Service Level Priority Summary Report, page 3-61

• CSQ–Agent Summary Report, page 3-63

• Detailed Call by Call CCDR Report, page 3-65

• Detailed Call, CSQ, Agent Report, page 3-69

• Multichannel Agent Contact Summary Report, page 3-72

• Multichannel Agent Login Logout Activity Report, page 3-74

• Multichannel CSQ Activity Report, page 3-76

• Outbound Agent Detail Performance Report, page 3-79

• Outbound Campaign Summary Report, page 3-82

• Priority Summary Activity Report, page 3-85

• Remote Monitoring Detail Report, page 3-87

• Traffic Analysis Report, page 3-89
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Abandoned Call Detail Activity Report
The Abandoned Call Detail Activity Report provides information about calls that 
are abandoned. For Unified CCX calls, a call is abandoned if it is not answered by 
an agent and the caller hangs up or is disconnected. For Unified IP IVR calls, a 
call is abandoned if it does not get past the workflow step that sets the handled 
flag. If a call has more than one leg that is abandoned (for example, an Unified IP 
IVR call that is processed by different applications), each abandoned leg is 
displayed in this report.

The Abandoned Call Detail Activity Report can include this chart:

The Abandoned Call Detail Activity Report includes a table that shows the 
following information for each abandoned call:

Chart Name Description

Calls Abandoned 
Each Day by Final 
Call Priority

For each day in the date range, displays the total number of calls abandoned and 
the final priority of the calls.

Field Description

Call Start Time Date and time that this call leg started.

Called Number Telephone number that the caller dialed.

Call ANI1 Telephone number of the originator of the call. If originated by an agent, the 
Unified CCX extension of the agent. If originated by a caller other than an agent, 
the telephone number of the caller.

Initial Call Priority Priority that the Unified CCX workflow assigned to the call when the call was 
received, from 1 (lowest) to 10 (highest). All calls start with a default priority of 
1, unless a different priority is set in the workflow.

Call Routed CSQ Names of up to the first 5 CSQs to which the call was queued. Multiple CSQ 
names are separated by commas.

Agent Name Name of the agent, if any, who was presented with the call before the call was 
abandoned.

Call Skills Up to 3 call skills associated with the CSQ to which the call was routed. Multiple 
skills are separated by commas.
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You can sort the Abandoned Call Detail Activity Report by any of these criteria:

Aborted and Rejected Call Detail Report
The Aborted and Rejected Call Detail Report provides detailed information about 
each call that is aborted or rejected by the system. A call is aborted if an exception 
occurs in the workflow that is processing a call. A call is rejected if system 
resources reach maximum capacity (for example, the maximum number of CTI 
ports is reached).

Final Call Priority Priority of the call when it was abandoned, from 1 (lowest) to 10 (highest).

Call Abandon Time Date and time that the call was abandoned.

Average Time to 
Abandon

Time to abandon is the duration from the time when the call comes to the system 
to the time when the call is abandoned. Average time to abandon is the average 
value for all calls abandoned during the report range.

1. ANI = automatic number identification

Field (continued) Description (continued)

Sort Criterion Result

Call Start Time Displays the report in order of the date and time that the call started.

Call ANI Displays the report in order of the telephone number that the caller is calling 
from.

Call Abandon Time Displays the report in order of the date and time that the call was abandoned.
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The Aborted and Rejected Call Detail Report can include this chart:

The Aborted and Rejected Call Detail Report includes a table that shows the 
following information for each aborted and rejected call:

Chart Name Description

Total Calls by 
Contact Disposition

Displays the total number of aborted calls and rejected calls during the report 
period.

A call is aborted when problems occur in executing the workflow script (for 
example, the workflow script throws exceptions).

A call is rejected when certain Unified CM or Cisco CRS resources are not 
sufficient for accepting incoming calls (for example, an insufficient number of 
CTI ports).

Field Description

Node ID – Session 
ID – Sequence No.

Node ID is the unique numeric ID that the system assigned to each CRS server 
in the cluster. It starts with number 1. (A Node ID value of 0 indicates that the 
data in the report is migrated from Cisco CRS 3.x.) Session ID is the unique 
session identification number that the system assigned to a call. Sequence No. 
is the session sequence number that the system assigned to each call leg. The 
session sequence number increases by 1 for each leg of a call.

Call Start Time,
Call End Time

Date and time that the call started, and date and time that the call was 
disconnected, transferred, or redirected.

Contact Type Contact type of a call (incoming, outgoing, internal, redirect, transfer-in).

Contact Disposition Disposition of the call (aborted or rejected).

Abort/Reject 
Reason

Reason that the call was aborted or rejected.

Originator DN1 If Originator Type is 1, this field shows the Unified CCX extension of the agent. 
If Originator Type is 2, this field shows the CTI2 port number. If Originator Type 
is 3, this field shows the telephone number of the caller.

Destination DN If Destination Type is 1, this field shows the Unified CCX extension of the 
agent. If Destination Type is 2, this field shows the CTI port number. If 
Destination Type is 3, this field shows the telephone number called.
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You can sort the Aborted and Rejected Call Detail Report by any of these criteria:

You can filter the Aborted and Rejected Call Detail Report by this parameter:

Called Number If the call was a transfer, the number that the call was transferred to. In other 
cases, this information is the same as the Original Called Number.

Original Called No. Number originally dialed by the caller. Can be either a route point number or an 
agent extension.

Application Name Name of the Unified CCX or Unified IP IVR application associated with the 
route point.

Call Routed CSQ CSQ to which the call was routed. This field is blank if the call was aborted or 
rejected before being routed to any CSQ.

1. DN = directory number

2. CTI = computer telephony interface

Field (continued) Description (continued)

Sort Criterion Result

Node ID – Session 
ID – Sequence No.

Displays the report in the order sorted by node ID, session ID, and sequence 
number.

Call Start Time Displays the report in order of call start times.

Abort – Reject 
Reason

Displays the report in alphabetical order by abort/reject reason.

Called Number Displays the report in order of the number that the caller dials.

Filter Parameter Result

Contact Disposition If you select Aborted, the report will show only aborted calls. If you select 
Rejected, the report will show only rejected calls. If you select both options, the 
report will show both types of calls.
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Agent Call Summary Report
The Agent Call Summary Report shows, for each agent specified, summary 
information about each call that was received (an inbound call) and each call that 
was made (an outbound call) by the agent. For inbound Unified CCX calls, this 
report shows the average time that the agent spent in Talk state, Work state, and 
on hold. For non-Unified CCX calls, this report shows the average and maximum 
talk time for the agent. For outbound calls, this report shows the average and 
maximum call time for the agent. This report also shows the number of calls 
transferred to the agent and transferred out (to another route point or another 
agent) by the agent, and the number of conference calls in which the agent 
participated.

The Agent Call Summary Report can include these charts:

The Agent Call Summary Report includes a table that shows the following 
information for each agent:

Chart Name Description

Total Inbound, 
Outbound Calls by 
Agent

Total number of calls received and calls made by agents.

Average Talk, Hold, 
Work Time for 
Inbound ACD

For Unified CCX calls received by agents, average time each agent spent in Talk 
state, on hold, and in Work state.

Average, Maximum 
Call Time for 
Outbound Calls

For calls made by agents, average and maximum time each agent spent on the 
call. (The time on a call includes time spent dialing, waiting for an answer, and 
talking).

Field Description

Agent Name First and last name of the agent.

Extension Unified CCX extension that the Unified CM assigned to the agent.

Total Inbound Total number of calls received by the agent. (Equal to inbound ACD calls + 
inbound non-ACD calls.)
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You can sort the Agent Call Summary Report by any of these criteria:

You can filter the Agent Call Summary Report by any of these parameters:

Inbound ACD— 
Total

Total number of Unified CCX calls received by the agent.

Inbound ACD—Avg 
Talk / Hold / Work

For Unified CCX calls received, the average time that the agent spent in Talk 
state, on hold, and in Work state.

Inbound 
Non-ACD—Total

Total number of non-Unified CCX calls received by the agent. This number 
includes calls made by other agents and by outside parties.

Inbound 
Non-ACD— Avg / 
Max Talk Time

For non-Unified CCX calls received, the average time that the agent spent 
talking, and the longest time that the agent spent talking for any 1 call. 

Outbound—Total Total number of calls made by the agent. This number includes calls attempted 
and calls connected.

Outbound—Avg / 
Max Call Time

For outbound calls the average call time, and the longest call time. Call time 
starts when an agent goes off-hook for a call and ends when the call terminates.

ACD Transfer-In Total number of Unified CCX calls transferred to the agent.

ACD Transfer-Out Total number of Unified CCX calls transferred out by the agent.

ACD Conference Total number of Unified CCX conference calls in which the agent participated.

Field (continued) Description (continued)

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents.

Total Inbound Calls Displays the report in order of the total number of calls received by agents.

Total Outbound 
Calls

Displays the report in order of the total number of calls made by agents.

Filter Parameter Result

Resource Group 
Names

Displays information for agents that belong to the specified resource groups. 

Agent Names Displays information for the specified agents. 
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Agent Detail Report
The Agent Detail Report contains detailed information about each Unified CCX 
call that was handled by an agent and each call that was made by an agent. It also 
includes information about non-Unified CCX calls. Unified CCX calls are defined 
as handled when an agent picks up the call. Unified CCX calls are calls dialed to 
a route point number. A non-Unified CCX call is any call that is not dialed to a 
route point number, for example, an internal call between agents or an outbound 
call.

The Agent Detail Report can include this chart:

The Agent Detail Report includes a table that shows the following information for 
every call received or made by each agent:

Skill Names Displays information for agents who possess the specified skills. 

Team Names Displays information for agents who belong to the selected teams.

Filter Parameter Result (continued)

Chart Name Description

Total Talk Time, 
Hold Time, Work 
Time by Agent

For each agent, displays the total talk time, the total hold time, and the total work 
time spent on all calls during the report period.

Field Description

Agent Name First and last name of the agent.

Extension Unified CCX extension that the Unified CM assigned to the agent.

Call Start Time,
Call End Time

Call start time is the date and time that the call leg rang at the agent extension. 
Call end time is the date and time call leg was disconnected or transferred.

Duration Elapsed time between call start time and call end time.

Called Number Telephone number that the caller dialed.
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Report Details
You can sort the Agent Detail Report by any of these criteria:

Call ANI Telephone number of the originator of the call. If originated by an agent, the 
Unified CCX extension of the agent. If originated by a caller other than an agent, 
the telephone number of the caller.

Call Routed CSQ CSQ that handled the call. A call is handled if a caller is connected to an agent 
while queued for this CSQ.

Other CSQs Names of CSQs to which the call was queued. Multiple CSQ names are 
separated by commas.

Call Skills Up to 3 call skills associated with the CSQ that handled the call. A call is 
handled if a caller is connected to an agent.

Talk Time For Unified CCX calls, elapsed time between the time an agent connected to the 
call and the time the call was disconnected or transferred, not including hold 
time. For non-Unified CCX calls, the duration of the entire call, if the call was 
answered.

Hold Time Total time that the call was on hold. Not applicable to non-Unified CCX calls.

Work Time Amount of time that an agent spent in Work state after the call. Not applicable 
to non-Unified CCX calls.

Call Type • Inbound ACD—Unified CCX call handled by an agent.

• Inbound non-ACD—Non-Unified CCX call that an agent received.

• Outbound—Call made by an agent (Unified CCX or non-Unified CCX).

• Transfer-In—Call transferred to an agent.

• Transfer-Out—Call transferred out by an agent.

• Conference—Conference call.

Field (continued) Description (continued)

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents.

Call Start Time Displays the report in order of call start times.

Call ANI Displays the report in order of the telephone number that the caller was calling 
from.
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Report Details
You can filter the Agent Detail Report by any of these parameters:

Agent Login Logout Activity Report
The Agent Login Logout Activity Report contains detailed information about the 
login and logout activities of agents. For each agent, it shows the login date and 
time and the logout date and time for each login session during the report period, 
and the reason code that an agent entered when logging out. This report also 
shows the duration of each login session, and the total login time for all login 
sessions.

The Agent Login Logout Activity Report can include this chart:

The Agent Login Logout Activity Report includes a table that shows the following 
information for each agent:

Filter Parameter Result

Resource Group 
Names

Displays information for agents that belong to the specified resource group or 
groups.

Agent Names Displays information for the specified agents.

Skill Names Displays information for agents that possess the specified skills.

Team Names Displays information for agents who belong to the specified teams.

Call Type Displays information for the specified call type (Inbound ACD, Inbound 
non-ACD, Outbound, Transfer-In, Transfer-Out, Conference)

Chart Name Description

Total Logged-In 
Time for Each Agent

For each agent, displays the total time logged in to the Unified CCX system.

Field Description

Agent Name First and last name of the agent.

Extension Unified CCX extension that Unified CM assigned to the agent. 
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Report Details
You can sort the Agent Login Logout Activity Report by any of these criteria:

You can filter the Agent Login Logout Activity Report by any of these parameters:

Login Time Date and time that the agent logged in to the Unified CCX system. If this 
information is preceded by a less-than sign (<), the agent logged in before the 
start time of the data in the report.

Logout Time Date and time that the agent logged out of the Unified CCX system. If this 
information is preceded by a greater-than sign (>), the agent was still logged in 
at the end time of the data in the report.

Logout Reason 
Code

Numeric reason code that the agent enters when the agent logs out from the 
Cisco Agent Desktop. A value of 0 indicates that no logout reason code is 
configured or that the agent was unable to enter a reason code.

Logged-In Duration Elapsed time between the Login Time and the Logout Time.

Total Total log-in time for each agent.

Grand Total Total logged-in duration for all agents during the report period.

Field (continued) Description (continued)

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents.

Login Time Displays the report in order of the time that agents logged in to the system.

Logged-in Duration Displays the report in order of the length of time that agents were logged in to 
the system.

Filter Parameter Result

Resource Group 
Names

Displays information for agents that belong to the specified resource group or 
groups.

Agent Names Displays information for the specified agents.

Skill Names Displays information for agents that possess the specified skills.

Team Names Displays information for agents who belong to the specified teams.
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Report Details
Agent Not Ready Reason Code Summary Report
The Agent Not Ready Reason Code Summary Report provides information about 
the length of time each agent spent in Not Ready state during the report period. 
For each agent, it shows the total log in time and the total time spent in Not Ready 
state. 

This report also shows the length of time that agents spent in Not Ready state for 
the reasons indicated by the reason codes that agents entered when going to Not 
Ready state. The report shows detailed information for each of up to eight reason 
codes, and displays consolidated information for other reason codes. By default, 
the report shows information for eight predefined reason codes. However, you can 
specify the reason codes for which the report shows detailed information (see 
Appendix A, “Cisco CRS Reason Codes”).

This report can show information for each 30-minute or 60-minute interval within 
the report period.

The Agent Not Ready Reason Code Summary Report can include this chart:

The Agent Not Ready Reason Code Summary Report includes a table that shows 
the following information for each agent that remains in Not Ready state:

Chart Name Description

Total Not Ready 
Time by Agent and 
Reason Code

For each agent, displays the time that the agent spent in each not ready reason 
code during the report period. Up to 8 reason codes are displayed in detail. 
Additional reason code appear as a total under “Other Reason Codes”.

Field Description

Agent Name First name and last name of the agent.

Extension Unified CCX extension that Unified CM assigned to the agent. 

Interval Start Time,
Interval End Time

Beginning date and time and ending date and time of each 30– or 60–minute 
interval within the report period, if you specify an interval with the Interval 
Length filter parameter. Otherwise, the beginning date and time and ending date 
and time of the report range. 

Total Logged-in Total time that the agent was logged in to the Unified CCX system during the 
interval.
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Report Details
You can sort the Agent Not Ready Reason Code Summary Report by this 
criterion:

Total Not Ready Total time that an agent spent in Not Ready state during the interval.

Time in RC n1 Total time that an agent spent in Not Ready state for the reason indicated by 
reason code n1, where n1 is a system-defined reason code.

Time in RC n2 Total time that an agent spent in Not Ready state for the reason indicated by 
reason code n2, where n2 is a system-defined reason code.

Time in RC n3 Total time that an agent spent in Not Ready state for the reason indicated by 
reason code n3, where n3 is a system-defined reason code.

Time in RC n4 Total time that an agent spent in Not Ready state for the reason indicated by 
reason code n4, where n4 is a system-defined reason code.

Time in RC n5 Total time that an agent spent in Not Ready state for the reason indicated by 
reason code n5, where n5 is a system-defined reason code.

Time in RC n6 Total time that an agent spent in Not Ready state for the reason indicated by 
reason code n6, where n6 is a system-defined reason code.

Time in RC n7 Total time that an agent spent in Not Ready state for the reason indicated by 
reason code n7, where n7 is a system-defined reason code.

Time in RC n8 Total time that an agent spent in Not Ready state for the reason indicated by 
reason code n8, where n8 is a system-defined reason code.

Time in Other RCs Total time that an agent spent in Not Ready state for the reasons indicated by 
reason codes that are not shown in the previous 8 columns.

Field (continued) Description (continued)

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents. 
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Report Details
You can filter the Agent Not Ready Reason Code Summary Report by any of these 
parameters:

Agent State Detail Report
The Agent State Detail Report shows detailed information about when the agent 
changed from one state to another. For each agent specified, this report shows the 
date and time of each state change, the name of the state changed to, the reason 
code, if any, for the change to Logout state or Not Ready state, and the length of 
time spent in each state.

Filter Parameter Result

Interval Length Entire report range—Displays information from the report start time through 
the report end time, but does not display information for specific intervals within 
the report period. 

Thirty (30) minute intervals—Displays information for 30-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 30 minutes after the report start time, and so on. 

Sixty (60) minute intervals—Displays information for 60-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 60 minutes after the report start time, and so on.

Resource Group 
Names

Displays information for agents who belong to the specified resource group or 
groups. 

Agent Names Displays information for the specified agents. 

Skill Names Displays information for agents who possess the specified skills. 

Team Names Displays information for agents who belong to the selected teams.

Reason Code Displays information for the selected reason codes. Up to 8 reason codes are 
displayed in detail. Additional reason codes appear as a total under Time in 
Other RCs.
3-21
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 3      Descriptions of Historical Reports
Report Details
The Agent State Detail Report can include this chart:

The Agent State Detail Report includes a table that shows the following 
information for each agent:

You can sort the Agent State Detail Report by this criterion:

Chart Name Description

Agent State 
Duration by Agent

For each agent, displays the length of time spent in each agent state.

Field Description

Agent Name First name and last name of the agent.

Extension Unified CCX extension that the Unified CM assigned to the agent.

State Transition 
Time

Date and time that the agent went to the state shown in the corresponding Agent 
State field.

Agent State The state of the agent (Login, Logout, Not Ready, Ready, Reserved, Talk, or 
Work).

Reason Code The reason code indicating why the agent went to Logout state or Not Ready 
state. 0 (zero) for other states.

Duration Length of time that the agent spent in the state shown in the corresponding 
Agent State field.

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents then by the date 
and time that an agent went to another state.
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Report Details
You can filter the Agent State Detail Report by any of these parameters:

Agent State Summary Report (by Agent)
The Agent State Summary Report (by Agent) shows, for each agent specified, the 
length and percentage of time that the agent spent in each of the following agent 
states: Not Ready, Ready, Reserved, Talk, and Work. This report also shows the 
total length of time that each agent was logged in. The Agent State Summary 
Report (by Agent) can show information for each 30-minute or 60-minute interval 
within the report period. In this case, the report will include a summary line for 
each agent that shows the length and percentage of time that the agent spent in 
each of the agent states during the report period.

The information in the Agent State Summary Report (by Agent) is grouped by 
agent. The Agent State Summary Report (by Interval) displays the same 
information grouped by interval. For more information, see the “Agent State 
Summary Report (by Interval)” section on page 3-25.

The Agent State Summary Report (by Agent) can include this chart:

Filter Parameter Result

Resource Group 
Names

Displays information for agents who belong to the specified resource groups. 

Agent Names Displays information for the specified agents. 

Skill Names Displays information for agents who possess the specified skills. 

Team Names Displays information for agents who belong to the selected teams.

Chart Name Description

Time Spent in Agent 
State by Agent

For each agent, displays the length of time spent in each agent state.
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Report Details
The Agent State Summary Report (by Agent) includes a table that shows the 
following information for each agent:

Field Description

Agent Name First name and last name of the agent.

Extension Unified CCX extension that the Unified CM assigned to the agent.

Interval Start Time,
Interval End Time

Beginning date and time and ending date and time of each 30- or 60-minute 
interval within the report period, if you specify an interval with the Interval 
Length filter parameter. Otherwise, the beginning date and time and ending date 
and time of the report range.

Total Logged-in 
Time

Total time that the agent was logged in to the Unified CCX system during the 
interval.

Not Ready Time Length and percentage of time that an agent spent in Not Ready state during the 
interval.

Ready Time Length and percentage of time that an agent spent in Ready state during the 
interval.

Reserved Time Length and percentage of time that an agent spent in Reserved state during the 
interval.

Talk Time Length and percentage of time that an agent spent in Talk state during the 
interval.

Work Time Length and percentage of time that an agent spent in Work state during the 
interval.

Summary For each agent in the report range, total logged-in time, total and percentage not 
ready time, total and percentage ready time, total and percentage reserved time, 
total and percentage talk time, and total and percentage work time.

Grand Total Total information for all agents during the report period. Includes total logged-in 
time, total and percentage not ready time, total and percentage ready time, total 
and percentage reserved time, total and percentage talk time, and total and 
percentage work time.
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Report Details
You can sort the Agent State Summary Report (by Agent) by this criterion:

You can filter the Agent State Summary Report (by Agent) by any of these 
parameters:

Agent State Summary Report (by Interval)
The Agent State Summary Report (by Interval) shows, for each agent specified, 
the length and percentage of time that the agent spent in each of the following 
agent states: Not Ready, Ready, Reserved, Talk, and Work. This report also shows 
the total length of time that each agent was logged in. The Agent State Summary 
Report (by Interval) can show information for each 30-minute or 60-minute 
interval within the report period. In this case, the report will include a summary 
line for each interval that shows the length and percentage of time that all agents 
spent in each of the agent states during the interval.

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents.

Filter Parameter Result

Interval Length Entire report range—Displays information from the report start time through 
the report end time, but does not display information for specific intervals within 
the report period.

Thirty (30) minute intervals—Displays information for 30-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 30 minutes after the report start time, and so on.

Sixty (60) minute intervals—Displays information for 60-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 60 minutes after the report start time, and so on.

Resource Group 
Names

Displays information for agents who belong to the specified resource group or 
groups.

Agent Names Displays information for the specified agents.

Skill Names Displays information for agents who possess the specified skills.

Team Names Displays information for agents who belong to the selected teams.
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Report Details
The information in the Agent State Summary Report (by Interval) is grouped by 
30- or 60-minute intervals within the report period. The Agent State Summary 
Report (by Agent) displays the same information grouped by agent. For more 
information, see the “Agent State Summary Report (by Agent)” section on 
page 3-23.

The Agent State Summary Report (by Interval) can include this chart:

The Agent State Summary Report (by Interval) includes a table that shows the 
following information for each agent:

Chart Name Description

Time Spent in Agent 
State by Interval

For each time interval, displays the length of time spent in each agent state by 
all agents.

Field Description

Interval Start Time,
Interval End Time

Beginning date and time and ending date and time of each 30- or 60-minute 
interval within the report period, if you specify an interval with the Interval 
Length filter parameter. Otherwise, the beginning date and time and ending date 
and time of the report range

Agent Name First name and last name of the agent.

Extension Unified CCX extension that the Unified CM assigned to the agent.

Total Logged-in 
Time

Total time that the agent was logged in to the Unified CCX system during the 
interval.

Not Ready Time Length and percentage of time that an agent spent in Not Ready state.

Ready Time Length and percentage of time that an agent spent in Ready state.

Reserved Time Length and percentage of time that an agent spent in Reserved state.

Talk Time Length and percentage of time that an agent spent in Talk state.

Work Time Length and percentage of time that an agent spent in Work state.
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Report Details
You can sort the Agent State Summary (by Interval) by this criterion:

You can filter the Agent State Summary Report (by Interval) by any of these 
parameters:

Summary For all agents in each interval in the report range, total logged-in time, total and 
percentage not ready time, total and percentage ready time, total and percentage 
reserved time, total and percentage talk time, and total and percentage work 
time.

Grand Total Total information for all agents and all intervals during the report period. 
Includes total logged-in time, total and percentage not ready time, total and 
percentage ready time, total and percentage reserved time, total and percentage 
talk time, and total and percentage work time.

Field (continued) Description (continued)

Sort Criterion Result

Interval Start Time Displays the report in order of the start times of the 30- or 60-minute intervals, 
if you specify an interval with the Interval Length filter parameter.

Filter Parameter Result

Interval Length Entire report range—Displays information from the report start time through 
the report end time, but does not display information for specific intervals within 
the report period.

Thirty (30) minute intervals—Displays information for 30-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 30 minutes after the report start time, and so on.

Sixty (60) minute intervals—Displays information for 60-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 60 minutes after the report start time, and so on.

Resource Group 
Names

Displays information for agents that belong to the specified resource group or 
groups.

Agent Names Displays information for the specified agents.
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Report Details
Agent Summary Report
The Agent Summary Report contains a summary of the activities of agents, 
including call and agent state activities.

The Agent Summary Report can include these charts:

The Agent Summary Report includes a table that shows the following information 
for each agent:

Skill Names Displays information for agents who possess the specified skills.

Team Names Displays information for agents who belong to the selected teams.

Filter Parameter Result (continued)

Chart Name Description

Call Handle Ratio 
by Agent

For each agent, displays the number of calls handled by the agent divided by the 
number of calls presented to that agent.

Total Calls Handled 
by Agent

For each agent, displays the total number of calls handled.

Average Talk Time, 
Hold Time, Work 
Time by Agent

For each agent, displays the average time spent in Talk state, on hold, and in 
Work state.

Field Description

Agent Name First name and last name of the agent.

Extension Unified CCX extension that the Unified CM assigned to the agent.

Average Logged-In 
Time

Total logged in time of the agent divided by the number of logged in sessions of 
the agent.

Calls Handled Number of calls connected to the agent.

If the agent establishes a conference with another agent, this value increases by 
1 for the conferenced agent.

If the agent transfers a call and later receives the call back as a transfer, this 
value increases by 2.
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Report Details
You can sort the Agent Summary Report by any of these criteria:

Calls Presented Number of calls sent to the agent, whether or not the agent picked up the call.

If a call was connected to an agent, transferred to another agent, and then 
transferred back to the original agent, the value for the original agent increases 
by two (once for each time the call was presented).

Handle Ratio Number of calls that the agent handled divided by the number of calls presented 
to the agent.

Handle Time—Avg Average handle time for all calls that the agent handled. Handle time is 
talk time + hold time + work time.

Handle Time—Max Longest handle time of any one call that the agent handled. Handle time is talk 
time + hold time + work time.

Talk Time—Avg Average talk time for all calls that the agent handled. Talk time is the elapsed 
time between the time that an agent connects to a call and when the call is 
disconnected or transferred, not including hold time.

Talk Time—Max Longest talk time of any one call that the agent handled. Talk time is the elapsed 
time between the time that an agent connects to a call and when the call is 
disconnected or transferred, not including hold time.

Hold Time—Avg Average total hold time for all calls that the agent handled.

Hold Time—Max Longest total hold time of any one call that the agent handled.

Work Time—Avg Average amount of time that an agent spent in Work state after calls.

Work Time—Max Longest amount of time that an agent spent in Work state after any 1 call.

Idle Time—Avg Average amount of time that an agent spent in Not Ready state.

Idle Time—Max Longest single amount of time that an agent spent in Not Ready state.

Field (continued) Description (continued)

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents.

Avg Logged-In 
Time

Displays the report in order of the average time that agents were logged in to the 
system.
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You can filter the Agent Summary Report by any of the following parameters. For 
the Top N and the Bottom N parameters, you specify the number (N) of agents 
that you want the report to show. For example, if you specify 3 for the Top N Calls 
Handled/Presented Ratio parameter, the report will show the three agents with the 
largest ratios. If more than n agents, where n is the number that you specify, have 
identical largest or smallest values, the report shows the first n agents in 
alphabetical order.

Total Calls 
Presented

Displays the report in order of the number of calls presented to agents.

Total Calls Handled Displays the report in order of the number of calls handled by agents.

Sort Criterion Result (continued)

Filter Parameter Result

Resource Group 
Names

Displays information for agents that belong to the specified resource group or 
groups.

Agent Names Displays information for the specified agents.

Skill Names Displays information for agents who possess the specified skills.

Team Names Displays information for agents who belong to the selected teams.

Top N Calls 
Handled/Presented 
Ratio

Displays information for the n agents with the largest ratios of calls handled to 
calls presented.

Bottom N Calls 
Handled/Presented 
Ratio

Displays information for the n agents with the smallest ratios of calls handled to 
calls presented.

Top N Avg Hold 
Time

Displays information for the n agents with the longest average hold times.

Bottom N Avg Hold 
Time

Displays information for the n agents with the shortest average hold times.

Top N Avg Talk 
Time

Displays information for the n agents with the longest average talk times.

Bottom N Avg Talk 
Time

Displays information for the n agents with the shortest average talk times.
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Agent Wrap-up Data Detail Report
The Agent Wrap-up Data Detail Report displays the details entered by an agent 
when entering the work state after attending an Automatic Contact Distribution 
(ACD) call. With the wrap-up data feature, an agent can choose to enter the work 
state to update data associated with that call.

The Agent Wrap-up Data Detail Report can include these charts:

The Agent Wrap-up Data Detail Report includes a table that shows the following 
information:

Top N Avg Work 
Time

Displays information for the n agents with the longest average work times.

Bottom N Avg Work 
Time

Displays information for the n agents with the shortest average work times.

Top N Avg Handle 
Time

Displays information for the n agents with the longest average handle times.

Bottom N Avg 
Handle Time

Displays information for the n agents with the shortest average handle times.

Filter Parameter Result (continued)

Chart Name Description

Total Calls by Agent 
and Wrap-up data

Displays total number of called handled by each agent (account enquiry, new 
customer information, and VIP customer information) for each wrap-up data

Field Description

Agent Name The name of the agent who handled the ACD call.

Extension The ACD extension of the agent who handled the call.

NodeID-SessionID-
SessionSeqNum

Node ID of the CRS engine which processed the call. Session ID and session 
sequence number assigned to the call. Together, these three values uniquely 
identify an ACD call processed by the system.

Call Start Time The time when the call is connected with the agent.
3-31
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 3      Descriptions of Historical Reports
Report Details
You can sort the Agent Wrap-up Data Detail Report by this criterion:

You can filter the Agent Wrap-up Data Detail Report by these parameters:

Call End Time The time when the call is disconnected from the agent.

Call ANI The phone number of the calling party.

Called Number The number dialed by the calling party.

Call Routed CSQ 
(Skills)

The CSQ to which the call is routed and handled. A call can be queued to 
multiple CSQs. This particular CSQ also handled the call.

Talk Time The time the agent spent in talking to the caller.

Hold Time The time the agent spent in putting the caller on hold.

Work Time The time the agent spent in after-call work state.

Wrap-Up Data Textual description of the wrap-up data, as entered by the agent in work state.

Field (continued) Description (continued)

Sort Criterion Result

Agent Name Displays the report in alphabetical order of agent names. Within the same agent, 
report data is sorted by call start time.

Filter Parameter Result

Agent Name Displays the selected agent(s) to be displayed in the report.

Resource Group 
Name

Displays agents who belong to the selected resource group(s).

Skill Name Displays agents with the selected skill(s).

Team Name Displays agents who belong to the selected team(s).
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Agent Wrap-up Data Summary Report
The Agent Wrap-up Data Summary Report shows detailed information of each 
wrap-up data. This report is available with the agent wrap-up feature. 

The Agent Wrap-up Data Summary Report can include these charts:

The Agent Wrap-up Data Summary Report includes a table that shows the 
following information:

Chart Name Description

Total ACD Calls by 
Wrap-up Data

Displays the total number of calls handled by the agent for each wrap-up data. 

Average Handle, 
Talk, Work Time by 
Wrap-up data

Displays the amount of time spent (handling the ACD call, talk time, and work 
time) by the agent for each wrap-up data.

Field Description

Wrap-Up Data Textual description of the wrap-up data, as entered by the agent in work state.

Total ACD Calls Total number of ACD calls to which this wrap-up data is associated.

Total Handle Time Total handle time of the ACD calls to which this wrap-up data is associated. 
Handle time refers to the combined total of the talk, hold, and work times.

Average Handle 
Time

Total handle time divided by total ACD calls for this wrap-up data.

Max Handle Time Maximum handle time of the ACD calls to which this wrap-up data is 
associated. 

Total Talk Time Total time that the agent spends talking to the caller.

Average Talk Time Total talk time divided by total ACD calls for this wrap-up data.

Max Talk Time Maximum time that the agent spends talking to the caller.

Total Talk Time as 
% of Total Handle 
Time

Total talk time divided by total handle time, for this wrap-up data. Converted to 
percentage format.
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You can sort the Agent Wrap-up Data Summary Report by this criterion:

You can filter the Agent Wrap Data Summary Report by this parameter:

Total Work Time Total time spent by agents in the work state for all the ACD calls to which this 
wrap-up data is associated.

Average Work Time Total work time divided by total ACD calls for this wrap-up data.

Max Work Time Maximum time spent by agents in the work state for all the ACD calls to which 
this wrap-up data is associated.

Total Work Time as 
% of Total Handle 
Time

Total work time divided by total handle time, for this wrap-up data. This total is 
then converted to percentage format.

Field (continued) Description (continued)

Sort Criterion Result

Wrap-Up Data Displays the report in alphabetical order by wrap-up data text.

Total ACD Calls Displays the report in ascending order of total number of ACD calls.

Total Handle Time Displays the report in ascending order of total call handle time.

Average Handle 
Time

Displays the report in ascending order of average call handle time.

Total Talk Time Displays the report in ascending order of total talk time.

Average Talk Time Displays the report in ascending order of average talk time.

Total Work Time Displays the report in ascending order of total work time.

Average Work Time Displays the report in ascending order of average work time.

Filter Parameter Result

Wrap-Up Data Displays statistics of the selected wrap-up data.
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Application Performance Analysis Report
The Application Performance Analysis Report shows information about calls 
presented to, handled by, and abandoned from each Unified CCX or Unified IP 
IVR application.

The Application Performance Analysis Report can include these charts:

The Application Performance Analysis Report includes a table that shows the 
following information for each Unified CCX or Unified IP IVR application:

Chart Name Description

Calls Presented by 
Application

Displays the total number of calls that each application received.

Calls Handled vs. 
Calls Abandoned by 
Application

Displays the total number of calls handled by each application and total number 
of calls abandoned while in each application.

Average Call 
Duration by 
Application

Displays the average length of calls that each application received.

Field Description

Application ID Identification number that the Cisco CRS system assigned to the application.

Application Name Name of the Unified CCX or Unified IP IVR application.

Calls Presented Number of calls received by the application. This number is equal to the number 
of calls handled by the application + the number of calls abandoned while in the 
application.

Calls Handled Number of calls handled by the application. A call is handled when it reaches 
the workflow step that defines the call as handled, or when it is handled by an 
agent.

Calls Abandoned Number of calls abandoned, aborted, or rejected while in the application. A call 
is abandoned if it does not reach the workflow step that defines the call as 
handled, or if the caller hangs up before the call is connected to an agent.
3-35
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 3      Descriptions of Historical Reports
Report Details
You can sort the Application Analysis Performance Report by any of these 
criteria:

Application Summary Report
The Application Summary Report contains summary call statistics for each 
Unified CCX or Unified IP IVR application. It includes information for presented, 
handled, abandoned, flow-in, and flow-out calls. It also includes information 
about call talk time, work time, and abandon time.

The Application Summary Report can include this chart:

Abandon Rate (per 
hour)

Average number of calls abandoned in each hour while in the application.

Avg Call Duration Average time that elapsed from the time that the call entered this workflow until 
the call exited this workflow by hanging up or entering another workflow.

Field (continued) Description (continued)

Sort Criterion Result

Application ID Displays the report in order of the identification number that the system 
assigned to each application.

Calls Presented Displays the report in order of the number of calls received by each application.

Call Abandon Rate Displays the report in order of average number of calls abandoned per hour 
while in each application.

Chart Name Description

Calls Presented by 
Application

Displays the number of calls received by each Unified CCX or Unified IP IVR 
application.
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The Application Summary Report includes a table that shows the following 
information for each Unified CCX or Unified IP IVR application:

Field Description

Application Name Name of the Unified CCX or Unified IP IVR application. 

Called Number The telephone number dialed by the caller if the call was placed from a Cisco 
Unified Communications phone. The Unified CM directory number to which the 
VoIP gateway routed the call if the call was placed from outside the VoIP 
network (for example, from the PSTN or a TDM PBX).

Calls Presented Number of calls received by the application. This number is equal to the number 
of calls handled by the application + the number of calls abandoned while in the 
application. 

Flow-In Number of calls redirected to this application from another application via a 
workflow. Does not include calls that come from another agent or an external 
system such as a voice messaging system.

Flow-Out Number of calls that this application sent to another application or external 
destination without being handled by an agent.

Calls Handled Number of calls handled by the application or by an agent. A call is handled by 
the application when it reaches the workflow step that defines the call as 
handled. A call is handled by an agent when the call is connected to and 
answered by an agent.

Avg Speed Answer Calculated as queue time plus ring time divided by number of calls.

Calls that do not connect to an agent are not included in this calculation.

Avg Talk Time Average talk time for all calls handled by an agent. Talk time is the elapsed time 
between the time that an agent connects to a call and when the call is 
disconnected or transferred, not including hold time. This value is calculated as 
total talk time divided by number of calls handled by the agent.

Calls that do not connect to an agent are not included in this calculation.

Avg Work Time For calls handled by an agent, the average amount of time that an agent spent in 
Work state after completing the calls. This value is calculated as total work time 
divided by number of calls handled by the agent.

Calls that do not connect to an agent are not included in this calculation.
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You can sort the Application Summary Report by this criterion:

You can filter the Application Summary Report by this parameter:

Call Custom Variables Report
The Call Custom Variables Report shows information about any custom variables 
set by the Set Session Info step in the workflow that the Unified CCX or Unified 
IP IVR application associated with this call.

The Call Custom Variables Report includes the following information:

Calls Abandoned Number of calls abandoned for this application. A call is abandoned if it does 
not reach the workflow step that defines the call as handled or if the caller 
terminates the call before an agent answers it. This value includes calls aborted 
or rejected by the system.

Avg Abandon Time Average duration of calls before they were abandoned.

Field (continued) Description (continued)

Sort Criterion Result

Application Name Displays the report in alphabetical order by the names of the applications.

Filter Parameter Result

Application Names Displays information for the selected applications.

Field Description

Node ID – Session 
ID – Sequence No.

Node ID is the unique numeric ID assigned by the system to each CRS server in 
the cluster. It starts with number 1. Session ID is the unique session 
identification number assigned by the system to each call. Sequence No. is the 
session sequence number assigned by the system to each call leg. The session 
sequence number increases by 1 for each leg of a call.

Note A Node ID value of 0 indicates that the data in the report is migrated from Cisco CRS 3.x.
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Start Time,
End Time

Date and time that the call started, and date and time that the call was 
disconnected, transferred, or redirected.

Contact Disposition Disposition of a call (abandoned, handled, aborted, or rejected).

For an Unified CCX call, a call is abandoned if the call disconnects before 
connecting to an agent. The call is handled when the call is connected to an 
agent.

For an Unified IP IVR call, a call is abandoned if it does not reach the workflow 
step that defines the call as handled. The call is handled when it reaches this 
step.

A call is aborted when problems occur in executing the workflow script (for 
example, the workflow script throws exceptions).

A call is rejected when certain Unified CM or Cisco CRS resources are not 
sufficient for accepting incoming calls (for example, an insufficient number of 
CTI ports).

Agent Name For an Unified CCX call, the name of the agent who handled this call.

Application Name Name of the Unified CCX or Unified IP IVR application associated with the 
route point.

Custom Variable 1 The contents of the variable _ccdrVar1, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Custom Variable 2 The contents of the variable _ccdrVar2, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Custom Variable 3 The contents of the variable _ccdrVar3, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Custom Variable 4 The contents of the variable _ccdrVar4, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Custom Variable 5 The contents of the variable _ccdrVar5, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Field (continued) Description (continued)
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You can sort the Call Custom Variables Report by either of these criteria:

You can filter the Call Custom Variables Report by these parameters:

Custom Variable 6 The contents of the variable _ccdrVar6, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Custom Variable 7 The contents of the variable _ccdrVar7, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Custom Variable 8 The contents of the variable _ccdrVar8, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Custom Variable 9 The contents of the variable _ccdrVar9, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Custom Variable 10 The contents of the variable _ccdrVar10, if this variable is set by the Set Session 
Info step in the workflow that the Unified CCX or Unified IP IVR application 
associated with this call or this leg invoked.

Field (continued) Description (continued)

Sort Criterion Result

Node ID – Session 
ID – Sequence No.

Displays report in the order of Node ID, Session ID, and Sequence Number of 
the call.

Call Start Time Displays the report in order of call start times.

Filter Parameter Result

Original Called 
Number

Displays information for the specified original called number or numbers

Called Number Displays information for the specified called number or numbers.

Calling Number Displays information for the specified calling number or numbers. Calling 
number is the same as Originator DN.

Application Name Displays information for the specified application or applications.
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Contact Type Displays information for the specified contact type or types (incoming, 
outgoing, internal, redirect, or transfer-in).

Originator Type Displays information for the specified originator type or types (agent, device, or 
unknown).

Destination Type Displays information for the specified destination type or types (agent, device, 
or unknown).

Duration Greater 
Than or Equal to T 
seconds

Displays calls with duration greater than or equal to the number of seconds 
specified by T.

Duration Less Than 
or Equal to T 
seconds

Displays calls with duration less than or equal to the number of seconds 
specified by T.

Custom Variable 1 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 1 contains the string or any of the substrings entered.

Custom Variable 2 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 2 contains the string or any of the substrings entered.

Custom Variable 3 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 3 contains the string or any of the substrings entered.

Custom Variable 4 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 4 contains the string or any of the substrings entered. 

Custom Variable 5 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 5 contains the string or any of the substrings entered.

Custom Variable 6 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 6 contains the string or any of the substrings entered.

Custom Variable 7 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 7 contains the string or any of the substrings entered.

Filter Parameter Result (continued)
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Called Number Summary Activity Report
The Called Number Summary Activity Report shows information about each 
number dialed by an inside or outside caller. This report includes information for 
calls to Unified CCX and Unified IP IVR applications and for calls to agents.

The Called Number Summary Activity Report can include these charts:

Custom Variable 8 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 8 contains the string or any of the substrings entered.

Custom Variable 9 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 9 contains the string or any of the substrings entered.

Custom Variable 10 Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
for which Custom Variable 10 contains the string or any of the substrings 
entered.

Any Custom 
Variable

Enter a whole string or a substring for which to search. Separate multiple strings 
with commas. When this filter parameter is specified, the report displays calls 
with any of the 10 custom variables containing the string or any of the substrings 
entered.

Filter Parameter Result (continued)

Chart Name Description

Total Calls by 
Called Number

Displays the total number of calls to each number, including calls to applications 
and calls to agents.

Average Call 
Duration by Called 
Number

Displays the average time that each call lasted for each number dialed.
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The Called Number Summary Activity Report includes a table that shows the 
following information for each number called:

You can sort the Called Number Summary Activity Report by any of these criteria:

Common Skill Contact Service Queue Activity Report (by Interval)
The Common Skill Contact Service Queue Activity Report (by Interval) shows 
summary information about calls presented, calls handled, and calls abandoned 
for each group of CSQs. (Such a group consists of CSQs that are configured with 
the same skill or skills and with difference competence levels.)

This report is designed for customers who have logical CSQs configured. A 
logical CSQ is a group of CSQs configured with the same skill but with different 
competence levels. When a call comes in to a script that uses the “logical CSQ” 
approach, it first goes to the CSQ with the lowest skill level. If the wait time 
exceeds the predefined threshold, the call goes to the next higher skill level. So, 

Field Description

Called Number For a call to a Unified CCX or Unified IP IVR application, the route point 
number associated with the application. For a call to an agent, the extension of 
the destination agent.

Call Type Call to an application or call to an agent.

Total Calls Total number of calls to each number.

Avg Calls (per day) Average number of calls per day.

Avg Call Duration Average duration of calls to each number.

Sort Criterion Result

Called Number Displays the report in order of the number called. For calls to an application, this 
number is the route point number. For calls to an agent, this number is the 
extension of the agent.

Total Calls Displays the report in order of the total number of calls that were originally 
dialed to each number.

Avg Call Duration Displays the report in order of the average duration of calls to each number.
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the same incoming call can flow within the same group of CSQs. The value on the 
Calls Presented summary line shows the maximum number of calls presented to 
all CSQs within the same group rather than the total number of calls presented to 
all CSQs within the same group. Calculating the sum could result in counting the 
same call multiple times because the call could be presented to different CSQs 
within the same logical group. For Calls Handled, this reports shows the total 
number of calls because one call can only be handled by one CSQ. For Calls 
Abandoned, this report shows the maximum number of all calls abandoned from 
all CSQs within the same group.

This report provides additional information for multiple CSQs that are configured 
with the same call skill but with different competence levels. An incoming call 
may be queued for the CSQ with the lowest competence level. If no agent is 
available for a certain period, the call will be queued for the next higher 
competence level. The summary line in the report displays the summarized 
statistics for the group of CSQs configured with common skills. A group of CSQs 
that is configured in this manner is called a logical CSQ.

This report can show information for each 30-minute or 60-minute interval within 
the report period. It is particularly useful for logical CSQs. If you do not have 
logical CSQs configured, consider using other CSQ reports (Contact Service 
Queue Activity Report, Contact Service Queue Activity Report by Interval/CSQ).

The Common Skill Contact Service Queue Activity Report (by Interval) can 
include this chart:

Chart Name Description

Calls Handled and 
Calls Abandoned by 
Interval

Number of calls handled and abandoned during each interval during the report 
period.
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The Common Skill Contact Service Queue Activity Report (by Interval) includes 
a table that shows the following information for calls presented, handled, and 
abandoned for each group of CSQs:

Field Description

Interval Start Time,
Interval End Time

Beginning date and time and ending date and time of each 30– or 60–minute 
interval within the report period, if you specify an interval with the Interval 
Length filter parameter. Otherwise, the beginning date and time and ending date 
and time of the report range. 

CSQ Name [Skills 
(Competence 
Level)]

Name of the CSQ, the skill or skills configured for this CSQ, and the 
competence level of each skill.

Calls Presented— 
Total

Number of calls offered to each individual CSQ within the group, whether or not 
an agent answered the call.

Calls Presented— 
Queue Time Avg

Average queue time for all calls routed to the CSQ.

Calls Presented— 
Queue Time Max

Longest queue of all calls routed to the CSQ (abandoned, handled, aborted, or 
rejected).

Calls Handled— 
Total

Number of calls handled by this CSQ. A call is handled if a caller is connected 
to an agent while queued for this CSQ.

Calls Handled— 
Handle Time Avg

Average handle time for all calls that the CSQ handled. Handle time is talk time 
+ hold time + work time.

Calls Handled— 
Handle Time Max

Longest handle time for any one call that the CSQ handled. Handle time is talk 
time + hold time + work time.

Calls Abandoned— 
Total

Number of calls routed to the CSQ but were not answered by an agent because 
the caller hung up or was disconnected.

Calls Abandoned— 
Queue Time Avg

Average time calls spent in queue before being abandoned.

Calls Abandoned— 
Queue Time Max

Maximum time any one call spent in queue before being abandoned.

Service Level— 
Percentage SL Met

Calculated as follows:

(calls handled within service level / by calls presented) * 100%.

Summary for Skills For each group of CSQs and each interval, total calls presented, calls handled, 
and calls abandoned.
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You can sort the Common Skill Contact Service Queue Activity Report (by 
Interval) by this criterion:

You can filter the Common Skill Contact Service Queue Activity Report (by 
Interval) by this parameter:

Sort Criterion Result

Interval Start Time Displays the report in order of the start times of the 30- or 60-minute intervals, 
if you specify an interval with the Interval Length filter parameter.

Filter Parameter Result

Interval Length Entire report range—Displays information from the report start time through 
the report end time, but does not display information for specific intervals within 
the report period.

Thirty (30) minute intervals—Displays information for 30-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 30 minutes after the report start time, and so on.

Sixty (60) minute intervals—Displays information for 60-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 60 minutes after the report start time, and so on.

CSQ Names Displays information for the specified CSQs.
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Contact Service Queue Activity Report
The Contact Service Queue Activity Report shows a summary of calls presented 
to, handled by, abandoned from, and dequeued from each CSQ. It also shows calls 
handled by workflows in other CSQs, and average and maximum time information 
for calls handled, calls handled, calls abandoned, and calls dequeued.

The Contact Service Queue Activity Report can include these charts:

The Contact Service Queue Activity Report includes a table that shows the 
following information for each CSQ:

Chart Name Description

Max Queue Time for 
Calls Presented by 
CSQ

For each CSQ, the call with the longest queue time.

Average Speed of 
Answer by CSQ

For each CSQ, the average speed of answer for calls handled.

Average Handle 
Time by CSQ

For each CSQ, the average handle time for calls handled.

Average Time to 
Abandon by CSQ

For each CSQ, average time calls spent in queue before being abandoned.

Average Time to 
Dequeue by CSQ

For each CSQ, average time calls spent in queue before being dequeued.

Field Description

CSQ Name (Call 
Skills)

Name of the CSQ, and call skills associated with the CSQ, if the CSQ is 
configured based on resource skills. Multiple skills are separated by commas.

Calls Presented Number of calls routed to the CSQ, whether or not an agent picked up the call.

Avg/Max Queue 
Time

Average queue time for all calls routed to the CSQ, and longest queue time of 
any one call that was routed to the CSQ.

Calls Handled Number of calls handled by this CSQ. A call is handled if a caller is connected 
to an agent while queued for this CSQ.
3-47
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 3      Descriptions of Historical Reports
Report Details
You can sort the Contact Service Queue Activity Report by any of these criteria:

Avg Speed of 
Answer

Calculated as follows:

(total queue time + total ring time) / calls handled

Avg /Max Handle 
Time

Average handle time for all calls that the CSQ handled, and longest handle time 
of any one call that the CSQ handled. Handle time is talk time + hold time + 
work time.

Calls Abandoned Number of calls routed to the CSQ but were not answered by an agent because 
the caller hung up or was disconnected.

Avg/Max Time to 
Abandon

Average time calls spent in queue before being abandoned, and longest time any 
one call spent in queue before being abandoned.

Avg/Max Abandon 
Per Day

Average is the total number of calls abandoned divided by the number of days 
in the report period. Maximum is the largest number of calls abandoned on a 
single day in the report period.

Calls Dequeued Number of calls queued for a CSQ and then dequeued by the Dequeue step in a 
workflow.

Avg/ Max Time to 
Dequeue

Average time calls spent in queue before being dequeued, and longest time any 
one call spent in queue before being dequeued.

Calls Handled by 
Other

Total of the following calls:

• Calls queued for the CSQ, then dequeued by the Dequeue step in a 
workflow, then marked as handled by the SetSessionInfo step in the 
workflow.

• Calls queued for more than 1 CSQ and then handled by another CSQ.

Field (continued) Description (continued)

Sort Criterion Result

Contact Service 
Queue

Displays the report in order of the name of the CSQ.

Total Calls 
Presented

Displays the report in order of the number of calls routed to the CSQ, whether 
or not an agent picked up the call.

Total Calls Handled Displays the report in order of the number of calls handled by the CSQ.

Total Calls 
Abandoned

Displays the report in order of the number of calls routed to the CSQ but were 
not answered because the caller hung up or was disconnected.
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You can filter the Contact Service Queue Activity Report by this parameter:

Contact Service Queue Activity Report (by CSQ)
The Contact Service Queue Activity Report (by CSQ) shows information about 
service levels, and about the number and percentage of calls presented, handled, 
abandoned, and dequeued. This report can show information for each 30-minute 
or 60-minute interval within the report period. In this case, the report will include 
a summary of information for each CSQ.

The information in the Contact Service Queue Activity Report (by CSQ) is 
grouped by CSQ. The Contact Service Queue Activity Report (by Interval) 
displays the same information grouped by interval. For more information, see the 
“Contact Service Queue Activity Report (by Interval)” section on page 3-53.

Filter Parameter Result

CSQ Names Displays information for the specified CSQs.

CSQ Types Includes these options:

• Resource Group—Displays information for CSQs that are configured with 
the Resource Pool Selection Model set to Resource Group in Unified EIM 
Administration.

• Skill Group—Displays information for CSQs that are configured with the 
Resource Pool Selection Model set to Resource Skills in Cisco CRS 
Administration.
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The Contact Service Queue Activity Report (by CSQ) can include these charts:

The Contact Service Queue Activity Report (by CSQ) includes a table that shows 
the following information for each CSQ:

Chart Name Description

Calls Handled, 
Abandoned, and 
Dequeued by CSQ

For each CSQ, displays the number of calls handled, abandoned, and dequeued. 
A call is considered to be handled when an agent picks up the call. A call is 
considered to be abandoned if the call disconnects before connecting to an 
agent. A call is considered to be dequeued from a particular CSQ in the 
following cases:

• The call is dequeued by a Dequeue step in a workflow.

• The call is marked as handled by a workflow.

• The call is queued for more than 1 CSQ and is handled by an agent in 
another CSQ.

Total Calls that Met 
Service Level by 
CSQ

For each CSQ, displays the total number of calls handled and the number of calls 
handled within the time entered in the Service Level field when the CSQ was set 
up in Cisco CRS Administration.

Field Description

CSQ Name
(Call Skills)

Name of the CSQ, and call skills associated with the CSQ, if the CSQ is 
configured based on resource skills. Multiple skills are separated by commas.

Interval Start Time,
Interval End Time

Beginning date and time and ending date and time of each 30- or 60-minute 
interval within the report period, if you specify an interval with the Interval 
Length filter parameter. Otherwise, the beginning date and time and ending date 
and time of the report range.

Service Level (sec) Value entered in the Service Level field when the CSQ was set up in Cisco CRS 
Administration. If the service level changed during the report period, the report 
shows the old and new service level values.

Calls Hand < SL Number of calls handled within the time shown in the Service Level field. A call 
is considered to be handled when an agent picks up the call.

Calls Aband < SL Number of calls abandoned within the time shown in the Service Level field. A 
call is considered to be abandoned if the call disconnects before connecting to 
an agent.
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Percentage of 
Service Level Met— 
Only Handled

Percentage of handled calls handled within the time shown in the Service Level 
field. A call is considered to be handled when an agent picks up the call. This 
value is calculated as follows:

(Number of calls handled within service level / Number of calls handled) * 
100%

Percentage of 
Service Level Met— 
Without Abandon

Percentage of presented calls, not counting abandoned calls, handled within the 
time shown in the Service Level field. This value is calculated as follows:

(Number of calls handled within service level / (Number of calls presented – 
Number of calls abandoned within service level) * 100%

Percentage of 
Service Level Met— 
Positive Abandon

Percentage of presented calls handled or abandoned within the time shown in the 
Service Level field. For this value, calls abandoned within the time shown in the 
Service Level field are considered to have met that service level. This value is 
calculated as follows:

((Number of calls handled within service level + Number of calls abandoned 
within service level) / Number of calls presented) * 100%

Percentage of 
Service Level Met— 
Negative Abandon

Percentage of presented calls handled within the time shown in the Service 
Level field. For this value, calls abandoned within the time shown in the Service 
Level field are considered to have not met that service level. This value is 
calculated as follows:

(Number of calls handled within service level / Number of calls presented) * 
100%

Calls Presented Number of calls routed to the CSQ, whether or not an agent picked up the call.

Calls Handled Number and percentage of calls handled by the CSQ. A call is considered to be 
handled when an agent picks up the call. The percentage is calculated as follows:

(number of calls handled) / (number of calls presented) * 100%

Field (continued) Description (continued)
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Report Details
You can sort the Contact Service Queue Activity Report (by CSQ) by this 
criterion:

Calls Abandoned Number and percentage of calls routed to the CSQ but were not answered by an 
agent because the caller hung up or was disconnected. The percentage is 
calculated as follows:

(Number of calls abandoned / Number of calls presented) * 100%

Calls Dequeued Number and percentage of calls dequeued. A call is considered to be dequeued 
from a particular CSQ in the following cases:

• The call is dequeued by a Dequeue step in a workflow.

• The call is marked as handled by a workflow.

• The call is queued for more than 1 CSQ and is handled by an agent in 
another CSQ.

The percentage is calculated as follows:

(Number of calls dequeued / Number of calls presented) * 100%

Field (continued) Description (continued)

Sort Criterion Result

CSQ Name Displays the report in alphabetical order by the names of CSQs.
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Report Details
You can filter the Contact Service Queue Activity Report (by CSQ) by any of 
these parameters:

Contact Service Queue Activity Report (by Interval)
The Contact Service Queue Activity Report (by Interval) shows information about 
service levels, and about the number and percentage of calls presented, handled, 
abandoned, and dequeued. This report can show information for each 30-minute 
or 60-minute interval within the report period. In this case, the report will include 
a summary of information for each interval.

The information in the Contact Service Queue Activity Report (by Interval) is 
grouped by interval. The Contact Service Queue Activity Report (by CSQ) 
displays the same information grouped by CSQ. For more information, see the 
“Contact Service Queue Activity Report (by CSQ)” section on page 3-49.

Filter Parameter Result

Interval Length Entire report range—Displays information from the report start time through 
the report end time, but does not display information for specific intervals within 
the report period.

Thirty (30) minute intervals—Displays information for 30-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 30 minutes after the report start time, and so on.

Sixty (60) minute intervals—Displays information for 60-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 60 minutes after the report start time, and so on.

CSQ Names Displays information for the CSQs selected.
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The Contact Service Queue Activity Report (by Interval) can include these charts:

The Contact Service Queue Activity Report (by Interval) includes a table that 
shows the following information for each CSQ:

Chart Name Description

Calls Handled, 
Abandoned, and 
Dequeued by 
Interval

For each time interval, displays the number of calls handled, abandoned, and 
dequeued. A call is considered to be handled when an agent picks up the call. A 
call is considered to be abandoned if the call disconnects before connecting to 
an agent. A call is considered to be dequeued from a particular CSQ in the 
following cases:

• The call is dequeued by a Dequeue step in a workflow.

• The call is marked as handled by a workflow.

• The call is queued for more than 1 CSQ and is handled by an agent in 
another CSQ.

Total Calls that Met 
Service Level by 
Interval

For each time interval, displays the total number of calls handled and the number 
of calls handled within the time entered in the Service Level field when the CSQ 
was set up in Cisco CRS Administration.

Field Description

Interval Start Time,
Interval End Time

Beginning date and time and ending date and time of each 30- or 60-minute 
interval within the report period, if you specify an interval with the Interval 
Length filter parameter. Otherwise, the beginning date and time and ending date 
and time of the report range.

CSQ Name
(Call Skills)

Name of the CSQ, and call skills associated with the CSQ, if the CSQ is 
configured based on resource skills. Multiple skills are separated by commas.

Service Level (sec) Value entered in the Service Level field when the CSQ was set up in Cisco CRS 
Administration. If the service level changed during the report period, the report 
shows the old and new service level values.

Calls Hand < SL Number of calls handled within the time shown in the Service Level field. A call 
is considered to be handled when an agent picks up the call.

Calls Aband < SL Number of calls abandoned within the time shown in the Service Level field. A 
call is considered to be abandoned if the call disconnects before connecting to 
an agent.
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Percentage of 
Service Level Met— 
Only Handled

Percentage of handled calls handled within the time shown in the Service Level 
field. A call is considered to be handled when an agent picks up the call. This 
value is calculated as follows:

(Number of calls handled within service level / Number of calls handled) * 
100%

Percentage of 
Service Level Met— 
Without Abandon

Percentage of presented calls, not counting abandoned calls, handled within the 
time shown in the Service Level field. This value is calculated as follows:

(Number of calls handled within service level / (Number of calls presented – 
Number of calls abandoned within service level) * 100%

Percentage of 
Service Level Met— 
Positive Abandon

Percentage of presented calls handled or abandoned within the time shown in the 
Service Level field. For this value, calls abandoned within the time shown in the 
Service Level field are considered to have met that service level. This value is 
calculated as follows:

((Number of calls handled within service level + Number of calls abandoned 
within service level) / Number of calls presented) * 100%

Percentage of 
Service Level Met— 
Negative Abandon

Percentage of presented calls handled within the time shown in the Service 
Level field. For this value, calls abandoned within the time shown in the Service 
Level field are considered to have not met that service level. This value is 
calculated as follows:

(Number of calls handled within service level / Number of calls presented) * 
100%

Calls Presented Number of calls routed to the CSQ, whether or not an agent picked up the call.

Calls Handled Number and percentage of calls handled by the CSQ. A call is considered to be 
handled when an agent picks up the call. The percentage is calculated as follows:

(number of calls handled) / (number of calls presented) * 100%

Field (continued) Description (continued)
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Report Details
You can sort the Contact Service Queue Activity Report (by Interval) by this 
criterion:

Calls Abandoned Number and percentage of calls routed to the CSQ but were not answered by an 
agent because the caller hung up or was disconnected. The percentage is 
calculated as follows:

(Number of calls abandoned / Number of calls presented) * 100%

Calls Dequeued Number and percentage of calls dequeued. A call is considered to be dequeued 
from a particular CSQ the following cases:

• The call is dequeued by a Dequeue step in a workflow.

• The call is marked as handled by a workflow.

• The call is queued for more than 1 CSQ and is handled by an agent in 
another CSQ.

The percentage is calculated as follows:

(Number of calls dequeued / Number of calls presented) * 100%

Field (continued) Description (continued)

Sort Criterion Result

Interval Start Time Displays the report in order of the start times of the 30- or 60-minute intervals, 
if you specify an interval with the Interval Length filter parameter.
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You can filter the Contact Service Queue Activity Report (by Interval) by any of 
these parameters:

Contact Service Queue Call Distribution Summary Report
The Contact Service Queue Call Distribution Summary Report shows the number 
and percentage of calls handled and dequeued in four different time intervals. The 
time interval lengths can be configured by users.

The Contact Service Queue Call Distribution Summary Report can include these 
charts:

Filter Parameter Result

Interval Length Entire report range—Displays information from the report start time through 
the report end time, but does not display information for specific intervals within 
the report period.

Thirty (30) minute intervals—Displays information for 30-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 30 minutes after the report start time, and so on.

Sixty (60) minute intervals—Displays information for 60-minute intervals 
within the report period. The first interval begins at the report start time, the next 
interval begins 60 minutes after the report start time, and so on.

CSQ Names Displays information for the CSQs selected.

Chart Name Description

Total Calls Handled 
by Time Interval and 
CSQ

For each CSQ, displays the total number of calls handled in each time interval.

Total Calls 
Abandoned by Time 
Interval and CSQ

For each CSQ, displays the total number of calls abandoned in each time 
interval.
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The Contact Service Queue Call Distribution Summary Report includes a table 
that shows the following information for each CSQ:

Field Description

CSQ Name (Call 
Skills)

Name of the CSQ, and the call skills associated with the CSQ, if the CSQ is 
configured based on resource skills. Multiple skills are separated by commas. 

Calls Handled Number of calls handled by the CSQ. A call is considered to be handled when 
an agent picks up the call.

Total / Percentage 
Calls Handled With 
Queue Time 0–T sec

Time interval showing the number and percentage of handled calls with a queue 
time that is less than or equal to T seconds. You can specify the value for T in 
the Filter Parameter field in the Report Detail area. The default value for T is 15 
seconds, and in this case, this field shows as 0–15 seconds.

Total / Percentage 
Calls Handled With 
Queue Time 0–2T 
sec

Time interval showing the number and percentage of handled calls with a queue 
time that is less than or equal to 2T seconds. You can specify the value for T in 
the Filter Parameter field in the Report Detail area. The default value for T is 15 
seconds, and in this case, this field shows as 0 – 30 seconds.

Total / Percentage 
Calls Handled With 
Queue Time 0–3T 
sec

Time interval showing the number and percentage of handled calls with a queue 
time that is less than or equal to 3T seconds. You can specify the value for T in 
the Filter Parameter field in the Report Detail area. The default value for T is 15 
seconds, and in this case, this field shows as 0 – 45 seconds.

Total / Percentage 
Calls Handled With 
Queue Time 0–4T 
sec

Time interval showing the number and percentage of handled calls with a queue 
time that is less than or equal to 4T seconds. You can specify the value for T in 
the Filter Parameter field in the Report Detail area. The default value for T is 15 
seconds, and in this case, this field shows as 0 – 60 seconds.

Calls Abandoned Number of calls abandoned from the CSQ. A call is considered to be abandoned 
if it was routed to the CSQ but was not answered by an agent because the caller 
hung up or was disconnected.

Total / Percentage 
Calls Abandoned 
With Queue Time 
0–T

Time interval showing the number and percentage of abandoned calls with a 
queue time that is less than or equal to T seconds. You can specify the value for 
T in the Filter Parameter field in the Report Detail area. The default value for T 
is 15 seconds, and in this case, this field shows as 0–15 seconds.

Total / Percentage 
Calls Abandoned 
With Queue Time 
0–2T sec

Time interval showing the number and percentage of abandoned calls with a 
queue time that is less than or equal to 2T seconds. You can specify the value for 
T in the Filter Parameter field in the Report Detail area. The default value for T 
is 15 seconds, and in this case, this field shows as 0 – 30 seconds.
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You can sort the Contact Service Queue Call Distribution Summary Report by this 
criterion:

You can filter the Contact Service Queue Call Distribution Summary Report by 
either of these parameters:

Total / Percentage 
Calls Abandoned 
With Queue Time 
0–3T sec

Time interval showing the number and percentage of abandoned calls with a 
queue time that is less than or equal to 3T seconds. You can specify the value for 
T in the Filter Parameter field in the Report Detail area. The default value for T 
is 15 seconds, and in this case, this field shows as 0 – 45 seconds.

Total / Percentage 
Calls Abandoned 
With Queue Time 
0–4T sec

Time interval showing the number and percentage of abandoned calls with a 
queue time that is less than or equal to 4T seconds. You can specify the value for 
T in the Filter Parameter field in the Report Detail area. The default value for T 
is 15 seconds, and in this case, this field shows as 0 – 60 seconds.

Field (continued) Description (continued)

Sort Criterion Result

Contact Service 
Queue

Displays the report in order of the names of CSQs.

Filter Parameter Result

Contact Service 
Queue Names

Displays information for the specified CSQs.

Time Interval (sec) T Lets you specify the number of seconds, T, that the report uses for the 4 time 
interval fields. The default value for T is 15 (seconds).
3-59
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 3      Descriptions of Historical Reports
Report Details
Contact Service Queue Priority Summary Report
The Contact Service Queue Priority Summary Report shows the total number of 
calls presented to each CSQ selected. It also shows the total number of calls by 
priority and the average number of calls per day, by priority, that were presented 
to each CSQ.

The Contact Service Queue Priority Summary Report can include this chart:

The Contact Service Queue Priority Summary Report includes a table that shows 
the following information for each CSQ:

You can sort the Contact Service Queue Priority Summary Report by this 
criterion:

Chart Name Description

Total Calls 
Presented by CSQ 
and Call Priority

For each CSQ, displays the number of calls of each call priority presented to the 
CSQ.

Field Description

CSQ Name (Call 
Skills)

Name of the CSQ, and the call skills associated with the CSQ, if the CSQ is 
configured based on resource skills. Multiple skills are separated by commas. 

Total Calls 
Presented

Total number of calls presented to the CSQ, whether or not an agent picked up 
the call. 

Total and Average 
Number of Calls by 
Priority (Priority 1 
through Priority 10) 

Total number of calls, by priority, presented to each CSQ, and the average 
number of calls per day, by priority, presented to each CSQ.

Call priorities range from 1 (lowest) to 10 (highest). All calls start with a default 
priority of 1, unless a different priority is set in the workflow.

Sort Criterion Result

Contact Service 
Queue Name

Displays the report in order of the name of the CSQs.
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You can filter the Contact Service Queue Priority Summary Report by this 
parameter:

Contact Service Queue Service Level Priority Summary Report
The Contact Service Queue Service Level Priority Summary Report contains 
information about the total number and percentage of calls that are handled within 
service level, and the number and percentage of calls that are handled within 
service level for each call priority. Call priorities range from 1 (lowest) to 10 
(highest).

The Contact Service Queue Service Level Priority Summary Report can include 
these charts:

The Contact Service Queue Service Level Priority Summary Report includes a 
table that shows the following information:

Filter Parameter Result

Contact Service 
Queue Name

Displays information for the specified CSQs. 

Chart Name Description

Total Calls that Met 
Service Level

For each CSQ, displays the total number of calls that are handled within service 
level.

Percentage of Calls 
that Met Service 
Level

For each CSQ, displays the percentage of calls that are handled within service 
level.

Field Description

CSQ Name (Call 
Skills)

Name of the CSQ, and the call skills associated with the CSQ, if the CSQ is 
configured based on resource skills. Multiple skills are separated by commas.

Service Level (sec) Value entered in the Service Level field when the CSQ was set up in Cisco CRS 
Administration. If the service level changed during the report period, the report 
shows the old and new service level values.
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You can sort the Contact Service Queue Service Level Priority Summary Report 
by this criterion:

You can filter the Contact Service Queue Service Level Priority Summary Report 
by this parameter:

Calls Presented Number of calls routed to the CSQ, whether or not an agent picked up the call. 

Total Service Level 
Met

Number and percentage of handled calls answered within the time shown in the 
Service Level field in Cisco CRS Administration. The percentage is calculated 
as follows:

(calls handled within service level / calls presented) *100%

Number and 
Percentage of Calls 
that Met Service 
Level for Each Call 
Priority (Priority 1 
through Priority 10) 

Number and percentage of handled calls in each call priority answered within 
the time shown in the Service Level field in Cisco CRS Administration. 

Call priorities range from 1 (lowest) to 10 (highest). All calls start with a default 
priority of 1, unless a different priority is set in the workflow.

Field (continued) Description (continued)

Sort Criterion Result

Contact Service 
Queue Name

Displays the report in order of the name of the contact service queues.

Filter Parameter Result

Contact Service 
Queue Name

Displays information for the specified CSQs.
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CSQ–Agent Summary Report
An agent can handle calls for multiple CSQs. The CSQ–Agent Summary Report 
shows, for each agent, information about calls handled in each CSQ. For each 
agent, the report includes the average and total talk time for handled calls, average 
and total work time after calls, total ring time of calls presented, number of calls 
put on hold, average and total hold time for calls put on hold, and number of 
unanswered calls.

The CSQ–Agent Summary Report can include this chart:

The CSQ–Agent Summary Report includes a table that shows the following 
information:

Chart Name Description

Calls Handled by 
CSQ and Agent

For each CSQ, displays the number of calls handled by each agent.

Field Description

CSQ Name Name of the CSQ.

Agent Name First name and last name of the agent who handled calls for this CSQ during the 
report period.

Extension Unified CCX extension that Unified CM assigned to the agent. 

Calls Handled Number of calls that were queued for this CSQ and answered by this agent 
during the report period.

Talk Time Avg Average talk time for all calls that this agent handled for this CSQ. Talk time is 
the elapsed time between the time that an agent answers a call and when the call 
is disconnected or transferred, not including hold time. The average is calculated 
as total talk time divided by the number of calls handled.

Talk Time Total Total talk time for all calls that this agent handled for this CSQ. Talk time is the 
elapsed time between the time that an agent answers a call and when the call is 
disconnected or transferred, not including hold time. 

Work Time Avg Average amount of time that an agent spent in Work state after calls. The average 
is calculated as total work time divided by the number of calls handled.

Work Time Total Total amount of time that an agent spent in Work state after calls. 
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You can sort the CSQ–Agent Summary Report by either of these criteria:

You can filter the CSQ–Agent Summary Report by this parameter:

Total Ring Time Time that elapsed between the time that a call rang at the Cisco Agent Desktop 
and the time that the call was answered by an agent, presented to another agent 
(if the first agent did not answer the call or let it go ring-no-answer), or 
disconnected. This field is blank if the call was not presented to any agent. 

Calls On Hold Number of calls that the agent puts on hold.

Hold Time Avg Average hold time for all calls that the agent put on hold. The average is 
calculated as total hold time divided by number of calls on hold. Not applicable 
to non-Unified CCX calls.

Hold Time Total Total time that the call was on hold. Not applicable to non-Unified CCX calls.

RNA Ring-no-answer—number of calls that were connected to the agent but that the 
agent does not answer.

Field (continued) Description (continued)

Sort Criterion Result

CSQ Name Displays the report in alphabetical order of the name of CSQs.

Agent Name Displays the report in alphabetical order by the names of agents.

Filter Parameter Result

CSQ Names Displays information for the specified CSQs. 
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Detailed Call by Call CCDR Report
The Detailed Call by Call CCDR Report shows most of the information that is 
contained in the contact call detail record (CCDR), which is stored in the Cisco 
CRS database. This report also includes information from the contact routing 
detail record and the agent connection detail record. The information in this report 
is for each leg of a call. (A call transfer or redirect initiates a new leg.)

The Detailed Call by Call CCDR Report can include these charts:

The Detailed Call by Call CCDR Report includes a table that shows the following 
information:

Chart Name Description

Number of Calls by 
Contact Disposition

Displays the percentage of calls that were handled, abandoned, aborted, and 
rejected, and percentage of calls that were abandoned, aborted, and rejected.

Number of Calls by 
Originator Type

Displays the percentage of calls that were originated by an agent, percentage of 
calls that were originated by a device (for example, a test call), and percentage 
of calls with an unknown origin (for example, calls received through a gateway).

Field Description

Node ID – Session 
ID – Sequence No.

Node ID is the unique numeric ID that the system assigned to each CRS server 
in the cluster. It starts with number 1. (A Node ID value of 0 indicates that the 
data in the report is migrated from Cisco CRS 3.x.) Session ID is the unique 
session identification number that the system assigned to a call. Sequence No. 
is the session sequence number that the system assigned to each call leg. The 
session sequence number increases by 1 for each leg of a call.

Start Time,
End Time

Date and time that a call started, and date and time that the call was disconnected 
or transferred.
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Contact T Type of call:

1—Incoming. Outside call received by the Unified CCX Edition system.

2—Outgoing. Call originated by the Cisco CRS system, other than a call made 
within the system. 

3—Internal. Call transferred or conferenced between agents, or a call made 
within the system.

4—Redirect. A previous leg redirected the call to this leg.

5—Transfer-in. A previous leg transferred the call to this leg.

Contact D Disposition of a call (abandoned, handled, aborted, or rejected).

For an Unified CCX call, a call is abandoned if the call disconnects before 
connecting to an agent. The call is handled when the call is connected to an 
agent.

For an Unified IP IVR call, a call is abandoned if it does not reach the workflow 
step that defines the call as handled. The call is handled when it reaches this 
step.

A call is aborted when problems occur in executing the workflow script (for 
example, the workflow script throws exceptions).

A call is rejected when certain Unified CM or Cisco CRS resources are not 
sufficient for accepting incoming calls (for example, an insufficient number of 
CTI ports).

Originator T Originator of the call:

1—Agent. Call originated by an agent.

2—Device. Call originated by a simulated caller. (Used for testing.)

3—Unknown. Call originated by an outside caller through a gateway or by an 
unmonitored device.

Originator ID Login identification of the agent who originated the call. Used only if Originator 
Type is 1.

Originator DN1 If Originator Type is 1, this field shows the Unified CCX extension of the agent. 
If Originator Type is 2, this field shows the CTI2 port number. If Originator Type 
is 3, this field shows the telephone number of the caller.

Field (continued) Description (continued)
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Destination T Destination of the call:

1—Agent. Call presented to an agent.

2—Device. Call presented to a route point.

3—Unknown. Call presented to an outside destination through a gateway or to 
an unmonitored device.

Destination ID Login identification of the agent who received the call. Used only if Destination 
Type is 1.

Destination DN If Destination Type is 1, this field shows the Unified CCX extension of the 
agent. If Destination Type is 2, this field shows the CTI port number. If 
Destination Type is 3, this field shows the telephone number called.

Called Number If the call was a transfer, the number that the call was transferred to. In other 
cases, this information is the same as the Original Called Number.

Original Called No. Number originally dialed by the caller. Can be either a route point number or an 
agent extension.

Application Name Name of the Unified CCX or Unified IP IVR application associated with the 
route point.

Queue Time For calls that were queued for the CSQ, time that elapsed between the time a call 
entered the CSQ and the time the call was answered by an agent or disconnected. 
0 for other calls.

Talk Time For calls that were connected to agents, elapsed time between the time that an 
agent answered the call and when the call was disconnected or transferred, not 
including hold time. 0 for other calls.

Hold Time For calls that were connected to agents, elapsed time between the time that an 
agent first put the call on hold and when the agent last took the call off of hold, 
not including talk time. Blank for other calls.

Work Time For calls that were connected to agents, amount of time that an agent spent in 
Work state after the call. Blank for other calls.

1. DN = directory number

2. CTI = computer telephony interface

Field (continued) Description (continued)
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You can sort the Detailed Call by Call CCDR Report by any of these criteria:

You can filter the Detailed Call by Call CCDR Report by any of these parameters:

Sort Criterion Result

Node ID – Session 
ID – Sequence No.

Displays the report in the order sorted by node ID, session ID, and sequence 
number.

Call Start Time Displays the report in order of the date and time that the call started.

Called Number Displays the report in order of the number called.

Filter Parameter Result

Original Called 
Number

Displays information for the specified original called number or numbers. 

Called Number Displays information for the specified called number or numbers. 

Calling Number Displays information for the specified calling number or numbers. Calling 
number is the same as Originator DN.

Application Name Displays information for the specified application or applications. 

Contact Type Displays information for the specified contact type or types (incoming, 
outgoing, internal, redirect, or transfer-in).

Originator Type Displays information for the specified originator type or types (agent, device, or 
unknown).

Destination Type Displays information for the specified destination type or types (agent, device, 
or unknown).

Duration Greater 
Than or Equal to T 
seconds

Displays calls with duration greater than or equal to the number of seconds 
specified by T. 

Duration Less Than 
or Equal to T 
seconds

Displays calls with duration less than or equal to the number of seconds 
specified by T.
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Detailed Call, CSQ, Agent Report
The Detailed Call, CSQ, Agent Report shows detailed call information about the 
CSQ that a call was routed to and the agent that handled the call.

The Detailed Call, CSQ, Agent Report can include this chart:

The Detailed Call, CSQ, Agent Report includes a table that shows the following 
information:

Chart Name Description

Total Calls by 
Called Number

Displays the total number of calls to each called number.

Field Description

Node ID – Session 
ID – Sequence No.

Node ID is the unique numeric ID that the system assigned to each CRS server 
in the cluster. It starts with number 1. (A Node ID value of 0 indicates that the 
data in the report is migrated from Cisco CRS 3.x.) Session ID is the unique 
session identification number that the system assigned to a call. Sequence No. 
is the session sequence number that the system assigned to each call leg. The 
session sequence number increases by one for each leg of a call.

Call Start Time
Call End Time

Date and time that the call started, and date and time that the call was 
disconnected or transferred.

Contact Disp Numeral indicating the disposition of a call as follows:

1—Abandoned. An IVR call is abandoned if it does not reach the workflow step 
that defines the call as handled. 

2—Handled. An Unified CCX call is handled when it is connected to an agent. 
An Unified IP IVR call is handled if it reaches the workflow step that defines 
the call as handled.

4—Aborted. An exception occurs in the workflow that processed the call.

5 and higher—Rejected. System resources reached maximum capacity (for 
example, the maximum number of CTI ports was reached).
3-69
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 3      Descriptions of Historical Reports
Report Details
Originator DN 
(Calling Number)

Originator directory number. This number is the same as the calling number. If 
originator type is agent, this field shows the Unified CCX extension of the agent. 
If originator type is device, this field shows the CTI port number. If originator 
type is unknown (through a gateway or an unmonitored device), this field shows 
the telephone number of the caller.

Destination DN Destination directory number. If destination type is agent, this field shows the 
Unified CCX extension of the agent. If destination type is device, this field 
shows the CTI port number. If destination type is unknown (through a gateway 
or an unmonitored device), this field shows the telephone number called.

Called Number If the call was transferred, this field shows the number that the call was 
transferred to. Otherwise, this field shows the number originally dialed by the 
caller. This number can be either a route point number or an agent extension.

(App. Name) Name of the Unified CCX or Unified IP IVR application associated with the 
route point.

CSQ Names Name or names of the CSQ or queues for which the call was queued. This field 
displays a maximum of five CSQs separated by commas. The CSQ that handled 
the call is marked with an asterisk (*). This field is blank if the call did not queue 
for any CSQ.

Queue Time Time that elapsed between the time a call entered the CSQ and the time the call 
was answered by any agent belonging to the CSQ.

Agent Name Name of the agent who handled the call, name of the agent who participated in 
the conference call, or name of the supervisor who barged the call. This field is 
blank if the call was not presented to any agent.

Ring Time Time that elapsed between the time that a call rang at the Cisco Agent Desktop 
and the time that the call was answered by an agent, presented to another agent 
(if the first agent did not answer the call or let it go ring-no-answer), or 
disconnected. This field is blank if the call was not presented to any agent. 

Talk Time Time that elapsed between the time that an agent answered the call and when the 
call was disconnected or transferred, not including hold time.

Work Time Amount of time that an agent spent in Work state after the call. This field is 
blank if the call was not handled by any agent.

Field (continued) Description (continued)
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You can sort the Detailed Call, CSQ, Agent Report by any of these criteria:

You can filter the Detailed Call, CSQ, Agent Report by any of these parameters:

Sort Criterion Result

Node ID – Session 
ID – Sequence No.

Displays the report in the order sorted by node ID, session ID, and sequence 
number.

Call Start Time Displays the report in order of the date and time that the call started.

Called Number Displays the report in order of the number called.

Filter Parameter Result

Called Number Displays information for the specified called number or numbers.

Calling Number Displays information for the specified calling number or numbers. Calling 
number is the same as Originator DN.

Application Name Displays information for the specified application name or names.

Contact Type Displays information for the specified contact type or types: incoming, 
outgoing, internal, redirect, or transfer-in.

Originator Type Displays information for the specified originator type or types: agent, device, or 
unknown.

Destination Type Displays information for the specified destination type or types: agent, device, 
or unknown.

Agent Name Displays Unified CCX calls handled by the specified agent or agents, conference 
calls in which the specified agent or agents participated, and calls barged by the 
specified supervisor(s).

CSQ Name Displays calls that queued for any of the specified CSQs.

Duration Greater 
Than or Equal to T 
seconds

Displays calls with duration greater than or equal to the number of seconds 
specified by T.

Duration Less Than 
or Equal to T 
seconds

Displays calls with duration less than or equal to the number of seconds 
specified by T.
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Multichannel Agent Contact Summary Report 
The Multichannel Agent Contact Summary Report is specific to the Unified EIM 
and the Unified WIM. It shows summary information about each call, e-mail, and 
chat that was received/made (inbound/outbound) by the agent for each agent 
specified.

Note Multichannel reports are specific to Unified EIM/Unified WIM and use the MS 
SQL 2000 database (installed in a mixed mode authentication). To generate 
combined historical reports, Cisco CRS requires access details for the Unified 
EIM/Unified WIM database (host name or IP address of the server, database 
name, database user, and database password). See the Cisco CRS Administration 
Guide for detailed configuration information.

For inbound Unified CCX calls, this report shows the average time that the agent 
spent in the Talk state, the Work state, and on hold. For non-Unified CCX calls, 
this report shows the average and maximum talk time for the agent. 

For outbound responses, this report shows the average and maximum call time for 
the agent. This report also shows the number of calls transferred to the agent and 
transferred out (to another route point or another agent) by the agent, and the 
number of conference calls in which the agent participated.

The Multichannel Agent Contact Summary Report can include these charts:

Chart Name Description

Total Inbound, 
Outbound Calls by 
Agent

Total number of calls received and calls made by agents.

Average Talk, Hold, 
Work Time for 
Inbound ACD

For Unified CCX calls received by agents, average time each agent spent in Talk 
state, on hold, and in Work state.

Average, Maximum 
Call Time for 
Outbound Calls

For calls made by agents, average and maximum time each agent spent on the 
call. (The time on a call includes time spent dialing, waiting for an answer, and 
talking).)
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The Multichannel Agent Contact Summary Report includes a table that shows the 
following information:

You can sort the Multichannel Agent Contact Summary Report by this criterion:

Field Description

Agent Name First and last name of the agent.

Extension Unified CCX extension that the Unified CM assigned to the agent.

Total Inbound Total number of calls received by the agent. (Equal to inbound ACD calls + 
inbound non-ACD calls.)

Inbound ACD— 
Total

Total number of Unified CCX calls received by the agent.

Inbound ACD—Avg 
Talk / Hold / Work

For Unified CCX calls received, the average time that the agent spent in Talk 
state, on hold, and in Work state.

Inbound 
Non-ACD—Total

Total number of non-Unified CCX calls received by the agent. This number 
includes calls made by other agents and by outside parties.

Inbound 
Non-ACD— Avg / 
Max Talk Time

For non-Unified CCX calls received, the average time that the agent spent 
talking, and the longest time that the agent spent talking for any 1 call. 

Outbound—Total Total number of calls made by the agent. This number includes calls attempted 
and calls connected.

Outbound—Avg / 
Max Call Time

For outbound calls, the average call time and the longest call time. Call time 
starts when an agent goes off-hook for a call and ends when the call terminates.

Email—Total Total number of e-mails sent by the agent. 

Email—Time For e-mails, the total e-mail time. 

Chat—Total Total number of chats by the agent. 

Chat—Time For chats, the total chat time. 

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents.
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You can filter the Multichannel Agent Contact Summary Report by these 
parameters:

Multichannel Agent Login Logout Activity Report
The Multichannel Agent Login Logout Activity Report is specific to the Unified 
EIM and the Unified WIM. It shows information about the login and logout 
activities of agents. For each agent, it shows the login date/time, the logout 
date/time for each session during the specified period, the reason code that an 
agent entered when logging out, the duration of each session, and the total time 
for all sessions. 

Note Multichannel reports are specific to Unified EIM/Unified WIM and use the MS 
SQL 2000 database (installed in a mixed mode authentication). To generate 
combined historical reports, Cisco CRS requires access details for the Unified 
EIM/Unified WIM database (host name or IP address of the server, database 
name, database user, and database password). See the Cisco CRS Administration 
Guide for detailed configuration information.

Total Inbound Calls Displays the report in order of the total number of calls received by agents.

Total Outbound 
Calls

Displays the report in order of the total number of calls made by agents.

Sort Criterion Result (continued)

Filter Parameter Result

Resource Group 
Names

Displays information for agents that belong to the specified resource groups. 

Agent Names Displays information for the specified agents. 

Skill Names Displays information for agents who possess the specified skills. 

Team Names Displays information for agents who belong to the selected teams.
3-74
Cisco CRS Historical Reports User Guide, Release 5.0(1)



 

Chapter 3      Descriptions of Historical Reports
Report Details
The Multichannel Agent Login Logout Activity Report can include these charts:

The Multichannel Agent Login Logout Activity Report includes a table that 
shows the following information:

You can sort the Multichannel Agent Login Logout Activity Report by this 
criterion:

Chart Name Description

Total Logged-In 
Time for Each Agent

For each agent, displays the total time logged in to the Unified CCX system.

Field Description

Agent Name First and last name of the agent.

Contact Identifies if this is a call, e-mail, or chat contact.

Extension Unified CCX extension that Unified CM assigned to the agent. 

Login Time Date and time that the agent logged in to the Unified CCX system. If this 
information is preceded by a less-than sign (<), the agent logged in before the 
start time of the data in the report.

Logout Time Date and time that the agent logged out of the Unified CCX system. If this 
information is preceded by a greater-than sign (>), the agent was still logged in 
at the end time of the data in the report.

Logout Reason 
Code

Numeric reason code that the agent enters when the agent logs out from the 
Cisco Agent Desktop. A value of 0 indicates that no logout reason code is 
configured or that the agent was unable to enter a reason code.

Logged-In Duration Elapsed time between the Login Time and the Logout Time.

Sort Criterion Result

Agent Name Displays the report in alphabetical order by the names of agents.

Login Time Displays the report in order of the time that agents logged in to the system.

Logged-in Duration Displays the report in order of the length of time that agents were logged in to 
the system.
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You can filter the Multichannel Agent Login Logout Activity Report by these 
parameters:

Multichannel CSQ Activity Report 
The Multichannel CSQ Activity Report is specific to the Cisco Unified E-Mail 
Interaction Manager (Unified EIM) and the Cisco Unified Web Interaction 
Manager (Unified WIM). It shows a summary of calls, e-mails, and chats 
presented to, handled by, abandoned from, and dequeued from each CSQ. It also 
shows calls handled by workflows in other CSQs, and average and maximum time 
information for calls handled, calls handled, calls abandoned, and calls dequeued. 

Note Multichannel reports are specific to Unified EIM/Unified WIM and use the MS 
SQL 2000 database (installed in a mixed mode authentication). To generate 
combined historical reports, Cisco CRS requires access details for the Unified 
EIM/Unified WIM database (host name or IP address of the server, database 
name, database user, and database password). See the Cisco CRS Administration 
Guide for detailed configuration information.

Filter Parameter Result

Resource Group 
Names

Displays information for agents that belong to the specified resource group or 
groups.

Agent Names Displays information for the specified agents.

Skill Names Displays information for agents that possess the specified skills.

Team Names Displays information for agents who belong to the specified teams.
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The Multichannel CSQ Activity Report can include these charts:

The Multichannel CSQ Activity Report includes a table that shows the following 
information:

Chart Name Description

Max Queue Time for 
Contacts Presented 
by CSQ

For each CSQ, the contacts with the longest queue time.

Max Queue Time for 
Emails Presented by 
CSQ

For each CSQ, the e-mail with the longest queue time.

Max Queue Time for 
Chats Presented by 
CSQ

For each CSQ, the chats with the longest queue time.

Average Speed of 
Answer by CSQ

For each CSQ, the average speed of answer for contacts handled.

Average Handle 
Time by CSQ

For each CSQ, the average handle time for contacts handled.

Average Time to 
Abandon by CSQ

For each CSQ, average time contacts spent in queue before being abandoned.

Average Time to 
Dequeue by CSQ

For each CSQ, average time contacts spent in queue before being dequeued.

Field Description

CSQ Name (Contact 
Skills)

Name of the CSQ, and contact skills associated with the CSQ, if the CSQ is 
configured based on resource skills. Multiple skills are separated by commas.

Contacts Presented Number of contacts routed to the CSQ, whether or not an agent picked up the 
contact.

Avg/Max Queue 
Time

Average queue time for all contacts routed to the CSQ, and longest queue time 
of any 1 contact that was routed to the CSQ.

Contacts Handled Number of contacts handled by this CSQ. A contact is handled if a caller is 
connected to an agent while queued for this CSQ.
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You can sort the Multichannel CSQ Activity Report by this criterion:

Avg Speed of 
Answer

Calculated as follows:

(total queue time + total ring time) / contacts handled

Avg /Max Handle 
Time

Average handle time for all Contacts that the CSQ handled, and longest handle 
time of any 1 contact that the CSQ handled. Handle time is talk time + hold time 
+ work time.

Contacts 
Abandoned

Number of contacts routed to the CSQ but were not answered by an agent 
because the caller hung up or was disconnected.

Avg/Max Time to 
Abandon

Average time contacts spent in queue before being abandoned, and longest time 
any 1 contact spent in queue before being abandoned.

Avg/Max Abandon 
Per Day

Average is the total number of contacts abandoned divided by the number of 
days in the report period. Maximum is the largest number of contacts abandoned 
on a single day in the report period.

Contacts Dequeued Number of Contacts queued for a CSQ and then dequeued by the Dequeue step 
in a workflow.

Avg/ Max Time to 
Dequeue

Average time contacts spent in queue before being dequeued, and longest time 
any 1 contact spent in queue before being dequeued.

Contacts Handled by 
Other

Total of the following Contacts:

• Contacts queued for the CSQ, then dequeued by the Dequeue step in a 
workflow, then marked as handled by the SetSessionInfo step in the 
workflow.

• Contacts queued for more than 1 CSQ and then handled by another CSQ.

Field (continued) Description (continued)

Sort Criterion Result

Contact Service 
Queue

Displays the report in order of the name of the CSQ.

Total Calls 
Presented

Displays the report in order of the number of contacts routed to the CSQ, 
whether or not an agent picked up the contact.
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You can filter the Multichannel CSQ Activity Report by these parameters:

Outbound Agent Detail Performance Report
The Outbound Agent Detail Performance Report shows detailed statistics for each 
agent by campaign. The report also contains the total call details and campaign 
call details are displayed for each agent besides a summary row of the call details 
for each agent for all campaigns combined. This report is available with the 
Outbound feature.

The Outbound Agent Detail Performance Report can include these charts:

Total Contacts 
Handled

Displays the report in order of the number of contacts handled by the contact 
service queue.

Total Contacts 
Abandoned

Displays the report in order of the number of contacts routed to the contact 
service queue but were not answered because the caller hung up or was 
disconnected.

Sort Criterion Result

Filter Parameter Result

CSQ Names Displays information for the specified CSQs.

CSQ Types Includes these options:

• Resource Group—Displays information for CSQs that are configured with 
the Resource Pool Selection Model set to Resource Group in Cisco CRS 
Administration.

• Skill Group—Displays information for CSQs that are configured with the 
Resource Pool Selection Model set to Resource Skills in Cisco CRS 
Administration.

Chart Name Description

Calls accepted by 
campaign and agent

Displays the total number of calls that are accepted by each agent for each 
campaign.
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The Outbound Agent Detail Performance Report includes a table that shows the 
following information:

Field Description

Agent Name The last and first name of the agent. 

Campaign Name The name of the campaign.

Offered Total number of outbound calls offered to this agent for this campaign. A contact 
that is offered to an agent multiple times (possibly because that agent skipped 
the call and was eventually looped back to the same agent) is counted once for 
each time the contact is presented. Offered refers to the total number of 
Accepted, Rejected, and Closed calls. 

Accepted Total number of outbound calls accepted by this agent for this campaign. A call 
is considered Accepted if an agent has clicked Accept when presented the call. 

Rejected The number of outbound calls that were skipped or rejected by this agent for this 
campaign. This means that the agent selected Reject, Skip, or Cancel 
Reservation. These contacts are dialed again.

Closed The number of Outbound contacts that were closed by this agent for this 
campaign. This means that the agent selected Skip-Close or Reject-Close. 
These contacts are not dialed again.

RNA Ring-no-answer (RNA). The number of outbound calls that the agent ignores.

Transfer The number of outbound calls that are transferred to this agent from another 
agent. This agent does not dial an outbound call, instead, the other agent dials 
the outbound call and transfers it to this agent. 

Average Talk Time The average time in HH:MM:SS (hours, minutes, seconds) this agent spends 
talking on outbound calls for this campaign. The durations consider all calls that 
were Agent Accepted and classified as Voice.

Maximum Talk 
Time

The longest time in HH:MM:SS (hours, minutes, seconds) this agent has spent 
talking on an outbound call for this campaign. The durations consider all calls 
that were Agent Accepted and classified as Voice.
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You can sort the Outbound Agent Detail Performance Report by this criterion:

You can filter the Outbound Agent Detail Performance Report by these 
parameters:

Sort Criterion Result

Agent Name Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in alphabetical order campaign name.

Offered Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in ascending order of calls offered.

Accepted Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in ascending order of calls accepted. 

Rejected Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in ascending order of calls rejected.

Closed Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in ascending order of calls closed. 

RNA Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in ascending order of RNA.

Transfer Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in ascending order of Transfer.

Average Talk Time Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in ascending order of average talk time.

Maximum Talk 
Time

Displays the report in alphabetical order of agent names. Within the same agent 
name, sort the report in ascending order of maximum talk time.

Filter Parameter Result

Campaign Name Displays selected campaigns.

Agent Name Displays selected agent(s).

Resource Group 
Name

Displays agents who belong to the selected resource group(s).

Skill Name Displays agents who have the selected skill(s).

Team Name Displays agents who belong to the selected team(s).
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Outbound Campaign Summary Report
The Outbound Campaign Summary Report shows information about summary 
statistics for each campaign over a specified time period. This report is available 
with the Cisco Unified Outbound Preview Dialer (Outbound) feature.

The Outbound Campaign Summary Report can include these charts:

The Outbound Campaign Summary Report includes a table that shows the 
following information:

Chart Name Description

Calls Accepted, 
Rejected, Closed by 
Campaign

Displays the total number of calls that are accepted, rejected, or closed for each 
campaign.

Field Description

Campaign Name The name of the campaign.

Total Records The total number of contact records for this campaign.

Available The total number of contacts available (to be dialed). This number includes 
callbacks and contacts that are retried (because of previous unsuccessful dial 
attempts (for example, due to answering machine response or busy status).

Attempted Total number of outbound contact records attempted. A contact is considered 
attempted when an outbound call is placed to the customer, regardless of the 
outcome. A call record is considered attempted if an agent (at some point) 
clicked on Accept for this contact. A contact that is presented to and accepted 
by an agent is considered Attempted by the system. If that contact is marked for 
Callback and therefore later called by the same or another agent, this call record 
is still considered Attempted only once, and not twice. Similarly if a contact was 
retried because the original attempt was unsuccessful (reached answering 
machine, busy signal, customer not home, etc.), the contact is counted only 
once.

Attempted % The percentage of outbound calls attempted. Attempted % = (Attempted/Total 
Records) * 100
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Accepted Total number of outbound calls accepted. A call is considered accepted if an 
agent has clicked Accept when presented the call. A call that is presented to an 
agent, skipped/rejected by that agent, presented to another agent, and then 
accepted by that other agent is counted once towards the number of calls. 

Rejected The number of outbound calls that were skipped or rejected by an agent as part 
of this campaign. This means that the agent selected Reject, Skip, or Cancel 
Reservation. These contacts are dialed again. If a contact is rejected by multiple 
agents, this field is incremented each time the contact is rejected.

Closed The number of outbound contacts that were closed by agents as part of this 
campaign. This means that the agent selected Skip-Close or Reject-Close. 
These contacts are not dialed again.

Voice The number of outbound calls for the day that ended successfully. This means 
that an agent accepted the call (by clicking Accept) and selected a classification 
of Voice for this contact. The calls marked with this classification are a subset 
of the calls accepted. 

Answering Machine The number of outbound calls for the day with a classification of Answering 
Machine. This means that an agent accepted the call (by clicking Accept) and 
selected a classification of Answering Machine for this contact. 

Fax/Modem The number of outbound calls for the day with a classification of Fax/Modem. 
This means that an agent accepted the call (by clicking Accept) and selected a 
classification of Fax/Modem for this contact. 

Invalid The number of outbound calls for the day with a classification of Invalid. This 
means that an agent accepted the call (by clicking Accept) and selected a 
classification of Invalid for this contact. 

Requested Callback The number of calls marked for callback. A call that is accepted by an agent, 
marked for callback, later presented to and accepted by another agent (at the 
callback time), and marked for callback again is counted twice towards the 
number of callback calls. 

Customer Not Home The number of outbound contacts where the party answering the phone was not 
the customer.

Wrong Number The number of outbound contacts where the party answering the phone 
indicated the customer didn’t live there.

Do Not Call The number of outbound contacts where the party answering indicated that they 
did not want to be called.

Field (continued) Description (continued)
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You can sort the Outbound Campaign Summary Report by this criterion:

Busy The number of outbound calls where the response was a busy signal.

Average Talk Time The average time in HH:MM:SS (hours, minutes, seconds) that agents spend 
talking on outbound calls. The durations consider all calls that were Agent 
Accepted and classified as Voice.

Maximum Talk 
Time

The longest time in HH:MM:SS (hours, minutes, seconds) that an agent has 
spent talking on an outbound call. The durations consider all calls that were 
Agent Accepted and classified as Voice.

Field (continued) Description (continued)

Sort Criterion Result

Campaign Displays the report in alphabetical order of campaign name.

Total Records Displays the report in ascending order of total records.

Available Displays the report in ascending order of calls available.

Attempted Displays the report in ascending order of calls attempted.

Accepted Displays the report in ascending order of calls accepted. 

Agent Rejected Displays the report in ascending order of calls rejected by agent.

Voice Displays the report in ascending order of calls that ended successfully. 

Answering Machine Displays the report in ascending order of answering machine calls. 

Fax/Modem Displays the report in ascending order of fax/modem calls. 

Invalid Displays the report in ascending order of invalid calls. 

Requested Callback Displays the report in ascending order of calls marked for callback. 

Agent Closed Displays the report in ascending order of calls closed by agent.

Customer Not Home Displays the report in ascending order of calls for which customer was not 
home.

Wrong Number Displays the report in ascending order of calls that reached wrong numbers.

Do Not Call Displays the report in ascending order of calls marked as do not call.

Busy Displays the report in ascending order of busy calls.
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You can filter the Outbound Campaign Summary Report by this parameter:

Priority Summary Activity Report

The Priority Summary Activity Report shows call information for each call 
priority.

The Priority Summary Activity Report can include this chart:

The Priority Summary Activity Report includes a table that shows the following 
information:

Average Talk Time Displays the report in ascending order of average talk time.

Max Talk Time Displays the report in ascending order of max talk time.

Sort Criterion Result

Filter Parameter Result

Campaign Displays statistics of selected campaigns.

Chart Name Description

Total Calls by Call 
Priority

For each priority level that was assigned, displays the percentage of calls that 
received that priority.

Field Description

Call Priority Final priority that the Unified CCX workflow assigned to the call when the call 
was received, from 1 (lowest) to 10 (highest). All calls start with a default 
priority of 1, unless a different priority is set in the workflow.

Total Calls Number of calls assigned a particular priority level as their final priority level.

Avg Calls For each day in the report period, the average number of calls that received a 
particular priority level as their final priority level.
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You can sort the Priority Summary Activity Report by either of these criteria:

You can filter the Priority Summary Activity Report by this parameter:

Total Number of 
Calls with Different 
Original and Final 
Priorities

Number of calls that ended with a priority level other than the priority that was 
assigned when the call was received.

Average Number of 
Calls (Per Day) with 
Different Original 
and Final Priorities

Average number of calls per day that ended with a priority level other than the 
priority that was assigned when the call was received.

Maximum 
Difference Between 
Original and Final 
Priorities 
Experienced by All 
Calls

Largest difference between a priority level assigned to any one call when it was 
received and the priority level the call had when it ended.

Average Difference 
(Per Call) Between 
Original and Final 
Priorities 
Experienced by All 
Calls

Average difference between a priority level assigned to a call when it was 
received and the priority level the call had when it ended.

Field (continued) Description (continued)

Sort Criterion Result

Call Priority Displays the report in order of the final priority level assigned to each call.

Total Calls Displays the report in order of the number of calls assigned a particular priority 
level as their final priority level.

Filter Parameter Result

Call Priority Levels Displays information for the calls assigned the specified priority level as their 
final priority level. Priority levels range from 1 (lowest) to 10 (highest).
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Remote Monitoring Detail Report
The Remote Monitoring Detail Report shows information about the agent 
monitoring activities of supervisors.

The Remote Monitoring Detail Report can include these charts:

The Remote Monitoring Detail Report includes a table that shows the following 
information for monitoring session:

Chart Name Description

Total Duration by 
User ID

For each supervisor, displays the total time duration that the supervisor spent in 
all monitoring sessions during the report period.

Average Wait Time 
by User ID

For each supervisor, displays the average time that the supervisor waits in the 
monitoring session before the actual monitoring starts. (Monitoring starts when 
the agent being monitored makes or receives a call.) This average is calculated 
for the entire report period.

Field Description

User ID Name of the supervisor who monitored the call. A value of –1 indicates that no 
valid user ID is configured in the workflow.

Start Time Time that this monitoring session started.

Original 
Monitored Party

Name of the CSQ or the Unified CCX extension of the agent that the supervisor 
originally chose to monitor.

Monitored 
Extension(s)

The extensions of one or more agents monitored in this session. If the supervisor 
originally chose to monitor a CSQ, this field contains the extensions of the agents 
who belong to that CSQ and who are monitored in this session. If the supervisor 
chose to monitor an agent, this field contains the extension of the agent that is 
monitored. Multiple agent extensions in the field indicate that a conference call or 
a transfer call was monitored, which involved multiple agents.

Duration Elapsed time between the start time and end time of the monitoring session.

Wait Time Time duration from when a supervisor chooses to monitor an agent or a CSQ to 
when the monitoring starts.
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You can sort the Remote Monitoring Detail Report by any of these criteria:

Status The status of this monitoring session:

Normal – Monitored—Monitoring completed successfully.

Normal – Agent RNA—Agent let the call go ring-no-answer.

Error – Unable to Stop Monitoring—Supervisor pressed the * key to terminate the 
monitoring session but it fails to terminate.

Error – Unable to Monitor New Call—Supervisor chose to monitor a new call but 
the system fails to respond.

Error – Agent Logged Off—The agent that the supervisor intended to monitor has 
logged off.

Error – Network Problem—Monitoring session is not successful due to network 
problems.

Error – VoIP Server Unable to Communicate—Monitoring session is not successful 
as a server with that Cisco CRS Monitoring component fails to communicate.

Status 
(continued)

Error – Monitoring Not Allowed—Supervisor attempted to monitor an agent or a 
CSQs that are not on the allowed list for the supervisor.

Error – Agent Not Logged In—Agent that the supervisor intended to monitor is not 
logged in.

Error – Invalid Input—Supervisor entered input that is not recognized by the 
system.

Error – Other—Errors not defined by any of the preceding messages.

Field (continued) Description (continued)

Sort Criterion Result

Start Time Displays the report in order of the time that the monitoring session starts.

User ID Displays the report in order of the name of the supervisor.

Duration Displays the report in order of the time duration of the monitoring session.
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Traffic Analysis Report
The Traffic Analysis Report shows information about incoming calls to the Cisco 
CRS system. The information is provided for each day in the report range and 
includes information about the peak hour of each day.

The Traffic Analysis Report can include these charts:

The Traffic Analysis Report includes a table that shows the following information 
for each date in the report range:

Chart Name Description

Total Incoming 
Calls by Date

Displays the total number of calls received by the Cisco CRS system for each 
day in the report range.

Peak Calls by Date For each date, displays the number of calls received in the hour with the most 
calls.

Average Call 
Duration by Date

Displays the average length of calls for each day in the report range.

Field Description

Date Date for which information is provided.

Total Incoming 
Calls

Total number of calls received by the Cisco CRS system for the day.

Avg Calls (per hour) Average number of calls received during each hour for the day.

Peak Calls (per 
hour)

Number of calls received during the peak hour. (See the next field.)

Peak Hour Start,
Peak Hour End

Start and end time of the hour in a day during which the largest number of calls 
were received. This hour is defined as the peak hour.

Call Duration Avg Average call length for the day.

Call Duration Min Length of the shortest call for the day.

Call Duration Max Length of the longest call for the day.
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You can sort the Traffic Analysis Report by this criterion:

Sort Criterion Result

Date Displays the report in order of the date for which information is provided.
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Report Footnotes
In some cases, the last page of a report may contain one of the footnotes shown in 
the following table:

Report Footnote Explanation

This report exceeds the configured maximum 

number of records for a report. Some records 

will not be included.

The setHistMaxRecCount utility has been used to 
limit the number of records processed for reports 
and the data in the report period includes more 
records than this limit.

For information about the setHistMaxRecCount 
utility, refer to Cisco CRS Historical Reports 
Administrator and Developer Guide.

This report might not include complete data 

for calls received after date time.
The report period ends after date and time, but 
your Cisco CRS deployment includes two servers 
on which the Database component is installed and 
the data on these servers has not yet been 
synchronized past date and time.

If you see this footnote, you can take one of these 
actions:

• Wait a few minutes then generate the report 
again

• If a failover has occurred, wait until the 
standby server falls back

• Generate the report again, but specify a period 
end time that is before date and time
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C H A P T E R 4

Generating Historical Reports

When you generate a report with the Cisco CRS Historical Reports client, you 
perform the following general steps:

1. Choose general report settings, including the name of the report, whether to 
include charts, and the date and time range for which you want information.

2. Choose detailed report settings, if you want, including a sort method and a 
filter parameter.

3. Use the Report Viewer to view, print, or save (export) the report.

The following sections explain these steps in detail, and include these topics:

• General Report Settings, page 4-1

• Detailed Report Settings, page 4-4

• Saving and Loading Report Settings, page 4-8

• The Report Viewer, page 4-12

General Report Settings
General report settings include:

• Name of the report to generate

• Whether to include charts with the report

• Date and time range of the information contained in the report
4-1
ical Reports User Guide, Release 5.0(1)



 

Chapter 4      Generating Historical Reports
General Report Settings
You can return report settings to their default values at any time by clicking Reset 
in the CRS Historical Reports main window. This action resets both general report 
settings and detailed report settings.

If a Report Settings file is loaded, clicking Reset returns both general report 
settings and detailed report settings to the values specified in that file.

You choose general report settings in the General Report Settings area, shown in 
the Historical Reports main window in Figure 1-1.

Related Topics

• Choosing the Report to Generate, page 4-2

• Including Charts with a Report, page 4-3

• Choosing the Date and Time Range for a Report, page 4-4

• Saving and Loading Report Settings, page 4-8

Choosing the Report to Generate
To choose the report that you want to generate, follow these steps:

Procedure

Step 1 In the Reporting Task area of the Cisco CRS Historical Reports main window, 
click the Generate and View Historical Reports radio button.

The window displays tabs for general and detailed report settings.

Step 2 Click the General tab if it is not selected already.

The General Report Settings area appears.
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Step 3 Click the Report Type drop-down arrow to view a list of available reports, and 
choose the report that you want to generate.

If you have already generated this report in this Cisco CRS Historical Reports 
session, any information that you previously entered in the general or detailed 
fields for this report appears in these fields again.

Now you can choose additional general report settings and choose detailed report 
settings. You also must specify a date and time range for the report before you can 
view it.

Related Topics

• Including Charts with a Report, page 4-3

• Choosing the Date and Time Range for a Report, page 4-4

• Detailed Report Settings, page 4-4

• Viewing Reports, page 4-14

Including Charts with a Report
By default, each historical report contains one or more charts that display specific 
information in the report. You can choose whether to include or omit charts.

If you want to include charts with the report that you have chosen as explained in 
the “Choosing the Report to Generate” section on page 4-2, check the Include 
Charts in Report check box in the General Report Settings area. If you do not want 
to include charts, uncheck this check box.

After choosing this setting, you must choose a date and time range for the report 
before you can view it. You also can choose detailed report settings.

Related Topics

• Choosing the Report to Generate, page 4-2

• Choosing the Date and Time Range for a Report, page 4-4

• Detailed Report Settings, page 4-4

• Viewing Reports, page 4-14
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Choosing the Date and Time Range for a Report
You must choose the date and time range for the data in the report that you have 
chosen as explained in the “Choosing the Report to Generate” section on 
page 4-2. In the Date and Time fields next to Report Start Date and Report End 
Date in the General Report Settings area, enter the beginning and ending dates and 
times of the time range for which you want to generate information.

You can now choose additional general report settings, choose detailed report 
settings, or click View to view the report.

Related Topics

• Choosing the Report to Generate, page 4-2

• Including Charts with a Report, page 4-3

• Detailed Report Settings, page 4-4

• Viewing Reports, page 4-14

Detailed Report Settings
Detailed report settings allow you to cause reports to present information in a 
particular order and to include only specific information. Detailed report settings 
include:

• Sorting method—Order in which information in a report appears

• Filter parameter—Specific information that a report includes

You choose detailed report settings in the Detailed Report Settings area of the 
Cisco CRS Historical Reports main window, shown in Figure 4-1.
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Figure 4-1 Detailed Report Settings Area

Choosing detailed report settings is optional. If you do not choose one or more 
settings, the report will contain all relevant information presented in the default 
order. This default order appears in the Sort Report By field.

You can return report settings to their default values at any time by clicking Reset 
in the CRS Historical Reports main window. This action resets both detailed 
report settings and general report settings.

If a Report Settings file is loaded, clicking Reset returns both detailed report 
settings and general report settings to the values specified in that file.

Related Topics

• Specifying a Sorting Method, page 4-6

• Specifying a Filter Parameter, page 4-6

• Saving and Loading Report Settings, page 4-8
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Specifying a Sorting Method
You can specify a sorting method to display the information in reports in a 
particular order. For detailed information about the sorting methods available for 
a particular report, see the description of that report in the “Report Details” 
section on page 3-7.

To specify a sorting method for the report that you have chosen as explained in 
the “Choosing the Report to Generate” section on page 4-2, follow these steps:

Procedure

Step 1 In the Reporting Task area of the Cisco CRS Historical Reports main window, 
click the Generate and View Historical Reports radio button.

The window displays tabs for general and detailed report settings.

Step 2 Click the Detailed tab.

The Detailed Report Settings area appears.

Step 3 Click the Sort Report By drop-down arrow to view a list of available sort methods, 
and then choose the sort method that you want to use.

After specifying a sorting method, you can choose additional detailed report 
settings, or click View to view the report.

Related Topics

• Specifying a Filter Parameter, page 4-6

• Viewing Reports, page 4-14

Specifying a Filter Parameter
A filter parameter lets you limit the information that a report includes by selecting 
only the information that you want. For example, if you are generating an Agent 
Summary Report, you can use a filter parameter to include information for 
specific agents only.
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For detailed information about the filter parameters available for a particular 
report, see the description of the report in the “Report Details” section on 
page 3-7.

If no filter parameter is available for the report that you are generating, the 
Parameter Setting area displays No Parameter Detailed Settings Available.

To specify a filter parameter for the report that you have chosen as explained in 
the “Choosing the Report to Generate” section on page 4-2, follow these steps:

Procedure

Step 1 In the Reporting Task area of the Cisco CRS Historical Reports main window, 
click the Generate and View Historical Reports radio button.

The window displays tabs for general and detailed report settings.

Step 2 Click the Detailed tab.

The Detailed Report Settings area appears.

Step 3 Click the Filter Parameter drop-down arrow to view a list of available filter 
parameters, and then choose the filter parameter that you want to use.

Depending on the filter parameter you choose, the Available pane of the 
Parameter Setting area displays either a list of available parameter settings or the 
Enter Parameter Value field. If you have previously chosen parameter settings for 
this report and this parameter during this session, the settings you chose before 
appear in the Selected pane.

Step 4 If a list of available parameter settings appears, choose the parameter setting or 
settings that you want to use as follows:

• To choose specific settings that appear in the Available pane, click the 
settings and then click >. The settings move to the Selected pane. To select 
all of the settings, click >> without choosing any settings.

• To unselect specific settings that appears in the Selected pane, choose that 
setting, and then click <. To unselect all settings, click << without choosing 
any settings.

If the Enter Parameter Value field appears, enter the value that you want to use as 
n in the filter parameter.
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Related Topics

• Specifying a Sorting Method, page 4-6

• Viewing Reports, page 4-14

Saving and Loading Report Settings
If you often generate particular reports, you may find that it is convenient to save 
the general and detailed report settings that you choose for these reports. You can 
recall these settings and make adjustments to them each time that you generate the 
report. You can also recall these settings and use them as a basis for a scheduled 
report.

You save report settings in a file called a Report Settings file. When you load a 
Report Settings file, the report settings saved in that file appear in the Cisco CRS 
Historical Reports main window.

Related Topics

• Saving Report Settings, page 4-8

• Loading Report Settings, page 4-10

• Changing and Saving Report Settings, page 4-11

Saving Report Settings
By default, the Cisco CRS Historical Reports client saves Report Settings files on 
your computer in the Cisco CRS Historical Reports\Reports directory, which is 
under the directory in which you installed the Cisco CRS Historical Reports 
system. (By default, the system installs in the Program Files directory.) The client 
gives a Report Settings file the name report.chc, where report is the name of the 
report for which you are saving settings. You can change the default directory and 
the base file name for a Report Settings file. The file name must have the 
extension .chc.

To save report settings in a new Report Settings file, follow these steps:
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Procedure

Step 1 In the CRS Historical Reports main window, choose the general report settings 
and detailed report settings that you want to save.

Step 2 Choose File > Save, or choose File > Save As, or click the Save tool.

The Save As dialog box appears.

Step 3 If you want, make changes in the Save As dialog box as follows:

• To save Report Settings files in a directory other than the default directory, 
use the Save In drop-down arrow, the Folder Name pane, or the Save In tools 
to specify the directory.

• To change the file name that appears in the File Name field, enter the file 
name that you want. To choose a file that already exists, you can use the File 
Name drop-down arrow to display a list of file names, and then choose the file 
name that you want. A message appears asking if you want to replace the 
existing file. Click Yes to continue.

Note A report settings file name must have the extension .chc. The system 
adds this extension to the name in the File Name field automatically.

Step 4 Click Save.

The Cisco CRS Historical Reports client saves the Report Settings file. You can 
load this file whenever you need it.

Related Topics

• General Report Settings, page 4-1

• Detailed Report Settings, page 4-4

• Loading Report Settings, page 4-10

• Changing and Saving Report Settings, page 4-11
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Loading Report Settings
When you load report settings, you specify the name of the Report Settings file in 
which the settings that you want are saved. When the report loads, these settings 
appear in the various fields in the CRS Historical Reports main window.

To load report settings from the Cisco CRS Historical Reports client main 
window, perform the following steps. If the client software is stopped, you can 
start the client software and load a Report Settings file in one step by choosing the 
Report Settings file in the directory in which it is stored.

Note You cannot load a report settings file that contains settings for a report for which 
you do not have access. You also cannot load a report settings file if the file was 
created when the client language was different than the current language.

Procedure

Step 1 In the Reporting Task area of the CRS Historical Reports main window, click 
Load Existing Report Setting.

You may also click the Open tool or choose File > Open.

The Open dialog box appears, showing the File List pane.

Step 2 If the Report Settings file that you want appears in the File List pane, double-click 
the name of the file, or click the name of the file and then click Open. 

If the Report Settings file does not appear, use the Look In drop-down arrow, the 
Folder Name pane, or the Save In tools to specify the directory. Then double-click 
the name of the file, or click the name of the file and then click Open.

TheCisco CRS Historical Reports main window appears. The General and 
Detailed report settings fields contain settings from the Report Settings file.

Related Topic

• Saving and Loading Report Settings, page 4-8
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Changing and Saving Report Settings
You can load a Report Settings file, make changes to any or all of the settings, and 
save the changes in the original Report Settings file or in a new file.

To change report settings, follow these steps:

Procedure

Step 1 Load a Report Settings file as described in the “Loading Report Settings” section 
on page 4-10.

Step 2 Make changes to the report settings as needed.

Step 3 If you want to save the changes in the Report Settings file that is currently loaded, 
choose File > Save.

If you want to save the changes in a new Report Settings file, choose File > 
Save As. Enter the new file name in the Save As dialog box, and then click Save.

Note If you load and make changes to a Report Settings file without saving the file, and 
you then try to choose a new report type or exit Cisco CRS Historical Reports, the 
computer displays a dialog box asking if you first want to save the changes that 
you made to the Report Settings file. Click Yes to save the changes in the original 
Report Settings file or click No to continue without saving the changes.

Sample Historical Reports
Some sample historical reports are located with the product documentation, under 
the Design Guides section in the following web site:

http://www.cisco.com/en/US/partner/products/sw/custcosw/ps1846/products_us
er_guide_list.html
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The Report Viewer
The Report Viewer window appears automatically when you click View in the 
CRS Historical Reports main window to generate a report. The Report Viewer 
window contains the report you have generated. It also contains a toolbar, shown 
in Figure 4-2, which provides tools for moving through the report, printing the 
report, exporting the report, finding text in the report, and viewing information 
about groups.

Figure 4-2 Report Viewer Toolbar

Item Reference

1 Close Current View tool Displaying Group Information Using the 
Group Tree, page 4-19

2 Print Report tool Printing Reports, page 4-20

3 Export Report tool Exporting Reports, page 4-21

4 Toggle Group Tree tool Displaying Group Information Using the 
Group Tree, page 4-19

5 Display Size field Changing the Display Size, page 4-15

6 Go to First Page tool Moving Through the Report, page 4-15

7 Go to Previous Page tool Moving Through the Report, page 4-15

8 Page Number field Moving Through the Report, page 4-15

9 Page count display Moving Through the Report, page 4-15

10 Go to Next Page tool Moving Through the Report, page 4-15

11 Go to Last Page tool Moving Through the Report, page 4-15
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Related Topics

• Viewing Reports, page 4-14

• Changing the Display Size, page 4-15

• Moving Through the Report, page 4-15

• Finding and Moving to Specific Text, page 4-16

• Displaying Information About Groups, page 4-17

• Printing Reports, page 4-20

• Exporting Reports, page 4-21

12 Stop Loading tool Moving Through the Report, page 4-15

13 Search Text tool Finding and Moving to Specific Text, 
page 4-16

14 Help tool Getting Online Help, page 1-7
4-13
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 4      Generating Historical Reports
The Report Viewer
Viewing Reports
To view a report, follow these steps:

Procedure

Step 1 In the CRS Historical Reports main window, choose the report settings that you 
want.

Step 2 Click View. 

The report generates and appears in the Report Viewer window.

Some reports can take a few minutes to generate and another few minutes to load 
into the Report Viewer window. To cancel a report while it is generating, click 
Cancel in the CRS Historical Reports main window or click the Stop Loading 
tool in the Report Viewer window.

When a report appears in the Report Viewer window, you can:

• Change the size of the display

• Move to different parts of the report

• Find specific text in the report

• Display information about particular groups

To exit the Report Viewer window, click the Close button on the title bar.

Related Topics

• Changing the Display Size, page 4-15

• Moving Through the Report, page 4-15

• Finding and Moving to Specific Text, page 4-16

• Displaying Information About Groups, page 4-17
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Changing the Display Size
To change the size of the report display, click the Display Size drop-down arrow 
and choose the value that you want. 

You can also select the value that appears in this field, enter a value between 25% 
and 400%, and press the Enter key.

Moving Through the Report
To make the most efficient use of system resources, the Cisco CRS Historical 
Reports client loads pages on demand as you move through the report. The Page 
Number field in the Report Viewer window shows the number of the currently 
displayed page. To its right, the Page Count field shows how many pages the 
report contains. 

The Page Count field does not show the total number of pages until all pages of a 
report have been loaded. Instead, it shows the number of the currently displayed 
page followed by a plus sign (+) to indicate that the report contains additional 
pages.

You can move through a report one page at a time or jump to any specific page. 
The following table shows how to move through a report:

To Make This Move 
When Viewing a Report Perform This Action in the Report Viewer Window

Move forward one page Click the Go To Next Page tool.

Move backward one page Click the Go To Previous Page tool.

Move to the last page Click the Go To Last Page tool.

Move to the first page Click the Go To First Page tool.

Move to a specific page Select the number that appears in the Page Number 
field, enter the page number that you want, and then 
press the Enter key.
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Note Moving directly to the first page or last page in a long report can take a few 
minutes. To stop these move actions, click the Stop Loading tool in the Report 
Viewer window.

Related Topic

• Finding and Moving to Specific Text, page 4-16

Finding and Moving to Specific Text
To find and move to specific text in a report that appears in the Report Viewer 
window, follow these steps:

Procedure

Step 1 On the Report Viewer toolbar, click the Search Text tool.

The Search dialog box appears.

Step 2 In the Find What field, enter the text that you want to find, and then click Find 
Next.

Caution Wild card searches are not allowed in this field.

The display moves to the next occurrence of the text that you entered.

You can continue to click Find Next to display subsequent occurrences of the 
same text.

Step 3 Click Cancel to close the Search dialog box.
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Displaying Information About Groups
Most historical reports have a specific set of information that has been designated 
as a group. For example, a group may contain the names of agents, or a group may 
contain dates. A report displays information arranged by its group.

The following table shows the name of the group for each report.

Report Name Group

Abandoned Call Detail Activity Report Call Start Date

Aborted and Rejected Call Detail Report —

Agent Call Summary Report Agent Name

Agent Detail Report Agent Name

Agent Login Logout Activity Report Agent Name

Agent Not Ready Reason Code Summary Report Agent Name

Agent State Detail Report Agent Name

Agent State Summary Report (by Agent) Agent Name

Agent State Summary Report (by Interval) Interval Start Time

Agent Summary Report Agent Name

Agent Wrap-Up Data Detail Report Agent Name

Agent Wrap-Up Data Summary Report Wrap-Up Data

Application Performance Analysis Report Application ID

Application Summary Report —

Call Custom Variables Report —

Called Number Summary Activity Report Called Number

Common Skill Contact Service Queue Activity 
Report (by Interval)

Contact Service Queue 
Name

Contact Service Queue Activity Report Contact Service Queue 
Name

Contact Service Queue Activity Report (by CSQ) Contact Service Queue 
Name

Contact Service Queue Activity Report (by Interval) Interval Start Time
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When you view a report, you can display information for any particular item in its 
group. For example, in the Agent Detail Report, you can display information for 
any single agent.

You display group information using the Group Tree. For many reports, you can 
also display group information directly from the charts that appear with the 
reports.

Related Topics

• Displaying Group Information Using the Group Tree, page 4-19

• Displaying Group Information from a Report Chart, page 4-19

Contact Service Queue Call Distribution Summary 
Report 

Contact Service Queue 
Name

Contact Service Queue Priority Summary Report —

Contact Service Queue Service Level Priority 
Summary Report

Contact Service Queue 
Name

CSQ–Agent Summary Report —

Detailed Call by Call CCDR1 Report —

Detailed Call, CSQ, Agent Report —

Multichannel Agent Contact Summary Report Agent Name

Multichannel Agent Login Logout Activity Report Agent Name

Multichannel CSQ Activity Report Contact Service Queue 
Name

Outbound Campaign Summary Report Campaign Name

Outbound Agent Detail Performance Report Agent Name

Priority Summary Activity Report Call Priority

Remote Monitoring Detail Report User ID

Traffic Analysis Report Date

1. CCDR = Contact Call Detail Record

Report Name Group
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Displaying Group Information Using the Group Tree

A Group Tree is a list of all group names available for a particular report. Most 
reports have a Group Tree.

To display the group tree for a report, follow these steps:

Procedure

Step 1 Click the Toggle Group Tree tool on the Report Viewer toolbar. 

The Preview pane appears, displaying a list of groups.

Step 2 To display information for a group in the Preview pane, click the name of the 
group.

The group information appears in a new pane called a Group Information pane. 
This pane has a tab that shows the name of the group.

If several Group Pane tabs appear, you can display the information that you want 
by clicking its tab. 

To display the Group Tree when you are viewing information in a Group 
Information Pane, click the Preview tab.

Step 3 To close the Preview pane any time it is displayed, click the Toggle Group Tree 
tool.

To close a Group Information pane when it is displayed, click the Close Current 
View tool.

Displaying Group Information from a Report Chart

In many reports, moving the mouse pointer over information displayed in the 
charts generated with the reports causes the pointer to change to a magnifying 
glass. The magnifying glass indicates that you can display group information 
from that chart.

To display group information from a chart, follow these steps:
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Procedure

Step 1 Make sure that the mouse pointer has changed to a magnifying glass, and then 
double-click the group name or its associated data.

The Group Information pane appears, displaying information for the group.

Step 2 To return to the chart, click the Preview tab.

Step 3 To close a Group Information pane when it is displayed, click the Close Current 
View tool.

Printing Reports
You can print a report while viewing any part of the report. If you are viewing 
information in a Group Information Pane, only that information prints. The report 
prints on the default printer that has been designated for your computer.

To print a report, follow these steps:

Procedure

Step 1 In the CRS Historical Reports main window, choose the report settings that you 
want, and then click View. 

The report appears in the Report Viewer window.

Step 2 Click the Print tool. 

The Print dialog box appears.

Step 3 In the Print dialog box, choose the settings that you want.

Step 4 Click OK. 

The Printing Records dialog box appears while the file is being printed and shows 
the progress of printing.
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Exporting Reports
Exporting a report means saving the report in a file. You can specify the name and 
location of the file and the format in which the report is saved. After a report is 
exported to a file, you can view, print, and manipulate the data in the file with 
another program. 

When you export a report, you can save it in any of the formats shown in the 
following table. If you export reports to Microsoft Excel, make sure that the 
Extended version of Excel 7.0 is installed on the computer on which you perform 
the export procedure.

To export a report, follow these steps:

Procedure

Step 1 In the CRS Historical Reports main window, choose the report settings that you 
want, and then click View. 

The report appears in the Report Viewer window.

Step 2 Click the Export Report tool.

The Export dialog box appears. 

Format
Extension that the System 
Adds to the File Name Description

Acrobat Format (PDF) .pdf Portable Document Format file that can be read 
with Adobe Acrobat Reader

Comma-separated 
values (CSV)

.csv Comma-separated text file

Excel (XLS) .xls Microsoft Excel file

Rich Text (Exact) 
Format

.rtf RTF file that can be opened with Microsoft Word

XML .xml Extensible Markup Language file
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Step 3 Click the Format drop-down arrow, and then choose the format in which you want 
to save the report.

A series of dialog boxes appear. The specific dialog boxes depend on the format 
that you chose.

Step 4 Set the desired exporting options and specify the name and location for the export 
file by enter information in the dialog boxes that appear.

When you are finished, the system exports the report and displays the Exporting 
Records dialog box, which shows the progress of the export operation.

To cancel the export operation at any time, click Cancel Exporting.
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Scheduling Historical Reports

Scheduling a historical report means instructing the Cisco CRS Historical Reports 
client to automatically generate the report at some time in the future. Although 
you can schedule a report to generate once, the report scheduling function is 
particularly useful for preparing reports that you require regularly. For example, 
you can schedule an Agent Detail Report to generate every Monday at midnight 
and an Agent Summary Report to generate on the first Sunday of every month at 
noon.

When you schedule a report, you perform these general steps:

1. Choose general settings for the report, including the name of the report, 
whether to include charts, and whether to save (export) or print the report.

2. Choose detailed settings for the report, if necessary, including a sort method 
and a filter parameter.

3. Choose scheduling settings, including how often and when the report is 
generated.

4. Save the scheduling information.

The following sections include these topics:

• Information in Scheduled Reports, page 5-2

• Recommendations for Scheduling, page 5-3

• The Scheduler, page 5-3

• General Settings for Scheduled Reports, page 5-5

• Detailed Settings for Scheduled Reports, page 5-10

• Choosing Schedule Settings, page 5-11
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• Saving a Schedule, page 5-14

• Viewing and Deleting Schedules, page 5-15

• Handling Missed Schedules, page 5-17

Information in Scheduled Reports
The following table shows the types of schedules that you can specify for 
historical reports and the information that is contained in each type of report. 

The time and date for data in scheduled reports is always the time and date of the 
Cisco CRS server.

Schedule Type Recurrence Options Information Contained in the Report

Daily • Every day (Sunday through 
Saturday)

• Every weekday (Monday through 
Friday)

• Every n days (for example, every 3 
days)

Note A report that is scheduled to recur 
every weekday will run every 
Tuesday through Saturday so that 
it can include information for 
Monday through Friday.

A daily report always contains data from 
12:00 midnight (0000) to 11:59:59 p.m. 
(1159:59) for the day before the report 
runs. For example, a daily report that runs 
on Tuesday will contain data for the 
preceding Monday.

Weekly • Every week on a certain day (for 
example, every Monday)

• Every n weeks on a specific day (for 
example, every two weeks on Friday)

A weekly report always contains data 
from Sunday at 12:00 midnight (0000) to 
Saturday at 11:59:59 p.m. (1159:59) for 
the week before the report runs, 
regardless of the day of the week on 
which the report runs. For example, a 
weekly report that runs on Monday, on 
Wednesday, or on Friday will contain data 
for Sunday through Saturday of the 
previous week.
5-2
Cisco CRS Historical Reports User Guide, Release 5.0(1)



 

Chapter 5      Scheduling Historical Reports
Recommendations for Scheduling
Recommendations for Scheduling
When a scheduled report generates, it can use significant resources on the Cisco 
CRS server. To help keep the server running most efficiently, schedule reports to 
generate at times when the Cisco CRS server is least busy, for example, late at 
night or early in the morning.

The Scheduler
The CRS Historical Reports client includes a program called the Scheduler. A 
Scheduler resides on each client computer and performs these functions:

• Maintains information about each schedule, including when each schedule 
should execute and what information the scheduled report should contain

• Executes schedules at their scheduled times, based on the time and date of the 
CRS Historical Reports client computer

Monthly • Every month on a specific date (for 
example, the 15th of every month)

• Every month on a certain day (for 
example, the first Friday of every 
month)

Note If a monthly report is scheduled 
to run on a date that does not 
occur in some months, for 
example the 30th or 31st, the 
report will run on the last day of a 
month that does not contain the 
date.

A monthly report always contains data 
from the first day of the previous month at 
12:00 midnight (0000) to the last day of 
the previous month at 11:59:59 p.m. 
(1159:59). For example, a monthly report 
that runs on any day in February will 
contain data for all of January.

Once Any single date and time that you specify A report that runs once contains data for 
the date and time range that you specify.

Schedule Type Recurrence Options Information Contained in the Report
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The Scheduler runs automatically and unattended in the background on the Cisco 
CRS Historical Reports client computer. It will not affect other activities that you 
perform on the client computer. The Scheduler should always be left running, 
even when you exit the CRS Historical Reports main window. If the Scheduler is 
not running when a schedule should execute, the schedule will not execute.

If a schedule does not execute because the Scheduler is not running, the Missed 
Report dialog box appears when the Scheduler restarts. For more information, see 
the “Handling Missed Schedules” section on page 5-17.

You can control the Scheduler using the Scheduler icon, shown in Figure 5-1. This 
icon appears in the status area on your Windows taskbar.

Figure 5-1 Scheduler Icon

To verify that the Scheduler is running, right-click the Scheduler icon and look at 
the Run Scheduler option in the Scheduler menu. If Run Scheduler is dimmed 
(that is, unavailable), the Scheduler is running.

Note The Scheduler icon does not appear in the Windows status bar under a terminal 
service session. If you need to access features from the Schedule icon, you must 
do so from the computer on which the Scheduler is installed.

To start the Scheduler, right-click the Scheduler icon and choose Run Scheduler. 
Or, choose Start > Programs > Cisco CRS Historical Reports > Cisco CRS 
Historical Reports Scheduler.

To stop the Scheduler, right-click the Scheduler icon and choose Stop Scheduler. 
The Scheduler remains loaded, but it will not execute schedules.

To exit the Scheduler, right-click the Scheduler icon and choose Exit. The 
scheduler unloads and will not execute schedules.

Note If you change the system time on the Cisco CRS Historical Reports client 
computer, stop and then restart the Scheduler that is running on that computer.
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General Settings for Scheduled Reports
General settings for scheduled reports include:

• Name of the report to schedule

• Whether to include charts with the report

• Whether to print the report or export it to a file

You can return the report settings you choose for a scheduled report to their 
default values at any time by clicking Reset in the CRS Historical Reports main 
window.

If you have saved report settings in a Report Settings file, you can load the Report 
Settings file and use it as a basis for a scheduled report. See the “Saving and 
Loading Report Settings” section on page 4-8 for information about saving and 
loading a Report Settings file.

If you have already made settings for a report in this Cisco CRS Historical Reports 
session, any information that you entered in the general or detailed fields for that 
report appears in those areas when you schedule reports. In addition, if the report 
is set to occur once, date and time information that you entered when you set up 
the report appears in the Cisco CRS Historical Reports Schedule menu. You can 
use the information that appears in the general and detailed fields and in the 
Schedule menu as a basis for your scheduled report, or you can click Reset to 
return the report settings to their default values.

Related Topics

• Choosing the Report to Schedule, page 5-6

• Including Charts with a Scheduled Report, page 5-6

• Choosing Whether to Print or Export a Scheduled Report, page 5-7
5-5
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter 5      Scheduling Historical Reports
General Settings for Scheduled Reports
Choosing the Report to Schedule
To choose the report that you want to schedule, follow these steps:

Procedure

Step 1 In the Cisco CRS Historical Reports main window, click the Schedule Future 
Reports, Including Repeat Reports radio button.

Step 2 Click the General tab, if it is not selected already.

Step 3 Click the Report Type drop-down arrow to view a list of available reports, and 
then choose the report that you want to generate.

Now you can specify whether to include charts with the report, choose whether to 
print or export the report, and choose detailed report settings. You also must 
choose schedule settings before the schedule will execute.

Related Topics

• Including Charts with a Scheduled Report, page 5-6

• Choosing Whether to Print or Export a Scheduled Report, page 5-7

• Detailed Settings for Scheduled Reports, page 5-10

• Choosing Schedule Settings, page 5-11

Including Charts with a Scheduled Report
Each historical report can contain one or more charts that summarize information 
in the report. If you want to include charts with a scheduled report, follow these 
steps:

Procedure

Step 1 In the CRS Historical Reports main window, click the Schedule Future Reports, 
Including Repeat Reports radio button.

Step 2 Click the General tab, if it is not selected already.
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Step 3 Check the Include Charts in Report check box.

If you do not want to include charts, uncheck this check box.

Now you can choose whether to print or export the report, and choose detailed 
report settings. You also must choose schedule settings before the schedule will 
execute.

Related Topics

• Choosing the Report to Schedule, page 5-6

• Choosing Whether to Print or Export a Scheduled Report, page 5-7

• Detailed Settings for Scheduled Reports, page 5-10

• Choosing Schedule Settings, page 5-11

Choosing Whether to Print or Export a Scheduled Report
When a schedule executes, the Cisco CRS Historical Reports client either prints 
the report or exports it (saves it in a file). After choosing this setting, you can 
choose detailed report settings. You also must choose schedule settings before the 
schedule will execute.

Related Topics

• Printing a Scheduled Report, page 5-7

• Exporting a Scheduled Report, page 5-8

• Detailed Settings for Scheduled Reports, page 5-10

• Choosing Schedule Settings, page 5-11

Printing a Scheduled Report

Scheduled reports print on the default printer that has been designated for your 
computer. To print a scheduled report when it generates, click the Export Type 
drop-down arrow in the CRS Historical Reports main window and choose Export 
to Printer.
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Now you can choose detailed report settings. You also must choose schedule 
settings before the schedule will execute.

Related Topics

• Exporting a Scheduled Report, page 5-8

• Detailed Settings for Scheduled Reports, page 5-10

• Choosing Schedule Settings, page 5-11

Exporting a Scheduled Report

The Cisco CRS Historical Reports client saves scheduled reports in files. You can 
view, print, and manipulate the data in these files with other programs. Unless you 
have changed the defaultExportPath parameter in the hrcConfig.ini file, the Cisco 
CRS Historical Reports client stores these files on the client computer in the Cisco 
CRS Historical Reports\Reports directory, which is under the directory in which 
you installed the Cisco CRS Historical Reports system. (By default, the system 
installs in the Program Files directory.) By default, the client saves scheduled 
reports in a PDF file. Also by default, the client gives saved reports a descriptive 
file name that indicates the name of the report, its language, its date and time of 
creation, the login identification of the user who scheduled it, its scheduled 
recurrence, its date range, and the format of the file. If desired, you can specify 
another format, location, and file name. (If you change the file name, the client 
automatically adds descriptive information to the new file name when it creates 
the file.)

When you specify that a generated report is to be saved, you can designate any of 
the formats shown in the following table.

Format
Extension that the System 
Adds to the File Name Description

Acrobat Format (PDF) .pdf Portable Document Format file that can 
be read with Adobe Acrobat Reader

Comma-separated values (CSV) .csv Comma-separated text file

Excel (XLS) .xls Microsoft Excel file

Rich Text (Exact) Format .rtf RTF file that can be opened with 
Microsoft Word

XML .xml Extensible Markup Language file
5-8
Cisco CRS Historical Reports User Guide, Release 5.0(1)



 

Chapter 5      Scheduling Historical Reports
General Settings for Scheduled Reports
To save a scheduled report in a file when the report runs, follow these steps:

Procedure

Step 1 Make sure that Export to File appears in the Export Type field in the Cisco CRS 
Historical Reports main window. If Export to File does not appear, click the 
Export Type drop-down arrow, and then choose Export to File from the list that 
appears.

Step 2 If you want to change the default format, location, or file name for exported files, 
click Export Location. 

(The Export Location button appears as “...” in the window.)

The Save As dialog box appears. The Cisco CRS Historical Reports client will add 
information to the default file name shown in the File Name field when the report 
is generated.

Step 3 If you want, make changes in the Save As dialog box as follows:

• To change the location, use the Save In drop-down arrow, the Folder Name 
pane, or the Save In tools to specify the directory in which to save the 
exported report.

• To change the file name, enter the new name in the File Name field, or click 
the drop-down arrow and then choose it from the list of existing names. If you 
specify a file name that includes an extension shown in the Save as type drop- 
down list, the system will create a file in that format, regardless of the format 
that you select in the Save As field.

• To change the format, click the Save As Type drop-down arrow, and then 
choose the format in which you want to save the report.

Step 4 Click Save.

Now you can choose detailed report settings. You also must choose schedule 
settings before the schedule will execute.

Related Topics

• Printing a Scheduled Report, page 5-7

• Detailed Settings for Scheduled Reports, page 5-10

• Choosing Schedule Settings, page 5-11
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Detailed Settings for Scheduled Reports
When you use detailed report settings, you can cause scheduled reports to include 
only specific information or to display information in a particular order. Detailed 
report settings include a sorting method and a filter parameter.

Detailed settings are optional. If you do not choose a detailed setting, the report 
will contain all relevant information presented in a default order.

To specify a sorting method and a filter parameter for a scheduled report, follow 
these steps:

Procedure

Step 1 In the Cisco CRS Historical Reports main window, click the Generate and View 
Historical Reports radio button.

Step 2 Click the Detailed tab.

Step 3 Choose detailed settings just as you do when you generate a report. See the 
“Detailed Report Settings” section on page 4-4 for complete instructions.

After choosing these settings, you must choose schedule settings before the 
schedule will execute.

Related Topics

• Detailed Report Settings, page 4-4

• Specifying a Sorting Method, page 4-6

• Specifying a Filter Parameter, page 4-6

• Choosing Schedule Settings, page 5-11
5-10
Cisco CRS Historical Reports User Guide, Release 5.0(1)



 

Chapter 5      Scheduling Historical Reports
Choosing Schedule Settings
Choosing Schedule Settings
After you choose general and detailed settings for a report, you are ready to 
choose schedule settings. You can make changes to any of the report settings later 
if you want.

When you choose schedule settings, you specify:

• How often the schedule executes

• Date and time range of schedule recurrences (if the schedule is to execute 
more than once)

To choose schedule settings, follow these steps:

Procedure

Step 1 In the Cisco CRS Historical Reports main window, click the Schedule Future 
Reports, Including Repeat Reports radio button.

Step 2 Click the General tab, if it is not selected already.

Step 3 Click Change.

The Cisco CRS Historical Reports Schedule window appears, as shown in 
Figure 5-2.
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Figure 5-2 Cisco CRSHistorical Reports Schedule Window

Step 4 In the Occurs area, choose how often the schedule executes, as explained in the 
following table.

1 Occurrence options

2 Occurrence frequency

3 Range of recurrence options

If You Want the Schedule to 
Execute This Often

Click This 
Radio Button Then Perform These Actions

Every day Daily Click the Every radio button, and then enter 1 in the 
Every n Day(s) field.

Every specific number of days 
(for example, every 3 days)

Daily Click the Every radio button, and then enter the 
number of days in the Every n Day(s) field.
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Step 5 Set Range of Recurrence options as follows:

For a schedule that is set to occur once, choose these settings in the Range of 
Recurrence area: 

• In the Start Date field, specify the date that you want the schedule to execute.

Every weekday (Monday 
through Friday)

Note This report will run 
every Tuesday through 
Saturday so that it can 
include information for 
Monday through Friday.

Daily Click the Every weekday radio button.

Every week on a certain day (for 
example, every week on Friday)

Weekly Enter 1 in the Every n Week(s) On field, and then 
click the radio button for the desired day.

Every specific number of weeks 
on a certain day (for example, 
every 2 weeks on Monday)

Weekly Enter the number of weeks in the Every n Weeks(s) 
On field, and then click the radio button for the 
desired day.

Every month on a specific date, 
(for example, the 15th of every 
month)

Monthly Click the Day n of calendar month radio button. 
Then enter the date in this field, or you can click the 
drop-down arrow and click the scroll arrow to 
display the date that you want and then click the 
date. (If you enter a date that does not occur in some 
months, for example 30 or 31, the system will use 
the last day of the month for months that do not 
contain the date.)

Every month on a certain day 
(for example, the second Friday 
of every month, or the last 
Sunday of every month)

Monthly Click the The number day of calendar month radio 
button. Click the drop-down arrow in the first field 
and choose the number of the day. Then click the 
drop-down arrow in the second field and choose the 
name of the day.

One time Once In the Report Start Date and Report End Date fields, 
specify the dates and times of the first and last data 
that you want to include in the report.

If You Want the Schedule to 
Execute This Often

Click This 
Radio Button Then Perform These Actions
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• In the Start Time field, specify the time that you want the schedule to execute.

For a schedule that is set to occur daily, weekly, or monthly, make these settings 
in the Range of Recurrence area:

• In the Start Date field, specify the first date on or after which you want the 
schedule to generate.

• In the Start Time field, specify the time at which you want to execute the 
schedule when the schedule occurs.

• Specify how often you want the schedule to recur:

– If you want the schedule to recur indefinitely, click the No end date radio 
button.

– If you want the schedule to recur a specific number of times, click the 
End after radio button and enter the number of occurrences in the End 
After field.

– If you want to specify the last date of a range during which you want the 
schedule to execute, click the End by radio button and enter the date in 
the End By field.

Step 6 Click OK to save your schedule settings.

Related Topics

• Information in Scheduled Reports, page 5-2

• General Settings for Scheduled Reports, page 5-5

• Detailed Settings for Scheduled Reports, page 5-10

• Saving a Schedule, page 5-14

Saving a Schedule
After choosing general, detailed, and schedule settings, you are ready to save the 
scheduling information. When you save scheduling information, the system stores 
the information you have specified as a schedule in the Scheduler database.

To save a schedule, follow these steps:
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Procedure

Step 1 In the Cisco CRS Historical Reports main window, click Schedule.

The Report Scheduled Successfully dialog box appears.

Step 2 Click OK.

Related Topics

• Information in Scheduled Reports, page 5-2

• General Settings for Scheduled Reports, page 5-5

• Detailed Settings for Scheduled Reports, page 5-10

• Choosing Schedule Settings, page 5-11

• Viewing and Deleting Schedules, page 5-15

Viewing and Deleting Schedules
To see a list of schedules that you created and that are stored in the Scheduler, 
choose Settings > Scheduler from the Cisco CRS Historical Reports main 
window, or click the Scheduler tool. The Scheduled Reports window appears.

To exit the Scheduled Reports window, click Close.

The Scheduled Reports window lists each stored schedule that you created when 
you were logged into the Cisco CRS Historical Reports system using the current 
login information. This window displays each schedule on a row and arranges 
information about each schedule in the columns shown in the following table.

Column Description

Report Name Name of the scheduled report

Date Created Date and time that the schedule was created

Recurrence Type How often the schedule executes

Export Type Printer, or format of the export file
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To expand a column if you cannot see its entire contents, drag the left or right 
border next to its title.

Related Topics

• Arranging the Order of Display, page 5-16

• Deleting Schedules, page 5-16

Arranging the Order of Display
When you open the Scheduled Reports window, the window displays schedules in 
alphabetical order by Report Name. You can change the display order by 
arranging the schedules in ascending or descending order by the information 
displayed in any column.

To change the order of displayed schedules, click the desired column name. The 
schedule appears in ascending alphabetical or numerical order by the information 
in that column. Click the same column name again to display the information in 
descending order.

For example, to display the list of schedules in the order that each schedule was 
created, click the Date Created column title. Similarly, to display schedules by 
recurrence type, click the Recurrence Type column title.

Deleting Schedules
When you delete a schedule, the schedule is permanently removed from the 
Scheduler and will no longer be run.

To delete a schedule, follow these steps:

Apps Server IP address or host name of the Cisco CRS server

Schedule Description Detailed description of the schedule

Column Description
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Procedure

Step 1 From the Scheduled Reports window, click anywhere in the row that contains the 
schedule you want to delete.

An arrow appears to the left of the name of the report, indicating that the schedule 
has been selected.

Step 2 Click Delete.

The Confirmation dialog box appears.

Step 3 Click OK to permanently delete the schedule. 

If you decide not to delete the schedule, click Cancel instead.

Handling Missed Schedules
In order for a schedule to execute:

• The Cisco CRS server, (or its standby server, if deployed) must be running.

• At least one server on which the Database component is installed must be 
running.

• The Scheduler must be running on the Cisco CRS Historical Reports client 
computer.

If schedules do not execute because a server is not running, you can generate the 
reports manually when the server is running again.

If schedules do not execute because the Scheduler is not running, the Scheduler 
will identify missed schedules. When the Scheduler restarts, the client computer 
will display a dialog box that shows the number of missed schedules and asks if 
you want to execute missed schedules. Click Yes to execute missed schedules, or 
click NO to continue without executing the schedules. If you click Yes, the reports 
that generate will depend on the parameters specified in the sch.ini configuration 
file and the scheduling options for the reports.
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For example, assume that you have set up a schedule to run daily, and that the 
schedule has no end date. In addition, assume that five of these schedules were 
missed, and that the sch.ini file instructs the system to execute up to three missed 
daily schedules. When you execute missed schedules, the system will generate the 
three most recent daily reports.

As another example, assume that you have set up a schedule to run weekly and to 
end after four occurrences. In addition, assume that all of these schedules were 
missed, and that the sch.ini file instructs the system to execute up to three missed 
weekly schedules. When you execute missed schedules, the system will generate 
three of the missed weekly reports. The first report will be the one that was 
scheduled to be the final report. The other reports will be the two previous reports.

Related Topic

• The sch.ini Configuration File, page 2-16.
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Log Files

The Cisco CRS Historical Reports system uses log files to record information 
about its activities. You can refer to the appropriate log file to help determine the 
cause of and solution for an error that occurs when

• You are generating, viewing, printing, or exporting a report

• The Scheduler is running a scheduled report

The following sections include these topics:

• Overview of Log Files, page 6-1

• Client System Log Files, page 6-2

• Server Log Files, page 6-6

Overview of Log Files
Some Cisco CRS Historical Reports system log files reside on the client system, 
and some log files reside on the Cisco CRS server. In addition, some log files can 
be generated on a standby server, if deployed. The following table shows general 
information about the log files.
6-1
ical Reports User Guide, Release 5.0(1)



 

Chapter 6      Log Files
Client System Log Files
Related Topics

• Client System Log Files, page 6-2

• Server Log Files, page 6-6

Client System Log Files
The Cisco CRS Historical Reports client maintains a series of Historical Reports 
Client log files and two Scheduler log files. These log files reside on the Cisco 
CRS Historical Reports client system. The log files are:

• System-name@session-no_CiscoAppReportsN.log—Contains information 
related to generating, viewing, printing, and exporting reports

• CiscoSch.log—Contains information related to activities of the Scheduler 
other than printing and exporting

• CiscoSchPrintExport.log—Contains information about printing and 
exporting activities of the Scheduler

Log File Contents System Location Reference

Historical Reports 
Client Log Files

Information related to 
generating, viewing, 
printing, and exporting 
reports

Client system See the “Historical 
Reports Client Log Files” 
section on page 6-3

Scheduler Log Files Information related to 
Scheduler activities

Client system See the “Scheduler Log 
Files” section on page 6-4

Database Log File Information related to 
retrieving information 
from the Cisco CRS 
database

Cisco CRS server or 
standby server

See the “Database Log 
File” section on page 6-6

Servlets Log File Information about users 
who log in or attempt to 
log in to the Cisco CRS 
Historical Reports system

Cisco CRS server See the “Servlets Log 
File” section on page 6-8
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Related Topics

• Historical Reports Client Log Files, page 6-3

• Scheduler Log Files, page 6-4

• Opening Log Files on the Client System, page 6-4

• Interpreting Log Files on the Client System, page 6-5

Historical Reports Client Log Files
The Historical Reports Client log files are named 
System-name@session-no_CiscoAppReportsN.log. These files are stored in the 
Cisco CRS Historical Reports\logs directory, which is under the directory in 
which you installed the Cisco CRS Historical Reports client system. (By default, 
the system installs in the Program Files directory.) 

If you are not running the Cisco CRS Historical Reports client under a Terminal 
Services session, System-name is the name of the system on which the client is 
installed, and @session-no is not included. If you are running the Cisco CRS 
Historical Reports client under a Terminal Services session, System-name is the 
name of the system from which you invoked Terminal Services, and @session-no 
is the session number assigned to the system under the Terminal Service session.

The system writes information related to generating, viewing, printing, and 
exporting reports to the current Historical Reports log file. When the system 
creates the first Historical Reports Client log file, the system replaces N in the file 
name with 0. When this file reaches the size specified in the hrcConfig.ini 
configuration file, the system creates a new Historical Reports Client log file. The 
system increases N in the new Historical Reports Client log file by 1. This process 
continues until the system creates as many log files as specified in the 
hrcConfig.ini configuration file. Then, the system begins overwriting the existing 
Historical Reports Client log files, starting with the oldest log file. 

Related Topics

• The hrcConfig.ini Configuration File, page 2-13

• Opening Log Files on the Client System, page 6-4

• Interpreting Log Files on the Client System, page 6-5
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Scheduler Log Files
The Cisco CRS Historical Reports Scheduler maintains two Scheduler log files:

• CiscoSch.log—Maintains information related to all Scheduler activities 
except printing and exporting

• CiscoSchPrintExport.log—Maintains information related to printing and 
exporting performed by the Scheduler

The Scheduler log files are stored in the Cisco CRS Historical Reports\Scheduler 
directory, which is under the directory in which you installed the Cisco CRS 
Historical Reports system. (By default, the system installs in the Program Files 
directory.)

Each Scheduler log file has a maximum size of 4 MB. When a Scheduler log file 
reaches this size, the system copies it to a backup file. The backup file has the 
same base name as the original file with the extension .bak. The system maintains 
one such backup file for each Scheduler log file. Each time a Scheduler log file 
reaches 4 MB in size, the system moves that information to the existing backup 
file, overwriting the information in the existing backup file.

Related Topics

• Opening Log Files on the Client System, page 6-4

• Interpreting Log Files on the Client System, page 6-5

Opening Log Files on the Client System
You open a Cisco CRS Historical Reports log file on the client system on which 
the log file is stored.

You can open log files from the Cisco CRS Historical Reports main window or by 
using a text editor. You can also open Scheduler log files from the Scheduler.

When you open a log file from the Cisco CRS Historical Reports main window or 
from the Scheduler, log information appears in a Notepad window. You can use 
the Notepad tools to move through the information in this window, to print the 
file, or to save it under another name. To exit a Notepad window, click the Close 
button on the Notepad menu bar.
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To open a log file using another text editor, start the editor, then open the file. You 
can use the editor tools to move through the information in this window, to print 
the file, or to save it under another name.

To open any log file from the Cisco CRS Historical Reports main window, follow 
these steps:

Procedure

Step 1 Click Help > Application Logs.

Step 2 Navigate to the directory containing the log file that you want to open, if 
necessary, and double-click the file name that you want.

The file appears in a Notepad window.

To open a Scheduler log file from the Scheduler, follow these steps:

Procedure

Step 1 Right-click the Scheduler icon that appears in the status area on your Windows 
taskbar.

The Scheduler pop-up menu appears.

Step 2 Choose View CiscoSch.log or View CiscoPrintExport.log.

The file you choose appears in a Notepad window.

Interpreting Log Files on the Client System
Each log file on the Cisco CRS client system contains a series of entries. The 
entries describe each activity that occurs in the part of the system for which the 
file is maintaining information. Each entry includes the date and time at which the 
activity occurred and a description of the activity. This information is arranged in 
order of occurrence, with the most recent activity shown at the end of the file. The 
system numbers each line of information sequentially. A new line numbered 1 is 
created each time the Cisco CRS Historical Reports client is started. 
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Level of detail in log files depends on values you specify in configuration files. 
The level of detail of the entries in the Historical Reports client log files depends 
on the LogLevel value specified in the hrcConfig.ini configuration file. The level 
of detail of the entries in the Scheduler log files depends on the LogLevel value 
specified in the sch.ini configuration file.

The information contained in the log files is designed to help you locate a 
problem, if one occurs. If the Cisco CRS Historical Reports client experiences an 
error or a problem, open the appropriate log file and locate the entry that describes 
the activity that was taking place when the error occurred.

Related Topics

• The hrcConfig.ini Configuration File, page 2-13

• The sch.ini Configuration File, page 2-16

Server Log Files
The Cisco CRS system provides these log files:

• Database log file—Contains information related to retrieving information 
from the Cisco CRS database. You create this file as needed, and give it the 
name of your choice.

• Jvm.stdout—Includes information about every user who logs in, or attempts 
to log in, to the Cisco CRS Historical Reports client.

Related Topics

• Database Log File, page 6-6

• Servlets Log File, page 6-8

Database Log File
The Database log file resides on the server from which the Cisco CRS Historical 
Reports client obtains historical data. This file logs information related to 
retrieving information from the Cisco CRS database. To help the server run most 
efficiently, the database log is turned off by default. If, when you try to generate 
a historical report, you receive an error message that is related to a Cisco CRS 
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database, you can turn on the database log to capture information for 
troubleshooting. Then you can provide that log file to the Cisco Technical 
Assistance Center for assistance with correcting the problem.

To turn on the database log and capture information in a log file, follow these 
steps:

Procedure

Step 1 On the server from which the Cisco CRS Historical Reports client obtains 
historical data, choose Start > Run.

The Run dialog box appears.

Step 2 In the Open field, enter cmd, and then click OK.

A Command window appears.

Step 3 At the command prompt, type cd program files\wfavvid, and then press the 
Enter key.

(If the CRS system is installed in another directory, replace program files with 
that directory name.)

Step 4 Type the following command to start database logging:

setsqllogging dbusername dbpassword on

Replace dbusername with the login name for the Cisco CRS database, and replace 
dbpassword with the login password for the database.

If you want to exit the Command window now, type exit. The database log will 
continue to run.

Step 5 From the Cisco CRS Historical Reports client, try again to generate the report that 
caused the problem.

Step 6 Repeat Step 1, Step 2, and Step 3.

Step 7 At the command prompt, type the following command:

getlogging dbusername dbpassword >> filename

Replace dbusername with the login name for the Cisco CRS database, replace 
dbpassword with the login password for the database, and replace filename with 
the name of a file in which to save the database log information.
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Step 8 Type the following command to stop the database log. 

setsqllogging dbusername dbpassword off

Replace dbusername with the login name for the Cisco CRS database, and replace 
dbpassword with the login password for the database.

Step 9 If you have not yet exited the Command window, type exit at the command 
prompt.

The file with the name you specified in Step 7 is the database log file. You can 
forward this file to the Cisco Technical Assistance Center for assistance in 
resolving the problem.

Servlets Log File
The servlets log file, jvm.stdout, resides on the Cisco CRS server in the 
wfavvid\tomcat directory, which is under the directory in which you installed the 
Cisco CRS system. (By default, the system installs in the Program Files 
directory.)

This file logs information from each servlet running on the Cisco CRS server, 
including the histRepClientsServlet servlet. This servlet provides the following 
information for every user who attempts to log in to the Cisco CRS Historical 
Reports system:

• IP address of the client computer from which the login was attempted.

• Date and time of the login attempt.

• Whether the login attempt was successful.

You open the jvm.stdout log file on the Cisco CRS server on which the log file is 
stored. To open this file in a Notepad window, navigate to the directory containing 
the file, and then double-click the file name. To open this file using another text 
editor, start the editor, then open the file. You can use the editor tools to move 
through the information in this window, to print the file, or to save it under another 
name.

There is no maximum size for the jvm.stdout file. When new information is 
generated, it is appended to the existing jfm.stdout file. To find information 
relating to logging in to the Cisco CRS Historical Reports system, open this file 
and search for histRepClientsServlet.
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C H A P T E R A

Cisco CRS Reason Codes

This appendix describes the events that cause an agent to go to the Logout state 
or Not Ready state. The built-in agent Not Ready reason codes are generated by 
the CRS server. The Agent State Detail table includes a valid reason code for these 
two states. Reason codes for other states is zero (default).

This appendix includes the following sections:

• About Reason Codes, page A-2

• System-Generated Reason Code Events, page A-2
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About Reason Codes
Reason codes are initiated by the agent from the Cisco Agent Desktop or are 
generated by the system. For details on agent-triggered reason code explanations 
see the Cisco Agent Desktop User’s Guide and the Cisco Desktop Administrator 
User’s Guide. 

The system-generated reason codes are displayed in the following reports when 
the CRS server moves an agent to the Logout or Not Ready states: 

• Logout reason codes: The Agent Login Logout Activity Report displays 
detailed information about the login/logout date, time, and other details for 
each session during the report period (see Agent Login Logout Activity 
Report, page 3-17). 

• Not Ready reason codes: The Agent Not Ready Reason Code Summary 
Report displays information about the length of time each agent spent in Not 
Ready state during a specified report period. For each agent, the total time 
spent in the Not Ready state is displayed along with other details (see Agent 
Not Ready Reason Code Summary Report, page 3-19).

• Logout and Not Ready reason codes: The Agent State Detail Report 
displays about when the agent changed from one state to another. (see Agent 
State Detail Report, page 3-21).

Each system-generated reason code in these reports are associated with an event 
indicating the agent’s status (see System-Generated Reason Code Events, 
page A-2). 

System-Generated Reason Code Events
The following events trigger system-generated reason codes:

• AGT_RELOGIN = 32767 

• CLOSE_CAD = 32766 

• CONNECTION_DOWN = 32765 

• CRS_FAILURE = 32764

• AGT_RNA = 32763 

• AGT_OFFHOOK = 32762
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• AGT_RCV_NON_ICD = 32761

• AGT_LOGON = 32760

• PHONE_DOWN = 327659

• WORK_TIMER_EXP = 327658

• CM_FAILOVER = 327657

• PHONE_UP = 327656

• CALL_ENDED = 327655

• DEVICE_RESTRICTED = 32754 

• LINE_RESTRICTED = 32753

AGT_RELOGIN
Reason Code: 32767

State: Logout 

The system issues this reason code when an agent is already logged in to one 
device (computer or phone) and then tries to relog in to a second device.

CLOSE_CAD
Reason Code: 32766

State: Logout 

The system issues this reason code when an agent closes the CAD without logging 
off. 

CONNECTION_DOWN
Reason Code: 32765

State: Logout 

The system issues this reason code when an IP Phone Agent or CAD crashes due 
to any reason or if the connection is disrupted.
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CRS_FAILURE 
Reason Code: 32764

State: Logout 

The system issues this reason code when the active server becomes the standby 
server and the agent loses connection to the CRS Platform.

AGT_RNA 
Reason Code: 32763

State: Not Ready

The system issues this reason code when the agent fails to answer an Unified CCX 
call within the specified timeout period.

AGT_OFFHOOK
Reason Code: 32762

State: Not Ready

The system issues this reason code when the agent goes off the hook to place a 
call. If the agent remembered to do this task the corresponding agent-triggered 
reason code is displayed. If the agent did not remember to do this task, the system 
issues this reason code.

AGT_RCV_NON_ICD
Reason Code: 32761 

State: Not Ready

The system issues this reason code when the agent is logged on to the CAD or IP 
Phone and then receives a call that is not queued on the CRS Platform.
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AGT_LOGON
Reason Code: 32760

State: Not Ready

The system issues this reason code when an agent logs in and is automatically 
placed in the Not Ready state.

PHONE_DOWN 
Reason Code: 32759

State: Not Ready

The system issues this reason code if the agent’s phone crashes and that agent is 
placed in the unavailable state.

WORK_TIMER_EXP 
Reason Code: 32758

State: Not Ready

The system issues this reason code when an agent’s state is changed from WORK 
to Not Ready. This change occurs if the WORK state for that agent’s CSQ is 
associated with an expired wrap-up timer. 

CM_FAILOVER
Reason Code: 32757

State: Not Ready

The system issues this reason code when the Unified CM fails over and the agent 
is moved to the Not Ready state.
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PHONE_UP 
Reason Code: 32756

State: Not Ready

The system issues this reason code when the agent’s phone comes up after it has 
been through a Phone Down state. 

CALL_ENDED 
Reason Code: 32755

State: Not Ready

The system issues this reason code when an agent is moved to the Not Ready state 
after handling a Unified CCX call. This situation occurs in one of two cases:

• If an agent (Agent 1) is in the Not Ready state and gets a consult Unified CCX 
call from another agent (Agent 2). In this case, after handling the call, Agent 
1 moves back to the Not Ready state.

• If an agent’s Automatic Available option is disabled and this agent gets a 
Unified CCX call, then this agent goes to the Not Ready state after handling 
the call.

DEVICE_RESTRICTED
Reason Code: 32754

State: Not Ready

The system issues this reason code if the agent device is flagged as a restricted 
device by the Unified CM Administrator. 

Warning If an agent’s device is added to the restricted list, then the functionality of the 
RmCm subsystem is impacted. 
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Note If the Allow Control of Device from CTI checkbox is not checked in the Default 
Device Profile Configuration window in the Unified CM GUI, then the device 
remains restricted and cannot be controlled. This setting can be modified for 
devices that register with Unified CM. For more information, see the Cisco 
Unified Communications Manager Administration Guide.

LINE_RESTRICTED 
Reason Code: 32753 

State: Not Ready 

The system issues this reason code if the agent’s phone line is flagged as a 
restricted device by the Unified CM Administrator.

Warning If an agent’s line is added to the restricted list, then the functionality of the 
RmCm subsystem is impacted.

Note If the Allow Control of Device from CTI checkbox is not checked in the Default 
Device Profile Configuration window in the Unified CM GUI, then the line 
remains restricted and cannot be controlled. This setting can be modified for 
devices that register with Unified CM. For more information, see the Cisco 
Unified Communications Manager Administration Guide. 
A-7
Cisco CRS Historical Reports User Guide, Release 5.0(1)

 



 

Chapter A      Cisco CRS Reason Codes
System-Generated Reason Code Events
A-8
Cisco CRS Historical Reports User Guide, Release 5.0(1)



 

Cisco CRS Historical Reports User Guide, Release 5.0(1)
G L O S S A R Y
A - C - D - E - F - G - I - J - L - M - N - P - R - S - T - V - W - X

A

ACD

Automatic Call Distribution. A feature that automatically routes incoming calls to the next available or 
longest idle agent or attendant in a line hunt group.

alarm

Signals that declare the run-time status and state of the Cisco CRS system and provide information for 
troubleshooting. Alarms can be forwarded to a Syslog server, to an SNMP trap subagent, or to a 
Windows Event Log.

alarm catalog

A file that contains alarms definitions.

alarm definition

A list of alarms and their properties. The definition for each alarm includes the alarm name, a 
description, an explanation, recommended actions, and related information.

alarm message

An alarm name followed by the reason for the alarm or the module name.

alarm service

A Windows service that receives alarms from the Cisco CRS Engine and its subsystems.
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application

In general, an application is a program that helps you accomplish a specific task; for example, a word 
processing program, a spreadsheet program, or an FTP client. Applications should be distinguished from 
system programs, which control the computer and run applications, and utilities, which are small 
assistance programs. In Cisco CRS, an application represents a configured combination of one or more 
triggers, a script, and the values for any parameter in that script.

Application Engine

A group of Java beans that can be combined in many ways to create applications such as Unified IP IVR. 
The Application Engine is the execution vehicle for all Cisco CRS based applications including Cisco 
Unified Contact Center Express, Cisco Unified IP IVR, and Cisco Unified Queue Manager scripts.

ASR

Automatic Speech Recognition. A technology that allows users of IVR systems to speak entries rather 
than enter numbers on a keypad.

Automatic Call Distribution

See ACD.

Automatic Speech Recognition

See ASR.

C

Call control group

Allows you to control how the Cisco CRS system uses CTI ports.

Call queuing

A method of handling calls until they can be answered by an agent.

Campaign 

A grouping of contacts for a particular purpose, such as a sales drive or a general announcement to a 
group of customers. Campaigns are used by Cisco Unified Outbound Preview Dialer to automatically 
place outgoing calls to a specific list of contacts.
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Campaign manager 

A Campaign Manager is the main control program of the Cisco Unified Outbound Preview Dialer. It 
maintains campaigns, dialer configuration, and current campaign data. 

CDP

Cisco Discovery Protocol. Media- and protocol-independent device-discovery protocol that runs on all 
Cisco-manufactured equipment including routers, access servers, bridges, and switches. Using CDP, a 
device can advertise its existence to other devices and receive information about other devices on the 
same LAN or on the remote side of a WAN. CDP runs on all media that support SNAP, including LANs, 
Frame Relay, and ATM media.

Cisco CRS Alarm Service

A Windows service automatically installed as part of Cisco CRS installation that receives alarms about 
system events from the Cisco CRS Engine and its subsystems. These alarms are defined in XML format 
in files called catalogs, which are set up as part of the Cisco CRS installation process.

CISCO-CCM-MIB

Cisco Unified Communications Manager Management Information Base. Exports the data in the Cisco 
Unified Communications Manager (Unified CM) database and other data sources. Examples of data 
exports include Unified CM group tables, region tables, time zone group tables, phone detail tables, 
gateway information tables, and status traps.

Cisco CRS

Cisco Customer Response Solutions. A platform that offers integrated application functionality, 
including Cisco Unified Contact Center Express (Unified CCX) for contact center functionality such as 
ACD, CTI, IVR, Cisco Unified IP IVR (Unified IP IVR) for call treatment and self-help automation, and 
Cisco Unified Queue Manager (Unified QM), an option for an IP Contact Center that provides call 
treatment to calls in queue. 

Cisco CRS Editor

A Windows tool with which application designers create new scripts or modify existing scripts. The 
visual scripting tool allows designers to drag and drop call-flow steps from a palette into the main design 
window.
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Cisco CRS Engine

Execution vehicle for Cisco CRS scripts. The Cisco CRS Engine can run multiple scripts simultaneously. 
On startup, the Cisco CRS Engine loads all scripts and configuration information from the Cisco CRS 
configuration datastore server. Individual scripts can be updated in real time and manually pushed to the 
Cisco CRS Engine without restarting the engine. Scripts that are running when a download occurs will 
not be affected by updates; they will run to completion with the pre-update logic. One Unified CM can 
support multiple Cisco CRS engines, but the Cisco CRS engines bind to only one Unified CM. 

One Unified CM supports many Cisco CRS Clusters (and not just one engine) and one Cisco CRS 
cluster, which may contain up to 2 Cisco CRS Engines, binds to one Unified CM.

Cisco Unified Contact Center Enterprise (Unified CCE)

Unified CCE can also handle traditional ACD calls and functions as a virtual ACD. Capabilities of 
Unified CCE include intelligent multichannel contact routing, ACD functionality, network-to-desktop 
CTI, IVR integration, call queuing, and consolidated reporting. 

Cisco Unified Contact Center Express (Unified CCX)

Unified CCX is an application that uses the Cisco Customer Response Solutions (Cisco CRS) platform 
to provide a multimedia (voice, data, and web) IP-enabled customer-care environment to enhance the 
efficiency of contact center. Unified CCX is available in Unified CCX Standard, Unified CCX Enhanced, 
and Unified CCX Premium packages. 

Cisco Unified Contact Center Express (Unified CCX) Call Monitoring Server

Dedicated server that provides for call monitoring. 

Cisco Unified Contact Center Express (Unified CCX) Call Statistics, Recording, and Monitoring Server

Dedicated server that maintains Unified CCX call statistics and that provides for recording and call 
monitoring for Unified CCX Enhanced. 

Cisco Unified E-Mail Interaction Manager (Unified EIM)

Unified EIM increases agent productivity through a powerful, visual workflow designer that helps create 
the e-mail handling process. Using the required service level agreement (SLA) triggers, you can 
automate email routing and monitoring. This e-mail collaboration provides full HTML support for both 
inbound and outbound communications, the ability to attach larger files from the agent desktop is 
supported, and powerful content-parsing capabilities in the product enable auto-suggestions from the 
knowledge base.
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Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) 

The Unified CCE component that is responsible for making routing decisions and performing ACD 
functions. In Cisco CRS with the IPCC Gateway PG, Unified CCX can be integrated as an ACD with 
Unified ICME software. 

Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) subsystem

A subsystem of the Unified IP IVR system that allows that system to interact with Unified ICME. 
Unified ICME provides a central control system that directs calls to various human and automated 
systems, such as Voice Response Units (VRUs) and ACDs. 

Cisco Unified Outbound Preview Dialer (Outbound)

Allows agents who are not busy with inbound calls to handle outbound calls, thereby maintaining high 
level of agent productivity. The Outbound provides the ability to create and schedule Outbound 
campaigns for Unified CCX. The Contacts to Dial are kept in the Cisco CRS Database. A campaign 
selects agents from CSQs assigned to it. 

Cisco Unified Queue Manager (Unified QM)

Unified QM is an IP-based call treatment and solution that provides powerful call-treatment options as 
part of the Cisco CRS solution. 

Cisco Unified Web Interaction Manager (Unified WIM)

Unified WIM ensures that your online customers are connected easily and seamlessly to the right agent 
every time. It also provides powerful file-sharing capabilities which allows agents to easily share files 
residing on their desktop. Advanced co-browsing capabilities allow agents and the customers to fill out 
forms together, field by field, even highlighting specific areas of a form or Web page for additional 
clarity. 

Configuration Datastore Server (CDS)

The Cisco CRS Configuration Datastore Server (CDS) manages and shares configuration, component, 
and application information within the Cisco CRS cluster and communicates with Unified CM.

Cisco Discovery Protocol

See CDP.
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Cisco Media Termination

See CMT.

CISCO-VOICE-APPS-MIB

Cisco Voice Applications Management Information Base. Provides information about supported SNMP 
traps.

CiscoWorks

CiscoWorks, available as a package separate from Cisco CRS, provides a suite of web-based applications 
for managing Cisco devices. It is the network management system (NMS) of choice for the Cisco CRS 
system and for other Cisco Unified Communications family of products. 

Cluster

A Cisco CRS cluster consists of a server (node) running Cisco CRS components in your Cisco CRS 
deployment.

Cluster profile

The Cisco CRS web page (home page) displays information about the cluster profile. A cluster profile 
includes data relating to the Cisco CRS servers, components, and licenses installed in a cluster.

CMT

Cisco Media Termination. An option to terminate the media on an agent's personal computer.

Codec

Coder/Decoder. A sampling and compression algorithm.

Comma-Separated Value

See CSV.

Component

An installation unit, either hardware or software, that you can install in a Cisco CRS system. Cisco CRS 
software components include the Cisco CRS Engine, the Database component, the Monitoring 
component, and the recording component. Hardware components include servers and client computers. 
You select the components you want when you install the system
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Configuration file

A file containing information for a computer or an application.

Contact

A connection with a remote customer.

Contact Service Queue

See CSQ.

Cisco CRS Datastores

Components that allow you to manage and monitor historical, repository, and configuration data across 
all servers in the Cisco CRS cluster. 

CSQ

Contact Service Queue. In Unified CCX, a CSQ is a call queue associated with one and only one Unified 
CM CTI Route Point.

CSV

Comma-separated value. A text file format used as a way of recording database fields.

CTI 

Computer Telephony Integration. The name given to the merger of traditional telecommunications 
(PBX) equipment with computers and computer applications. The use of caller ID to retrieve customer 
information automatically from a database is an example of a CTI application.

CTI Port

A virtual port, analogous to a trunk line in a traditional ACD or PBX setting. A CTI Port allows access 
to the post-pouting capabilities of Unified IP IVR.

CTI Port Group

A group of access points into the Unified CCX telephone network.
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CTI Route Point

 A virtual device that can receive multiple simultaneous calls for the purpose of application-controlled 
redirection.

Customizer

A window used to configure the properties of a step in the Cisco CRS Editor. 

D

Datastores

See Cisco CRS Datastores

Data type

In a programming language, a set of data with values having predefined characteristics. Examples 
include integer, floating point unit number, character, string, and pointer. Usually, a limited number of 
such data types come built into a language. The language usually specifies the range of values for a given 
data type, how the values are processed by the computer, and how they are stored. 

Default script

A script that gracefully terminates a call in the event of an error in the main script.

Deployment scenario

A set of Cisco CRS features and options on a server or servers.

Dialing list 

A file containing a list of customer account numbers, names, and phone numbers that can be imported 
as contacts for a specific outward bound campaign.

Directory profile

The directory profile describes the directory structure. It contains the directory host name or IP address, 
directory port number, directory user (DN), directory password, base context, server type, and 
configuration profile name. For each Unified IP IVR system, a directory profile must be created. There 
are two directories associated with each Unified IP IVR system: the Configuration Directory and the 
Repository Directory (called “the Repository”).
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Direct preview dialing mode 

A mode of dialing in the Outbound In this mode, Cisco Agent Desktop (CAD) software enables agents 
to view outbound call requests automatically placed by the system. 

DTMF

Dual Tone Multi-Frequency. The signal to the telephone company that is generated when you press a key 
on a telephone keypad. With DTMF, each key you press on your phone generates two tones of specific 
frequencies. So that a voice cannot imitate the tones, one tone is generated from a high-frequency group 
of tones and the other from a low-frequency group. Unified CCX telephone keypad presses resulting in 
DTMF is often used to capture customer input to IVR prompts.

Dual Tone Multi-Frequency

See DTMF.

E

Event

An occurrence that is significant to an application and that may call for a response from the application.

Excel (XLS) format

Format of data in the Microsoft Excel spreadsheet application.

Export

To convert a file from the format of one application to the format of another application, or to move data 
out of one file and import it into another file.

Expression

A formula, evaluated when a Cisco CRS script executes, to determine the value of a variable.

F

Field (also database field)

An item in a database record. For example, Name, City, or Zip Code. A group of fields make up a record.
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G

Grammar

A set of spoken phrases or DTMF digits that can be recognized by a script.

I

ICME

See Unified ICME

Interactive Voice Response

See IVR.

IP Phone Agent

A Unified CCX agent without a personal computer. The agent logs in, logs out, and changes states using 
the Cisco IP Phone screen. 

IVR 

Interactive Voice Response. A system that provides information as recorded messages over telephone 
lines in response to user input in the form of spoken words or, more commonly, DTMF signaling. 

J

Java Database Connectivity

See JDBC.

Java Telephony Application Programming Interface

See JTAPI.

JDBC 

Java Database Connectivity. A Java API that enables Java programs to execute SQL statements, allowing 
Java programs to interact with any SQL-compliant database. Because nearly all relational DBMSs 
support SQL, and because Java itself runs on most platforms, JDBC makes it possible to write a single 
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database application that can run on different platforms and can interact with different database 
management systems (DBMSs). JDBC is similar to Open Data Base Connectivity (ODBC) but is 
designed specifically for Java programs, whereas ODBC is language-independent.

JTAPI 

Java Telephony Application Programming Interface. A call control model developed by Sun 
Microsystems.

JTAPI call control groups

A pooled series of CTI ports that the Cisco CRS system uses to serve calls as they arrive at the Cisco 
CRS server.

L

Log file

A file that keeps track of the activity of a computer or an application.

M

Master service

The service that controls the service-specific function in a Cisco CRS cluster where you can have more 
than one service of the same type. Only one service of a given type can be the master within the Cisco 
CRS Engine component. You cannot configure the master service.

MCS

Media Convergence Server. A turnkey server platform for Cisco CRS.

Media Termination

See CMT.

Management Information Base

See MIB.
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Media Convergence Server

See MCS.

Media Termination

See CMT.

MIB

Management Information Base. Database of network management information that is used and 
maintained by a network management protocol, such as SNMP or CMIP. The value of a MIB object can 
be changed or retrieved using SNMP or CMIP commands, usually through a graphical user interface 
network management system. MIB objects are organized in a tree structure that includes public 
(standard) and private (proprietary) branches.

MRCP

Media Resource Control Protocol. An application level protocol that enables client devices requiring 
audio/video stream processing to control media service resources like Speech Synthesizers (TTS), 
Speech Recognizers (ASR), Signal Generators, Signal Detectors, Fax Servers, and so on over a network. 
This protocol is designed to work with streaming protocols like Real Time Streaming Protocol (RTSP) 
or Session Initiation Protocol (SIP) which help establish control connections to external media streaming 
devices, and media delivery mechanisms like Real Time Protocol (RTP). 

N

Node

A computer that is linked to other computers in a network of computers.

P

Palette

A grouping of steps in the Cisco CRS Editor.

Pane

A part of a window that is devoted to a specific function.
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PIM

Peripheral Interface Manager. The Cisco proprietary interface between a peripheral device and the 
Peripheral Gateway.

Ports

In a communications network, a logical channel identified by its unique port number.

Post-Routing

Process of making a routing decision after a call reaches a termination point.

Pre-Routing

Process of making a routing decision before a call reaches a termination point.

Prompts

A message from a computer that asks the operator to do something, such as enter a command, enter a 
password, or enter data, or that indicates that the computer is ready to accept input.

Purge

To delete both a set of data and all references to the data.

R

Real-Time Transport Protocol

See RTP.

Record (also database record)

In a database, a group of fields that make up one complete entry. For example, record about a customer 
might contain fields for name, address, and telephone number.

Repository

The subdirectory in the configuration datastore where Cisco user scripts are stored. You manage your 
Cisco scripts with the Repository Manager.
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Resource

Agent enabled to handle Unified CCX calls.

Resource group

A set of related resources.

RTP

Real-Time Transport Protocol. One of the IPv6 protocols. RTP is designed to provide end-to-end 
network transport functions for applications transmitting real-time data, such as audio, video, or 
simulation data, over multicast or unicast network services. RTP provides services such as payload type 
identification, sequence numbering, time stamping, and delivery monitoring to real-time applications. 

S

Scheduler

A program that resides on a Cisco CRS Historical Reports client computer. The Scheduler maintains 
information about each scheduled report, including when the report should execute and what information 
the report should contain. The scheduler also executes scheduled reports at their scheduled times, based 
on the time and date of the Cisco CRS Historical Reports client computer.

Script

A sequence of steps constructed in the Cisco CRS Editor. Scripts are sometimes also called flows, call 
flows, or work flows since scripts control the flow of a call. 

Server

A computer that provides services or resources to other computers (called clients) connected to it 
through a network. 

Service

A program, routine, or process that performs a specific system function to support other programs, 
particularly at a low (close to the hardware) level. In Cisco CRS, you can have a master service and a 
standby service.
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Serviceability

Enables remote network management support for the Cisco CRS system. Serviceability enables this 
support through CiscoWorks and through any other third-party network management system (NMS) that 
uses standard protocols.

Session (historical reporting)

Historical reporting seats are also called historical reporting sessions. Historical reporting sessions 
(seats) refer to the number of historical reporting clients that can be started at the same time on different 
client machines. 

Session (script)

An object that stores information about a caller as they move through a script

Simple Network Management Protocol

See SNMP.

Skill

Designated competency of an agent in a given area. Enables agents to handle calls associated with their 
expertise.

Skill Based Routing

The routing of calls to agents with designated skills.

Snapshot Agent

Generates a snapshot or image of the current database data.

SNMP 

Simple Network Management Protocol. The standard protocol for network management software. Using 
SNMP, programs called SNMP agents monitor devices on the network. Another program collects the 
data from the agents. The database created by the monitoring operations is called a management 
information base (MIB).
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SNMP agent

Simple Network Management Protocol agent. Hardware or software that monitors devices on a network. 
Data from an SNMP agent, which is contained in a MIB, helps in network management and 
troubleshooting.

SNMP service

A Windows service that provides a framework for SNMP and provides the SNMP agent that interfaces 
with SNMP subagents.

SNMP subagent

Cisco provides SNMP subagents to support each Cisco MIB. The SNMP service loads the Cisco SNMP 
subagents and it exchanges SNMP messages with the SNMP subagents. The SNMP service formats 
information as MIBs and sends this information to a Network Management System (NMS). It also sends 
traps from the SNMP subagents to the appropriate SNMP trap receivers.

Step

A single element in the Cisco CRS Editor that accomplishes a specific function

Subfacility

A traceable software component.

Subsystem

Extensible modular development environment that performs a particular function.

Syslog

A Cisco standard that allows for logging of errors across an enterprise. Provides local logging of network 
events to files. Also provides remote logging to various systems via standard protocols.

T

Table (also database table)

A presentation of information organized in rows and columns.
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Text-to-Speech

See TTS.

Trace (also trace file)

A TCP/IP utility that allows you to determine the route packets are taking to a particular host. Trace route 
works by increasing the “time to live” value of packets and seeing how far they get, until they reach the 
given destination. 

Trap (also SNMP trap)

A program interrupt, usually caused by some exceptional situation in an application. In most cases, after 
such an interrupt, the operating system performs some action, then returns control to the application. 

Trigger

Signals that respond to incoming contacts at a specified route point by selecting telephony and media 
resources to serve the contact and invoking application scripts to handle it. The Cisco CRS system uses 
JTAPI triggers to start responses to telephone calls and HTTP triggers to start responses to HTTP 
requests. In these cases, telephone numbers and Web addresses (associated with the triggers) act as the 
triggers.

TTS

Text-to-Speech. A speech synthesis application that creates a spoken sound version of the text in a 
document or database.

TTS Client

A component of TTS that must reside on the Cisco CRS server.

TTS Server

A dedicated server that converts text into speech and plays it back to the caller.

V

Variable

A placeholder for data.
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VXML (also VoiceXML)

Voice Extensible Markup Language. Allows a user to interact with the Internet through 
voice-recognition technology.

Variable

A placeholder for data.

W

Wrap-up

Call-related work performed by an agent after the call is over. An agent performing wrap-up is in either 
the Work Ready or Work Not Ready state. Often includes entering data, filling out forms and making 
outbound calls necessary to complete the transaction. The agent is unavailable to receive another 
inbound call while in this mode.

X

XML

Extensible Markup Language. A programming language developed by the World Wide Web Consortium 
that allows Web developers to create customized tags that will organize and deliver efficiently. XML is 
a metalanguage, containing a set of rules for constructing other markup languages.
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